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2 Introduction

This Operation Manual is designed to help the user
understand the basic operational principles of the Dynamic
Vapour Sorption (DVS) Advantage instrument, and how to set
up and operate the system to gain efficient use of both the
instrument and the user’s time.

If any questions remain unanswered upon reading this
manual, please do not hesitate to contact either your SMS
representative or SMS directly. Also available for on-line
customer support are our application notes which can be
found on our website at: http://www.smsuk.co.uk .

Figure 2.1: The Dynamic Vapour Sorption (DVS) Advantage
system


http://www.smsuk.co.uk/
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3 Principles of Operation

The DVS Advantage is designed to accurately measure a
sample’s change in mass as it sorbs precisely controlled
concentrations of water or organic vapours in an air carrier
gas.

The sample is hung from a microbalance in a sample pan (an
empty pan is usually hung on the other side of the balance as
a ‘reference’). Air carrying the test vapours is then passed
over the sample at a well-defined flowrate and temperature.
The sample mass readings from the microbalance then reveal
the vapour adsorption/desorption behaviour of the sample.

A schematic diagram of a DVS Advantage system is shown
below:

Figure 3.1: Schematic of a DVS Advantage.
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At the heart of the DVS system is an ultra-sensitive recording
microbalance capable of measuring changes in sample mass
lower than 1 part in 10 million. This type of microbalance has
very good long-term stability and is therefore ideally suited to
the measurement of vapour sorption phenomena, which may
take from minutes to days to achieve equilibrium.

The main instrument microbalance and stand is housed in a
precisely controlled constant-temperature oven. This ensures
a highly stable instrument baseline as well as accurate vapour
generation control. In addition, the oven’s temperature range
(and so the instrument’s experimental temperature range) is
broad, spanning from 5-60°C.

The required vapour pressures are generated by mixing dry
and saturated vapour gas flows in the correct proportions,
using mass flow controllers. A propriety optical vapour sensor
as well as temperature probes are situated near the sample to
verify and control system performance.

The instrument’s microbalance mechanism is very sensitive to
the sorption and desorption of moisture or organic vapours.
Therefore a constant flow rate of a dry gas is used to purge
the balance head. This facilitates the best performance in
terms of baseline stability. The purge flow is automatically
controlled so that the condensation of vapour in the balance
head cannot occur.

The DVS Advantage instrument is fully automated via control
from a dedicated PC microcomputer. A schematic of the
instrument’s sub-systems is shown below:
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PC Microcomputer

Balance QOven

Control Unit Controller Micro-Controller System

Optical
Vapour
Sensor

Isolation
Valves

Temp Sample Mass Flow
Probes | Pre-Heater j| Controllers

Microbalance

Figure 3.2: Schematic Diagram of DVS instrument’s sub-
systems.

The PC microcomputer is interfaced to the balance control
unit via an RS-232 serial link. The oven is also controlled
using an RS-232 serial link via a proprietary controller. An
advanced microprocessor system is used to drive a range of
important sub-component systems including:

Temperature RTD probes

Sample Pre-heater

Mass Flow Controllers

Optical Vapour Concentration Sensor
Isolation Valves

This controller is linked to the PC microcomputer via a USB
link.

The DVS Advantage software package supplied with the
instrument provides a flexible and easy-to-use interface for
setting up and running Vvapour sorption/de-sorption
experiments.

In addition, the DVS Analysis Suite, which runs from within
Microsoft Excel, provides a powerful environment for rapid
plotting and data analysis (please refer to the DVS Analysis
Suite User Manuals).
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4 Instrument Installation

The DVS Advantage must be installed correctly by a qualified
service engineer and it is strongly advised that your local SMS
representative is contacted before decommissioning or
moving an instrument from its installation site.

10
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5 Minimum Computer
Requirements

5.1 Windows 2000/XP Professional

The minimum computer requirements for Windows 2000/XP
Professional (English Language version) are:

1. Pentium lll processor (500 MHz)

2. 256 MB RAM.

3. Microsoft Internet Explorer 5.01 or later

4,

1 x available USB 2.0 port (if Dino-Lite USB video
camera is to be used)

5.2 Windows Vista

The minimum computer requirements for Windows Vista
(English Language version) are:

1. Dual Core 1.8 GHz (32 bit) processor.

2. 2 GB RAM.

3. Microsoft Internet Explorer 5.01 or later

4

1 x available USB 2.0 port (if Dino-Lite USB video
camera is to be used)

Note: To check what version of Internet Explorer is installed,
view the Help>About Internet Explorer menu item when
Internet Explorer is running.

11
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6 DVS Operation
6.1 Hardware

The following points are designed to aid in developing a
‘standard operating procedure’ to ensure that the DVS is
given the opportunity to deliver optimum results.

6.1.1 Starting up the DVS instrument:

The instrument will need restarting if there is a local power
failure or a laboratory shutdown, in which case everything
must be switched off at the power supply and all power
switches put in the OFF position before commencing start-up.

Turn on the mains power to the computer, DVS Advantage
Control Unit, oven and the Cahn microbalance Control Unit.

Then turn on:

1. The Cahn microbalance control unit via the switch at
the rear. A red LED on the front panel will indicate
that it is on.

2. The DVS Control Unit via a switch at rear. The lower
green LED on the front of the unit will signify that the
unit is powered up.

3. The computer provided with the instrument.

4. Turn on the Oven system via its front panel power
switch.

5. Now turn on the carrier gas supply, which should be
dry nitrogen regulated at a constant pressure of
between 1 and 2 bar.

6. The DVS Advantage software supplied with the
instrument may now be started up by double clicking

12



DVS Advantage - Operation Manual

on the DVS Advantage icon on the computer main
screen or menu. Following the software initialisation
routine the DVS Advantage software main panel will
be displayed.

The DVS instrument is now ready to be used.

6.1.2 Closing Down the DVS instrument
DVS instruments are designed for continuous laboratory
usage. Therefore it is not necessary for the instrument to be
shut down at the end of the working day - indeed it is intended
that the DVS system will be working overnight!

The DVS Advantage Control Unit and the Cahn microbalance
Controller are best left powered up at all times. The only need
for powering down these units may arise during extended
laboratory closures where local laboratory safety policy
requires all instruments to be turned off. In these cases
please follow the procedure below:

1. Exit the DVS Advantage software.

2. Turn off the carrier gas supply.

3. Turn off in the following order:

a. The PC compatible computer.

b. The DVS Control Unit main power via the
switch on the back of the unit.

c. The Cahn microbalance controller via its rear
switch.

d. The Oven via the front panel switch

13
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4. Finally turn off the mains power to the computer, DVS
Control Unit and the Cahn microbalance Controller.

WARNING!

If the power to the Cahn microbalance is turned off the Cahn
microbalance unit will need to be re-calibrated after re-
establishing RS232 communications between the balance
and the computer (See Section 7.2).

6.1.3 DVS Sample Pans

The DVS Advantage instrument is supplied with a pair of
precision quartz pans which are provided as a matched
weight pair (European part No.C-WM-003A; North America
No. QPNH13).

Figure 6.1: Quartz sample pans for a DVS-1 (left) and DVS-2
(right)

14
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Larger glass pans are normally provided with the DVS
Advantage 2 (see Figure 6.1 above).

The quartz pans will be suitable for general materials
characterisation. They should be used as a pair (one for the
reference position and one for the sample position) as their
matched weights will minimise buoyancy drift. Please note,
however, they are very fragile and will shatter if dropped.

Stainless steel mesh pans are also available for use with the
DVS Advantage system for applications in which a solid
sample pan is not necessary. Please contact Surface
Measurement Systems for more information.

6.1.3.1 Preparation of the Sample Pans

An important issue for the accurate and reliable use of any
gravimetric equipment is the cleanliness of the sample pan,
and the elimination of static from the sample. Cleaning the
cups is as much a question of remembering what not to do, as
well as what to do.

Do not flame clean the pans, unless when using the
platinum type. This results in micro-cracks forming on the
surface of the glass and will result in a very high baseline shift
between 0 and 98% p/po.

Do not use detergents to clean the pans - they are very
difficult to remove and once again will result in a very high
baseline shift.

Do not, having cleaned the pans, rub them with a cloth or
tissue - this can create static build-up on the pan which may
affect the DVS results or result in cup breakage.

Clean the pans using pure water from a wash bottle (or
equivalent) (either HPLC grade or distilled and deionised
water). Having cleaned the pans in water, rinse in a clean

15
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pure solvent such as ethanol (ethyl alcohol) or isopropyl
alcohol (IPA), and then allow to air dry naturally.

If the sample pans have contamination which is difficult to
remove there are two acceptable cleaning strategies
available. One is to try a different solvent to help remove the
contamination. This can also be combined with mild short-
term ultrasonic cleaning. However, ultrasonic cleaning can
occasionally result in pan breakage and thus should only be
used as a last resort.

It is always good practice to have a least one spare pair of
sample pans available.

If working under strict time constraints then it is a good idea to
utilise a spare matched pair of pans and rotate them in
sequence.

In order to achieve a satisfactory baseline in the DVS, it is
important to establish two very important parameters:

1. That the pan is dry, and therefore the baseline at 0%
p/p, is stable.

2. That there is no static on the sample pans which
could cause a baseline shift as the DVS moves to
high vapour partial pressures.

The preferred method of establishing that both of these
conditions have been met once the pan is hanging from the
balance is as follows:

e Set the target moisture partial pressure to 0%
manually, and allow 5-10 minutes for the pan to fully
dry. Then check the baseline for stability - a criterion
of less than 3 times the balance resolution (0.1 ug for
DVS Advantage 1, 1ug or 10ug for DVS Advantage 2)
per 20 seconds is the target. If the drift is always
negative, then the pan may not yet be dry. If the drift

16
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is positive or erratic, however, then it is possible that
there is static on the pans.

Elimination of the static is easily accomplished by
setting the target moisture p/p, to 95% for a period of
5 minutes — this provides a conductive path to earth
for the static. There may be a rapid change in mass
as the vapour partial pressure passes through 60-
80% as the static discharges. Once a stable baseline
has been established at the high water vapour partial
pressure, the target p/po may be reset to the starting
p/po to be used for the next experiment.

Once this humidity has been reached, again check for
balance stability over a period of a few minutes.
During this time prepare the method to be utilised, the
sample etc.

Finally, the DVS is ready to be ‘tared’ once balance
stability has been established.

17
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Microbalance

Outlet for
GC/MS

Single finger lift
mechanism
Real time vapour

concentration :
optical sensor T Sample chamber with

pre-heater and
optional cameralfibre
optic port

Vapour bottle B

Vapour bottle A

Figure 6.2: Layout of the DVS Advantage stand assembly

6.1.4 Sample Mass Considerations

Before loading the sample, it is wise to consider the likely
change in mass (ie; vapour uptake) that may occur during the
experiment. If the change in mass is likely to be less than
0.5%, then a sample mass of 50 mg or even 100 mg (for DVS
Advantage 1) will produce a more acceptable signal-to-noise
ratio. However, for changes greater than this 10-20 mg is
normally more than adequate, and for very hydrophilic
materials, less than 10 mg may in fact be more suitable (more
vapour means more experimental time!).

18
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If using the DMDT mode for the experiment (Sections 6.2.2,
9.5.2 and 9.6.1.1) the fact that ‘dm/dt’ is expressed as a
percentage must also be considered. Therefore an equilibrium
criterion of dm/dt = 0.002, which is suitable for a 10-20 mg
sample, will be too high for a 100 mg sample (a value of
0.0005 would be more appropriate in the latter case).

It should also be remembered that samples such as
compressed tablets will respond very slowly to partial
pressure changes. This will necessitate the use of low dm/dt
settings in experiments involving samples such as these.

6.1.4.1 Using Larger Sample Masses

The various DVS systems will handle a wide range of sample
masses, though to use the maximum possible sample mass,
counterweights or tare weights will need to be used:

DVS Advantage 1

This DVS system will measure a change in mass of up to
150mg in the sample mass without any need of
counterweights. For example, for a 50mg sample a 100mg
increase in mass could be measured. Using a counter or tare
weight, samples of up to 1.5g in mass may be studied, though
the maximum measurable change in sample mass remains
150mg.

DVS Advantage 2 - LOW MODE

A system in LOW MODE (default) will measure a change in
mass of up to 1.0g in the sample mass without any need of
counterweights. Using a counterweight, samples of up to 10g
in mass may be studied, though the maximum measurable
change in sample mass remains 1g.

DVS Advantage 2- HIGH MODE

This system will measure a change in mass of up to 10.0g in
the sample mass without any need of counterweights. Using a

19
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counterweight, samples of up to 100g in mass may be
studied, though the maximum measurable change in sample
mass measured remains 10g.

The methodology for use of counterweights is as follows:

1.

Estimate the weight of the sample — for this example,
imagine that the sample mass is approximately
500mg and it is to be used in a DVS 1 system which
can measure a maximum weight change of 150mg.

Place a 500mg calibration weight in the sample pan,
and place 500mg of tare weights on the reference
side of the balance system.

Tare the balance (Section 10.2.2).

Remove the calibration weight and substitute the
sample into the sample pan (assuming the mass
reported by the balance at this stage is -5.3678mg).

Select the Configuration > Set Counter Weight
Value menu item in the control software (Section
9.3.3) and enter a counter weight value of 500mg.

The mass reading from the balance will now be
494.6322mg ie: 500mg - 5.3678mg.

6.1.5 Loading the sample

The procedure for loading a sample into the system is as

follows:

20

Firstly, open the DVS Advantage manifold so that the
sample pan can be removed or replaced.
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Figure 6.3: Release arm for sample access

Pulling forward the cam as indicated in Figure 6.3 will
release the manifold and permit access to the sample
pan area.

e The pan should be carefully removed using tweezers;
it should not be removed by hand.

e Remember, the sample pan is contained in the LEFT-
hand side of the manifold, and the reference pan is
contained in the right-hand side. Note that the
sample pan is placed within the pre-heater zone in the
manifold.

Note: The sample must not be loaded into the DVS pan while
it is hanging in the manifold! It must be loaded remotely on an
analytical balance or on the bench, where a spillage can be
easily cleaned up. The cup should only be placed back into
the DVS once it has been sufficiently loaded with sample.

21
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e Once loaded on the hang down wire, the sample
should be allowed to settle for a short time before
starting the experiment. This ensures that the first few
data points are not affected by the swinging of the
sample cup, and also allows the sample to equilibrate
to the temperature and humidity of its new
environment.

6.1.6 Controlling the Oven and Preheat

Temperature

The DVS instrument is designed to perform measurements
isothermally, over the temperature range specified for the
system. The working temperature may be set using the DVS
Advantage Software for both the DVS Advantage 1 and 2.
Simply set the Target Sample Temperature to the desired
value.

In addition, the DVS Advantage has a high-temperature local
sample pre-heater (Section 6.1.7 below, and Section 9.5.1).
This allows for rapid heating of the sample prior to the vapour
sorption experiment and is useful for drying porous materials
or for removing water from chemical hydrates.

Note: The microbalance MUST be recalibrated whenever the
operational temperature of a DVS Advantage 1 and 2 is
changed.

After making a small change in the system’s operating
temperature (<10°C), the user should wait a minimum of one
hour to ensure the instrument has reached thermal
equilibrium before commencing experiments at the new
temperature.

This waiting period will increase with larger temperature
changes (i.e. >10°C).

22
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Monitoring the sample chamber temperature will give a good
indication of the re-establishment of thermal equilibrium - the
major rate-limiting factor in this process is the establishment
of a new thermal equilibrium in the humidity generation
bottles.

It is also important to remember that the partial pressure
MUST be set to 0% p/p, whilst changing the temperature of
the instrument to avoid the possibility of condensation.

6.1.7 DVS Advantage 1 and 2 Preheat

function

The DVS Advantage sample chamber is equipped with a
small heating device which can heat the sample locally as the
first stage of an experiment (Figure 6.2).

To use the preheat facility, the user must set up a Preheat
Method by using the Method Menu of the DVS Advantage
software (Section 9.5.1) to create a new Preheat Method.

This new Preheat Method should be saved and then
incorporated into a Sequence (Section 9.6). Running the
Sequence will allow the preheater to dry the sample in the
manner requested.

6.2 Software — Quick Start to running
an experiment

The following section is designed to get the user started with
running experiments on the DVS instrument. Sections 9 and
10 give a more detailed description of the software

functionality.

23
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6.2.1 Initial Considerations

There are many factors to be considered prior to running an
experiment on the DVS. For instance, the approximate uptake
characteristics of the sample material, the amount of sample
material available, and whether this experiment is intended to
be a quick sample survey, or a final run to provide high quality
publication data should all be taken into account.

Once the sample has been loaded into the instrument there
are many different ways of setting up and running
experiments. The following points may be used as a basic
guide for setting up and running Methods on the DVS:

6.2.2 Method Stage Type — Stage-End

Determinant

A DVS experimental Method is made up of a series of
Preheating or Partial Pressure steps. Each of these steps is
termed a Stage (Section 9.5).

In the case of a Partial Pressure Method, a key consideration
is the amount of time each Stage will last. Usually the
objective at the end of each Stage is for the sample to have
reached equilibrium at the given Partial Pressure.

There are two Methods by which the end of a Stage can be
determined; Time and dm/dt.

6.2.2.1 Time

(Refer also to Section 9.5.2.1)

This regimen is the simplest — a Stage will last for a specified
period of time regardless of the state of equilibration of the
sample i.e. if the sample has not yet reached equilibrium at
the end of the allotted stage time, the instrument will move to
the next stage regardless.
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When to use Time-based experiments
Time-based experiments are useful in their simplicity.

Often — especially when testing samples whose sorption
properties are unknown - it is desirable at first to use Time-
based experiments to gain a rough idea of the time required
for the sample to equilibrate at each Stage and the dm/dt
reached at equilibrium. A very rough guide to running these
initial exploratory experiments is to try a Stage time of 2 hours
or more.

Thereafter dm/dt-based experiments may then offer the most
convenient experimental configuration (see below).

6.2.2.2 DMDT

(Refer also to Section 9.5.2)

This uses the percentage rate of change of mass with time
(dm/dt) to determine whether a sample has come to
equilibrium.  Using this as the Stage-End Determinant
ensures that the sample reaches the required degree of
equilibration before the Stage is deemed complete. If for
some reason the sample does not reach equilibrium then the
software will move on to the next stage after a specified
maximum time has elapsed.

Suitable DMDT criteria

As outlined in Section 6.1.4, if using the DMDT mode the fact
that ‘dm/dt’ is expressed as a percentage must be considered
when determining the dm/dt criteria to set for sample
equilibrium.

An equilibrium criterion of dm/dt = 0.002 is suitable for a 10-20

mg sample, but will be too high for a 100 mg sample (a value
of 0.0005 would be more appropriate in the latter case).
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When to use DMDT

It is recommended that, when using samples of unknown
sorption behaviour, Time-based criteria be used in initial
experiments. This will allow a rough determination of the time
and dm/dt required for equilibration. DMDT methods may
then be used if desired once an idea of the required Stage
dm/dt is known.

6.2.3 Preliminary Settings

If drying the sample and/or the moisture behaviour of the
sample is unknown, it is recommended to have the Update
Sample Weight an completion of first method stage option
activated (Section 9.5.2.1)

6.2.4 Initial Sample Weight

As soon as the sample has been loaded in the DVS and has
stopped swinging, press the M(0) button to store the initial
weight (Section 10.2.3).

6.2.5 Running an Automated Experiment
To run an automated experiment, follow the 5 easy steps
outlined below:

1. First input the experiment details onto the Run
Experiment panel (Section 0). These include Sample
Name, Sample Description, the Output directory, etc.
This provides useful information for later analysis of
the DVS data.

2. Create any DVS Methods to be used via the New
Method menu item (Section 9.5) that is located on the
Method menu.

Note: An existing DVS method may be edited by selecting
the Edit Method menu item (Section 9.5)
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3.

Once all DVS methods to be used in the experiment
have been created, add them to a new DVS
Sequence by using the New Sequence menu item
located on the Sequence menu (Section 9.6.1.1).

Note: An existing sequence may also be used by selecting
the Load Sequence menu item (Section 9.6.1.2).

4,

Once a DVS sequence is loaded the experiment may
be commenced. Select the Run Experiment panel
(Section 0) and then click the Run Sequence and
Save Data button. The DVS Advantage will instantly
start sequentially running the Methods contained in
the active DVS Sequence and saving the DVS data to
the output directory specified.

Once the experiment is in progress, the change in
mass, humidity, Stage time, etc. can be monitored as
the experiment progresses using the Mass Graph
and Instrument Data panels (Sections 10.3 and
10.4).

At any time during an experiment it is possible to gain
an overall view of the data. Use the Import DVS Data
function provided in the DVS Analysis Suite to
analyse the data in Microsoft Excel® (please refer to
the DVS Analysis Suite User Manual).

Once the Run Sequence and Save Data switch of
the Run Experiment panel has returned to the OFF
state, the experiment has finished. However, after
removing the sample pan for cleaning, the sample
should be inspected visually. Has the sample
changed colour, or turned into a solid or liquid? These
observations constitute important and valuable
information which can enhance the gravimetric data
gained from the DVS.
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5. Once the experiment has completed the results may
be analysed using the DVS Analysis Suite software.

6.3 Organic Vapour Operation

The DVS Advantage is designed for use with water as well as
a range or organic solvents. Please also refer to Section 9.4
for information on using the software with respect to solvent
information.

6.3.1 Organic Vapour Leak Sensor

The DVS Advantage incorporates highly solvent-resistant ‘O’
ring seals, as well as the vapour detector safety interlock and
an external gas exit for safe ventilation of the exhaust gases.

The exit vapour gas stream from the DVS Advantage should
be vented to an appropriate location such as a fume
cupboard.

The DVS Advantage’s integrated organic leak detector will
normally shut down all the power to the instrument in the
event of a vapour leak inside the instrument incubator.

The sensitivity of the detector is factory-set for the most
volatile vapours to be used and may only be adjusted by a
qualified service engineer. In the event of a system shutdown
the top LED on the DVS Advantage Control unit turns red.

The system will only reset when both of the following
conditions have been met: the DVS Advantage software is re-
started AND all traces of organic vapour have been removed
from the incubator (green LED illuminated). This usually
requires the incubator door to be left open for several minutes
in order to dissipate the vapours. It should be noted that
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accidental tripping of the detector might occur during the
filling/refilling of solvent vapours.

The system should not be restarted until the source of the
vapour leak has been established. In the case where the
sensor does not reset to a vapour-clear status, please contact
Surface Measurement Systems.

6.3.2 Using Organic Vapours

SMS recommends only the organic solvents listed below
which have been tested for use in the DVS. Only solvents of
high purity should be used and HPLC-grade is recommended.

e Heptane e 1-Butanol

e Octane e Isopropanol

e Nonane e Toluene

e Decane e Ethyl Acetate
e Undecane e Butyl Acetate
e Dodecane e 1.4-Dioxane
e Cyclohexane e Dichloro-methane
e Methanol e 1-Propanol

e Ethanol

e Acetone

e 2-Butanone

e Acetonitrile

WARNING!

Solvents with very high flammability such as diethyl ether and
tetrahydrofuran (THF) must not be used in the DVS
Advantage.

Note: The use of any solvents not on this list should be
discussed with SMS as they could constitute a safety hazard.
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SMS will not be held responsible for the consequences of
using non-recommended solvents.

6.3.2.1 Installing an organic solvent into the
DVS Advantage system

Upon choosing a solvent, decant it into one of the smaller
(250ml) pyrex bottles until it is approximately half-full. It is
presumed that the bottle is already clean and free of any
solvents from previous experiments. It is a wise idea to label
the bottle with the name of the solvent contained within.

The bottle may be placed in the Bottle A or Bottle B position in
the Advantage manifold - it should be screwed into the
chosen position until hand-tight.

The system is also provided with a larger 500ml bottle and it
is recommended that this be used for water. Again this bottle
should be half-filled with either HPLC-grade or distilled and
deionised water - the bottle should be labelled to indicate its
contents.

Bottle B
Bottle A
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Figure 6.4: Solvent reservoirs on the DVS Advantage

6.3.2.2 Changing solvent reservoirs.

The DVS Advantage is designed to allow rapid changing of
solvents. This is also facilitated by the availability of two
solvent reservoir bottles designated Bottle A and Bottle B.

Once an experiment has finished, any bottle containing an
organic solvent which is not required should be unscrewed
from the Advantage manifold and sealed using the blue caps
supplied. They may then be stored until required again.

It is then advised that an empty bottle be fitted to the manifold
and 95% partial pressure be requested. This will allow dry
nitrogen to be flushed through the system which will remove
any vapour left from the previous experiments. Thirty minutes
should be sufficient time for a complete system flush. This will
need to be repeated for the other bottle if both solvents have
been changed.

If a different solvent is then required in the system, the new
solvent bottles may be mounted onto the manifold (again
hand-tight only).

Note: It is important to remember to identify the new solvents
by finding them on the list provided under Solvents > Select
Solvents (Section 9.4.1) on the DVS software main panel.

This is a very important step as the instrument has no way of
identifying the solvents that have been placed in the solvent
bottles!
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6.4 Optical Vapour Concentration
Detector

A key feature of the DVS Advantage is the incorporation of a
real time, in-line optical detector for measuring the vapour
pressure of organic and inorganic solvents.

This optical sensor determines the temperature at which a
liquid droplet film forms on a special optical mirror. This dew
point temperature is then converted into the solvent partial
pressure using the sample temperature and standard vapour
pressure tables for the solvent in question.

The optical sensor is mounted at the rear of the DVS stand
and in-line with the vapour flow stream prior to it entering the
sample chamber (see Figure 6.2).

The DVS control software incorporates a number of special
control features to maintain the cleanliness and performance
of the optical mirror.

This optical sensor has proven to be a very effective tool for
determining real organic vapour concentrations for a wide
range of organic solvents. However, SMS cannot guarantee
the sensor will operate for every organic solvent. Should there
arise any problems or questions pertaining to the optical
sensor please contact SMS.
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7 Maintenance and Service

71 Refrigeration Maintenance

The Advantage incubator’'s refrigeration runs continuously
when the instrument is in use. This being the case, it is
possible for a build-up of ice on the incubator’s refrigeration
panel to form. This will result in a slow decline in temperature
control over a period of months and may result in permanent
damage to the cooling system if not rectified.

Note: It is strongly recommended that the incubator be
regularly defrosted by turning it off for an hour or so at least
once every three months, but ideally once a month, in order to
avoid the build up of ice.

Note: If a large build-up of ice has formed, please be aware
that a large amount of water will drain away via the drainage
tube connected to the rear of the incubator.

This drainage tube is usually directed into a container or bottle
— care must be taken that this container or bottle does not
overflow.

As the incubator thaws, it is common for ice to drop down in
the back of the incubator. This ice should be physically
removed and not be left to sit inside the unit.
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7.2 Calibrating the Microbalance

The microbalance needs to be calibrated against a certified
calibration weight for optimum system performance. It is
recommended that the microbalance be calibrated whenever:

e The microbalance is turned off;

e The DVS system is moved to a new location or
repositioned in its current site;

e The experimental temperature of the incubator is
changed, and;

e At least every month during routine usage.

Please refer to Section 9.7.1.2 for details of the microbalance
calibration procedure.
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8 Additional Hardware Issues

8.1 Time taken for the sample partial
pressure to change after the
target %p/p, is changed

Around 90% of the requested change in sample p/p, should
be achieved within 3 to 4 minutes of altering the p/p, set point.

For example, upon changing the set point from 20% p/p, to
60% p/po, the sample partial pressure should reach 56% p/p,
within 4 minutes.

8.2 Proximity between the actual
partial pressure and the requested
value

In Open Loop control mode the DVS programme uses a look-
up table in conjunction with an interpolation algorithm which
takes into account temperature, gas flow rate and desired
partial pressure in computing the ratio of dry to wet gas flow
rates. The generated partial pressure should be within +/-
1.5% pl/p, of the set point specified for commonly used flows
and temperatures (e.g. 25°C and 200 sccm).

In the case of Closed Loop control, in which the vapour
concentration from the optical vapour sensor is used to
actively change the gas mix ratio, the vapour pressure
generated should be within +/-1% p/p, of the set point
specified.
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8.3 Vapour Pressure stability

Generally, the stability of the vapour pressure once
equilibrium has been established will be typically +/-0.5%p/po.

Any problems with thermal stability might lead to slightly
higher levels of drift.

8.4 Statically charged samples

Occasionally DVS users may come across samples that
exhibit significant levels of static charge - especially those
studying pharmaceutical materials. Static electricity has long
been an important issue for microbalance users and must be
treated with respect in those uncommon circumstances when
it does occur. Statically charged powders will often exhibit
unusual properties during sample preparation, such as
strongly adhering to mortar/pestles, or to container walls. In
the worst cases, transfer of static electricity to the sample
hang-down wire will cause it to adopt a non-vertical alignment.
Weight measurements associated with statically charged
samples and sample cups will exhibit slow but significant drift.
The build up of static may be prevented by using either an
ionising antistatic gun, or a source of ionising radiation such
as a polonium strip.

Care in cleaning the glass/quartz pans can minimise their
becoming statically charged. Pans that have been cleaned
with a solvent or water should be allowed to dry statically - the
use of a hot air gun or dry air line to rapidly dry pans often
leads to them becoming statically charged.
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Hang-down wire falling off the
system balance

If a hang-down wire falls off the system balance, follow the
procedure outlined below to re-hang the wire:

1.

8.6

The helmet which covers the microbalance must first
be removed; loosen the four thumb screws securing
the helmet, rotate the four holding flanges, and
carefully lift the helmet vertically until it is clear of the
pillars that guard the microbalance mechanism.

The hang-down wire must then be recovered. If it has
dropped down into the DVS manifold, then a wire
hook made from a paper clip may be used to carefully
lift the hang-down wire out (care must be taken to
avoid bending the hang-down wire while doing this).

Then using tweezers, drop the hang down wire
through the holes that form the centre part of the flow
chokes. It may take a few attempts to get the wire
through both lower and upper flow chokes. Then,
making sure that no excessive force is applied to the
very sensitive balance arm, lift the wire on to the
balance arm. Check that the hook for holding the
sample pan is orientated in the correct direction prior
to carefully replacing the helmet.

Finally, carefully finger-tighten all four securing flange
screws to replace the balance helmet.

Purpose of the Purge Gas

Experience has shown that microbalances may exhibit slight
drift over long time periods if exposed to high partial
pressures. The magnitude of this problem varies from balance

37



DVS Advantage Operation Manual

to balance, but may typically be 10ug over a 24-hour period.
By flowing a purge gas through the balance head at all times,
this drift can be largely eliminated.
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9 Software Toolbar

9.1 Introduction

The Control software Toolbar allows the user to create the
building blocks of an experiment —Method and Sequence files.

The toolbar options also allow the user to manage these files
and to configure the instrument for optimum performance.

File Configuration Solvents Method Sequence Calibrakion  Wideo Help
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9.2 File

The File menu allows instrument preferences to be set, and
for various DVS files to be exported into a .DAT format. The
control software may also be exited from the File menu.

Preferences 4

Excport Method File, .,
T Export Sequence File. ..
et Export Data File. ..

Data Reduction Toal. ..

e : Sample Density Wizard. .,

Exit... CErl+E

9.2.1 Preferences

Preferences General, ..

Default Directories. .

Export Method File. ..
Export Sequence File, .. Videa 4
Export Data File, .

Post Experiment Instrument Settings. ..

Data Reduction Toal... ] )
Email Settings. ..

Sample Density Wizard. ..
P ¥ Calibration Reminders. ..

Exit... Ctrl+E I

The Preferences option allows commonly used settings to be
stored as preferences.

Note: The General Preferences menu item is disabled
whenever a Sequence is loaded and/or data is being saved.
The Sequence must be cleared and data saving stopped to
enable this option for use — see Section 9.6 on Sequences.
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9211 General

Preferences General...

Default Directories., ..

Export Method File. ..
Export Sequence File. .. Widea 4

Export Data File, .. . )
Post Expetiment Instrument Settings. ..

Data Reduction Taal,.. . )
Email Settings. ..

Sample Density Wizard. ..
F il Calibration Reminders. .

Exit... Ctri+E [

Clicking the General option calls up the following window:

" General Preference Settings

Sampling Rates Calibration Weight [mg] Control Mode
Sampling Rate: Solvent & | Open Loop %
100.0000 3:
Save Data Rate: Salvent B: | Open Loop %
Maszs Axiz % Paitial Pressure Axis Temperature Axiz

“Y'max [rg]: (0.0100 EI: Ymax (%]l |90.00 El: “max [*C]: |30.00 El:
“rmin (mg): |-0.0100 3: min (%) |0.00 3: “rin (*C): (20,00 3:

Auto Scale Az Auto Scale Axis Auto Scale Axiz

BN

General Preference Settings may be specified for the
following functions:

Sampling Rates

Calibration Weight

Control Mode

Mass/Partial Pressure/Temperature Axis
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The General Preference settings are automatically loaded
each time the DVS Advantage software is started. Each of
these functions may be edited in other parts of the Control
software — if they are, however, upon restarting the software
they will return to the settings specified in the Preferences
window.

Details of how to edit the settings for these functions are
contained in later sections of this manual.

In addition — any changes made in the General Preferences
settings will not come into effect until either the Control
software is re-started or the new settings are confirmed in the
editing windows for each function.

For example, if the General Preferences window were used to
edit the scaling on the mass axis:

" General Prefenence Sellings
Samplng Rates Calibuation Wiight fesg] Contsu Mo

[oamoe =]

% Pastial Prevoune Axiv Temgeraturn Axia

ST Yempoy [0

Mass Axiz

Y'max [mgl: (4.5 El:
'mirn [mal: -4.a El:

Auto Scale Axis

Ay Sl A (] s S s

...then going to Configuration - Rescale Mass Axis
(Section 9.3.2) will call up the editing window which will
display the newly defined preferences:
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Rescale Mass Axis

Ymax [mg]: [4.5000 EI:
Y'min [mg): -4.5000 3:

[]Auto Scale Axis

o [ o |

These new settings will not be implemented, however, until
they are confirmed by clicking OK (or by restarting the Control
software). The mass axis will then be rescaled according to
the new settings.

Upon altering the settings in the General Preference
Settings window, clicking Save will save the new settings.
Clicking Cancel will retain the previous settings.

921.2 Default Directories

General, ..

Default Direckaries. .,
Export Method File. .

Export Sequence File... Yideo 4

Export Data File. ., ) .
Post Experiment Instrument Settings. ..

Data Reduction Toal,.. ] )
Email Settings...

Sample Density Wizard, ..
P ! Calibration Feeminders. ..

Exit... Chrl+E [
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Clicking the Default Directories option calls up the following
window:

" Default Directories

Methods: | CADWSAdvantageimethod |E
Sequences: | CADYS -Advantagehsequence |E
Data: | CADVS-Advantagehdata |E

[] Backup Data Files:
To: | |

[ s [ oo |

These preferences allow the user to define where various
DVS files will be saved by default.

Methods: | C:HDWS -Advantageimethad |E]
Sequences: | C:ADWS -Advantagehzequence |E]
D ata: | C:ADWS-Advantageidata |E]

The default locations for Method, Sequence, and DVS Data
files can be specified here.

The following default directories are in place upon software
startup:

Methods: C:\DVS-Advantage\method
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Sequences: C:\DVS-Advantage\sequence
Data: C:\DVS-Advantage\data

To choose a different directory, click on the button at the
end of the relevant Output Directory box — the following
window will appear:

Browse For, Folder, @@

Select DWS Data Directory

[T Data ~
-5 DELL
|21 Documents and Settings
1) download
|5 DRIVERS
) Y5 Adv+
= [5) DvS-Advantage

I5) config

) data G
< I >
Make Mew Folder ] [ Ok ] [ Cancel

Upon selecting the desired folder and clicking OK, the newly
specified directory appears in the Output Directory box.

Backup Data Files

Backup Data Files:

To: | |E]

[] Delete ariginal data file after successiul backup operation
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This option specifies the backup directory to which a copy of
the raw Data files will be stored once each DVS Method has
completed. This option should be set to a directory location on
the network.

Using this option ensures that the DVS experiment is not
interrupted by a network connection failure. As the Data files
are saved to the network at the end of each Method, they can
then be more easily incorporated into the user’s normal IT
back up procedures.

In order to activate the Select Backup Directory option, the
tick-box next to the section header must be clicked:

Backup Data Files:

Selection of the Backup Directory works in the same way as
for the Method/Sequence/Data Directory, as shown above.

Delete original data file after successful backup operation:
If the raw data file backup operation is successful and this
option is selected, all raw data files produced by the
current DVS experiment that were saved to the Data
Output directory (as specified in Step 1) are deleted.

This option is also activated using a tick-box:

Backup Data Files:

To: E]
elete aniginal data file after successiul backup operation >

Note: If the backup operation is unsuccessful, the raw data
files will not be deleted from the Data Output Directory. This
ensures that the data will never be lost.
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Save/Cancel

Once the Default Directories have been specified, the settings
can be saved by clicking the Save button. Clicking Cancel
will retain the original settings.

Note: In the case of the Default Directories Preferences
described above, the settings become active as soon as they
have been saved — the Control software does not need to be
restarted to activate the newly specified preferences.

9.2.1.3 Video

Freferences General... ‘

) Default Directories...
Export: Method File,..

Export Sequence File... Widen Snapshat Tmage Overlay Settings. ..

Expatt: Data File, .. i ) Snapshat Image Format...
Post Experiment Instrument Settings. ..

Data Reduction Tool... ) Autamatic Snapshat Operation Mode. ..
Email Settings. ..

Sample Density Wizard. ..
P ¥ Calibration Reminders. .. [

Exit... Chr+E [

If the system has been fitted with the digital microscope
option, then it has the capability to take snapshots of the
sample. This can be done either manually or automatically.

The Video menu item determines the kind of information that
is overlaid on the sample pictures, the file format of these
pictures and whether they are taken periodically or at the end
of experimental Method Stages (see Section 9.5 for more
information on Methods).

For more information on taking sample snapshots and
formatting the snapshots themselves, please refer to Sections
9.8 and 10.7).

Snapshot Image Overlay Settings

) Default Directories. ..
Export Method File...

Expott: Sequence File...

General... ‘

Export: DataFile... Snapshot Image Format
Paost Experiment Instrument Settings, ..
Data Reduction Tool... Automatic Snapshot Cperation Mode. .,
Email Settings. ..
Sample Density Wizard...
P ¥ Calibration Reminders. .. [

Exit... CtrHE E
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Clicking this option calls up the following window:

7 Video Preference Setting

Snapzhot Image Overlay Settings

Mate: Thiz data will be automatically added to saved video images.

Partial Pressure %] Sample Temp. [*C})
() Target (%) Actual ) Target (%) Actual
| Save | | Cancel |

The Video Preference Setting window determines the type
of system information that is overlaid on the sample
shapshots.

The window above allows the user to select either the Target
or Actual Partial Pressure and Sample Temperature to be
displayed on the sample pictures (see also Section 10.4 on
the Instrument Data panel).

Once the preferred data format is selected, clicking Save
recalls the control software main interface. These
preferences are retained through software re-starts.

Any snapshot of the sample then displays the selected data -
along with the date. For instance, the following settings.....

T Yideo Preference Setting

Snapshot Image Overlay Settings
Mote: This data wil be automatically added to saved video images.

Partial Pressure [%] Sample Temp. [*C)

&) Target O Actual (O Target (3 Actual
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...... would be displayed in the top, left-hand corner of the
sample picture as shown below:

Thu Sep 25 20:10:13 2008 - Target PP: 0.00, Actual Temp: 25.00

CIDVS-Advantage'\data'test 9.1iff

In addition, directory location of the picture file is recorded in
the bottom left-hand corner of the frame.

For more information on taking sample snapshots, please
refer to Section 10.7.

Snapshot Image Format

General...
Default Directories...

Export Method File., ..

Export Sequence File... mage Overlay Settings...
Export Data File... g mage Format...
Paost Experiment [nstrument Settings., ..

Data Reduction Taal. .. ] ) | Autarnatic Snapshat Operation Mode. ..
Email Settings...

Sample Density Wizard. ..

Calibration Reminders... [

Exit... CirHE I
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This option determines the file format of the sample pictures.
Clicking Snapshot Image Format calls up the Video
Preference Setting window, which allows the user to choose
the file format of TIFF, BMP or JPEG:

7 Video Preference Setting E'

Snapzhot Image Format

Cancel |

Clicking Save returns the control software main dialogue
screen. These preferences are retained through software re-
starts.

With these preferences stored, the next time a sample
snhapshot is taken, the user will be prompted to save the file in
the selected format — no other format will be available unless
the preference settings are changed.

For example, if the following preference were stored.....

" Yideo Preference Setting [')E

Snapzhot Image Format

X v

50



DVS Advantage Operation Manual

..... then, upon taking a sample snapshot, the user would be
prompted to save the resulting picture file in BMP format only:

Enter ¥ideo Image Filename

Save in: |l’f)dala v| <] 7‘ % [
Y [calibration
My Recent
Documents
=
L
Deskiop

My Documents

My Computer
. File name: | N | [ Save ]
My Netwark | Save as ype: EMP Files [*.bmp) ~ Cancel

For more information on taking sample snapshots and saving
the resulting files, please refer to Section 10.7.

Automatic Snapshot Operation Mode

General..,
Default Directories...

Export Method File. ..
Expott Sequence File...
Expork Data File,..

Snapshat Image Overlay Settings...

Snapshot Image Format...
Post Experiment Instrument Settings. ..

Data Reduction Toal, .. . )
Email Settings. ..

Sample Density Wizard...

Calibration Reminders. ..

Exit. .. ChrH+E I

When data is not being saved, sample snhapshots may be
taken manually by clicking the Take Snapshot button on the
Video tab (refer Section 10.7).

However, if data is being saved, then snapshots can only be

taken according to the settings of a running Method (refer
Section 9.5) or at pre-determined time intervals.
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The Automatic Snapshot Operation Mode allows the user
to choose between the options stated above.

Clicking the Automatic Snapshot Operation Mode option
calls up the Video Preference Setting window:

T Video Preference Setting g|

Dperation Mode: Automatic Snapshots

) Use video settings in method
() Timed Intervals:

Take video image eveny:

1 3: rinute[z]

[ [ o= |

The options available are:

Use video settings in method:

This option ensures that sample snapshots will be taken
according to the settings in a running Method.

In order for any pictures to be taken in this case, a Method
must be running, which has been set to activate the camera at
the end of each Method Stage.

For more details on Method settings, please refer to Section
9.5).

Timed Intervals:
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This option ensures that sample pictures will be recorded at
the interval set (in minutes) whenever data is being saved —
with or without running a Method.

Clicking the Timed Intervals option activates the data entry
box entitled Take video image every: as shown below:

T Yideo Preference Setting §|

Dperation Mode: Automatic Snapshots

() Use video settings in method

%) Timed Intervals:

T ake video image every:

1 3: minute[z)

[ 5w ][ coed |

The number of minutes that may be entered ranges from 1 to
9999. The figure may be entered directly or by using the
arrows at the side of the data entry box.

In the window shown above, clicking Save would ensure that
a sample picture would be taken every one minute whenever
data was being saved — either by running a Method or by
saving data only.

The Video Preference Settings, once saved, are retained
through software re-starts.

Whether saving pictures though Method settings or at Timed

Intervals, the pictures taken are saved in the same directory
as the system data files (refer Section 9.2.1.2).
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Note: When data is being saved, the video preference option
for Automatic Snapshot Operation Mode becomes inactive.
However, the other video preference settings — Snapshot
Image Overlay Settings and Snapshot Image Format may
be altered during data saving.

9.2.1.4 Post Experiment Instrument Settings

General...

Default Directories. ..

Export Method File.. .
Export Sequence File, .. Yideo

Export Data File. ..

Posk Expetiment Instrument Settings. ..

Data Reduction Tool, .. ] ]
Email Settings. ..

Sample Density Wizard, .,
F Y Zalibration Reminders.. .

Exit... CkrH-E [

The Post Experiment Instrument Settings option allows the
user to specify the post-experiment flowrate and partial
pressure of the system.

This is particularly useful if, for instance, the sample needs to
be preserved under specific conditions before finally being
removed from the DVS Advantage system.

Clicking the Post Experiment Instrument Settings calls up
the Edit Post Experiment Settings window:
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" Edit Post Experiment Settings E|

Specify the Target % Partial Preszure
and the Total Gaz Flow to use when the
Sequence runz have completed.

Target % PP 0.00 =

Total Flow Rate 200 [soom)

k. ‘ ‘ Cancel ‘

When first opened, the window will appear with default
settings shown above.

The post-experiment Target %PP may be directly entered
into the data-entry box or by using the up and down arrows to
the box’s right. The permissible target partial pressure values
range from 0 to 100%.

" Edit Post Experiment Settings E|

Specify the Target % Partial Prezsure
and the Tatal Gaz Flow to use when the
Sequence runz have completed.

Target & PP 0.0o =

Total Flow Rate 200 [gcom]  w

200 [zoem)
150 [zcem)

120 [zzom)
] 100 [goem) :|
75 [zoom]

B0 [zcom) 55

20 [zozm)
10 [zocm]
0 [scocm)
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The Total Flow Rate is set by using the drop-down list as
shown below:

Only the Total Flow Rate values shown on the list above may
be used. They can be set by either selecting them on the list,
or by typing digits into the display box, which will call up the
closest flowrate figure from the list.

Clicking OK will set the entered values, and return the DVS
Advantage Control software main interface.

Clicking Cancel will also return the Control software main
interface, but without setting the newly entered values.

Note: The Post Experiment Settings are retained through a
software re-start — they do not revert to default values when
the Control software is shut down.

9.2.1.5 Email Settings

Freferences General..,

Default Directories. ..

Export Method File. ..
Export Sequence File. ., Post Experiment Inskrument Settings. .,

Export Data File. ..

Email Settings. ..

Data Reduction Toal, ., o .
Calibration Feminders. .,

Exit... Chrl+E I

The control software can be set to send emails notifying the
user of when an experiment has completed, and also when an
error has occurred.

Clicking File>Preferences>Email Settings... calls up the
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Email Settings Editor window:

" Email Settings Editor

X

Email Seltings

SMTP Server: |

From : | dvz@yourlab. com

|
|
Tao: | |
|
|

cc: |

Subiject : |An email natification from your WS Advantage instrument

Email Notifications

\Experimeﬂtsl Enors |

[ Send an email if a system emor acours

Email Body:

An erar has occured on the DVS Advantage instrument. Please forward this email to your local
Sk5 representative.

EnES
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Email Settings
e

[ —

Email Settings

SMTP Server:
From: | dvs@yourlab.com

To:

CC:

Subject : | &n email notification from pour 0VS Advantage instrument

This box allows the user to define the SMTP Server, the
recipient addresses for the emails, and the email Subject
header (the default message shown below may be edited).

It may be necessary to enlist the help of the local IT
Administrator to help configure these settings.

SMTP Server

This needs to be set to the name of the e-mail relay server to
be used. If the SMTP Server field is left blank, the name of
the local SMTP server is used.

Note: Windows XP computer administrators, please refer to
Section 17.1.5.8 for more information on configuring SMTP for
the email function to work.

58




DVS Advantage Operation Manual
Once the necessary details have been filled in, clicking the
Test button will call up the following window:
Send Test Email rz|

1 ) The test email was sent successfully,

Clicking OK returns the Email Settings Editor window.

Shortly after the Test button is clicked, a test email of the form
shown below is sent to the recipients:

Email Notifications

B An email notification from your DVS Advantage instrument - Message (Plai... |ZHE|E|

i File Edit Yew Insert Formst  Iools  Ackions  Help

E.L!E,_%Baply\;,%Replytoﬂl_lh_%Forﬂardhj EER =N AT A AN o’

From: duncanSpamMail@spamEveryone.com Sent:  Fri 13/06/2008 14:37
To: Duncan Pearse
Co:

Subject:  An email notification From your DYS Advantage instrument

h‘hls iz a test emaill generated by your DVS Advantage instrument.
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This box allows the user to specify the information that will be
contained in, and attached to the emails sent from the DVS
Advantage system.

Experiments tab

Email Motifications

™ Send an email natification when experiments complete. -

Email Body:

A DVS Advantage experiment has completed.

This tab specifies the content of emails sent regarding
experiments.

The emails are activated by checking the box entitled Send
an email notification when experiments complete.
Checking this box also activates another check box entitled
Attach raw data file(s):
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W :Send an emall notification when experiments complete. | [ Attach raw data filefs).

Checking this second box ensures that the DVS raw data file
(.dat) is attached to the email when the experiment
completes.

The email body box allows the user to specify any text which
is to be included in the email notification:

Email Body:

A DVS Advantage experiment has completed.

The default text shown above may obviously be edited as
desired.

Once all the necessary options are specified, and a DVS

experiment has completed, then an email of the form shown
below is sent:
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B An email notification from your DVS Advantage instrument - Message (Plai...

! Fle Edit Wew Insert Format Tools  Actions  Help

LA E_i&&eplvlcﬁReplvtoAHI-L-?.Forwardld e SR X | e-]©

From: duncanspamiMail@spamEveryone, com Sent:  Fri 13/06/2008 14:46
Ta: Duncan Pearse
o

Subject:  An email notification From your DYS Advantage instrument

Attachments: &l sample - Fri 13 Jun 2008 14-43-41.dat (1 KE)

A DVE Advantage experiment has completed.

Errors tab
[Fmasepie &

[Ty
P

Fon! [ deatbyensi o

[ P e S ey P ——

™ Send an email if a spstem emrar occurs

Email Body:

A emor has occured on the DWS Advantage instrument. Pleasze forward this email ko your local
5SS representative.
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This tab specifies the content of emails sent regarding errors.

The emails are activated by checking the box entitled Send
an email if a system error occurs.

The email body box allows the user to specify any text which
is to be included in the email error notification:
Email Body:

An eror haz occured on the DWS Advantage instrument. Please forward thiz email ba your local
SHS reprezentative.

The default text shown above may obviously be edited as
desired.

Once all the necessary options are specified, an email of
similar form to those shown above is sent in the event of an
error occurring.

After the desired email settings have been entered, clicking
Save calls up the following confirmation message:

Email Setting Saved ﬁl

‘Er) Your Email Setkings have been saved.

Clicking OK returns the DVS Advantage Control software
main interface.
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9.2.1.6 Calibration Reminders

General...
Default Directories. ..

Export Method File, ..
Export Sequence File. .. Wideo 3
Export Data File. ..

Post Experiment Instrument Settings. ..

Data Reduction Toal. .. ] _
Email Settings. ..

Sample Density Wizard, ..

Calibration Reminders. ..

Exit... Chrl+E [

The DVS Advantage Control Software can be set to provide
the user with regular reminders to calibrate the system.

Clicking File>Preferences—>Calibration Reminders.... calls
up the Edit Calibration Reminders window:

I Edit Calibration Reminders

Balance Calibration

¥ Enable Monthly Balance Calibration Reminders

Next reminder datetime: | 13/07/2008 10:25:00

Fartial Frezsure Syztem Calibration

¥ Enable Partial Pressure System Calibration Reminders

Perform the zalt experiments every
Mest reminder datetime: | 13/06/2009 10:25:00

Incubator D efrost

¥ Incubator Defrost Reminders

Perform the Defrost cycles eveny W
Next reminder dateime: | 13/09/2008 10:25:00

[ [ o ]
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Note: The reminders are triggered by the completion of an
experiment. If the system is sitting idle the reminders will not
spontaneously activate — the system needs to be in use for
the reminders to function.

The chosen reminder settings are retained through control
software re-starts.

Balance Calibration
B alance Calibration

v Enable Monthly Balance Calibration Beminders

Mext reminder datetime: 1340742008 10:25:00

This reminder is set to monthly only, and can be activated by
ticking the check-box. As shown above, the date on which
the next reminder is due appears in the display box — it will be
set to one month from when the check-box is ticked.

For more information on balance calibrations, please refer to
Sections 7.2 and 9.7.1.2.

Partial Pressure System Calibration
Partial Preszure Systern Calibration

[v Erable Partial Pressure Spstem Calibration Reminders

Perfarm the zalt expeniments evern 12 months | w

5 manths
B months
7 mianths
3 maonths
9 maonths
10 months
11 months

Mext reminder datetime: 13406420
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Partial pressure calibrations involve performing salt tests on
the system (refer Appendix B, Section 12).

The reminders for these experiments are activated using the
check-box indicated, and their frequency can be set using the
drop-down menu shown above. Again, the due date for the
next reminder is displayed in the window at the bottom of the
panel.

It is recommended that the salt tests are performed at least

every six months.

Incubator Defrost

Incubator Diefrozt

v [ncubator Defrost Reminders

Ferfarm the Defrost cycles every 3 months "

Mext reminder dateftime: | 13409714 manths
A maonths

B months
7 manths
2 maonths
9 manths
10 months v

For more information on refrigeration maintenance please
refer to Section 7.1.

The reminders for the defrosts are activated using the check-
box indicated, and their frequency can be set using the drop-
down menu shown above. The due date for the next
reminder is displayed in the window at the bottom of the
panel.

66



DVS Advantage Operation Manual

The window first appears with a defrost frequency of 3
months, which is the recommended minimum — however, the
ideal frequency is monthly.

When an experiment has completed and a reminder is due, a
Calibration Reminder window appears as shown below.

Calibration Reminder

[The DWS-&dvantage Balance iz due for re-calibration.

Flease click the Calibration --»Calibrate Balance menu item to begin the calibration
procedure.

The 045 -Advantage Partial Preszure System iz due for re-calibration.

Flease re-calibrate the Partial Pressure System by performing salt experiments uzing the
Calibration --»Sakvent Lookup Tables renu iter.

The 0%S-Advantage incubator iz dus ta be defrosted.

Fleasze defrost the incubator - refer to Chapter 7 of the DWS Advantage Operation Manual for
further details.

Click. the Snooze button if pou would ke to be reminded again after pour next experiment.,
Click. the Dismizs button if you intend to perform the calibration procedure(s] now.

[ Snooze l I Dizmnizz

In the example shown above, all three reminders are
activated. The Calibration Reminder will display all of the
due reminders in one window. Each reminder provides
instructions on where to find information on how to perform
each calibration.

As indicated, the reminder also informs the user that clicking
Snooze will ensure that the reminders re-appear after the
next DVS experiment has run its course, and that clicking
Dismiss will automatically update the reminders to appear at
their next due date.
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9.2.2 Export Method/Sequence/Data File

These functions export
the details of a Method,
Preferences d Sequence or Data file to

a Text format (.txt) file.

Export Method File. ..

Export Sequence File. ..
Export Data File., .

This is useful in cases
where, for instance, the
user may wish to
analyse a Data file in a

Data Reduction Taoal, .

Sample Density Wizard.., format other than Excel,
_ or if the user wishes to
Exit... Chrl+E view the details of a

Method or Sequence
file without using the Control software.

Clicking any of the Export Method, Sequence or Data File
options calls up the following window (in this example, a
Method File is being exported):

Select DVS Advantage Method File E]@
Look ir: | ) method “ OF o
N @ — ,p‘ré .........................................................................
My Recent
Documents
'_P%%
Desktop
My Documents
My Computer
] = E— -
My Network. Files of type: Methad Files [".sa0." pre] w |

Figure 9.1: The Select DVS Advantage Method File window

68



DVS Advantage Operation Manual

The Select DVS Advantage Method File window opens the
directory specified in the Preferences toolbar option (Section
9.2.1.2). If desired, the user may navigate to a different
directory using the Look in: drop-down menu.

Upon selecting the file to be exported and clicking Open, the
Enter Target Export Filename window appears:

Enter, Target Export Filename @@

Save in: | |2 method v ] > El,

&

My Recent
Documents

\

by Documents

I
"]

%59

Y

by Computer
‘,11 File name: exported method file. bt b
My Metwork. | Save as tpe: Text Files [*.bxt) v

Figure 9.2: The Enter Target Export Filename window

This window allows the user to specify the name of the
exported .txt file and to save it in the desired directory. By
default, the window navigates to the same directory as that
specified in Preferences (as per above). The Save in: drop-
down menu may be used to navigate to an alternative
directory.

Upon clicking Save, the following dialog box appears:
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Export Method

- | ) The method file has been exported successFully,

Upon clicking OK, the Control Software interface is returned.

As an example, the .txt format of the exported Method file is
shown below:

B exported method file.txt - Notepad

File Edt Format Wiew Help

DWS ADVANTAGE PREHEAT METHOD FILE
varsion: 1
Filename: c:vpvs-advantageimethod\test. pre

Method File Created: Mon DeC 18 16:51:28 2006
Author:

Stage# Start Temp. (C)  Stop Temp. (C) Time (min.)
1 25.0 25.0 180.0

2 25.0 200.0  180.0
3 200.0  200.0  180.0
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9.2.3 Data Reduction Tool

Preferences b

Export Method File. .
Export Sequence File. .,
Export Data File. .

Data Reduckion Taoal., ..

Sample Density Wizard, ..

Exit. .. Chrl+E

The Data Reduction
Tool reduces the number of data points exported from a .dat
file to Excel. This is especially useful in cases where the .dat
file contains too many data points to fit into an Excel file.

Note: Although later versions of Excel can accommodate
around one million data points, the current maximum of data
points that the DVS Analysis Suite can handle is around sixty
thousand, which is the same capacity as older versions of
Excel (2003 and earlier).

Large .dat files will therefore need to be reduced to around
sixty thousand data points at most if they are to be used with
the Analysis Suite software.

Also Note: Using the Data Reduction Tool does not affect the
contents of the .dat file — the whole file can be exported to
Excel in full at a later stage if desired.
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Clicking the Data Reduction Tool option calls up the
following window:

Data Reduction Tool FX|

If the amount of data contained in a raw data file iz too big for Excel®
to handle, uze this tool to reduce the number of data points exported.

Export every Mtk row of data from the raw data file,

whereW = | 10 3

Ok I l Cancel ]

The window features a data entry box which allows the user
to define the level of data reduction required. The window will
always open with the default setting of exporting every 10th
row of data to excel. This can be altered to anywhere
between a minimum of 1 and a maximum of 600.

If a figure below 1 is entered, then the software will revert to a
default of 1, if a figure above 600 is entered, then likewise a
default of 600 will be used.

In the example shown below, every 2" data point is to be
exported:

Data Reduction, Tool &l

If the amount of data contained in a raw data file iz oo big for Excel®
to handle, use thiz tool ta reduce the number of data points exported.

Esport every Mth row of data from the raw data file,

Fs

where M = 2 &

Ok ‘ [ Cancel ]
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Once the desired level of data reduction has been specified,
clicking OK initiates the Export Data File process explained
above in Section 9.2.2.

The exported data file, once opened in Excel, will display a
reduced number of rows according to that specified in the
process above.

Figure 9.3 below compares the ‘reduced data’ file (with every
2" data point exported to Excel) with the same file if it had
been exported to Excel with no data reduction:

Tirme (min) Mass Tirme (min) Mass
0.01 a 1.01 a
1.01 a 3.03 a
202 a 5.03 a
3.03 a 7.04 a
4.03 a 8.05 a
5.03 a 11.08 a
B.04 a 13.06 a
7.04 a 15.07 0
8.04 a 17.07 0
8.05 a 19.08 a

Figure 9.3: The same data file exported to Excel with no data
reduction (left) and with every second data point exported
(right) — the ‘reduced data’ will, naturally, occupy half the
number of rows of the original.
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9.2.4 Sample Density Wizard

Preferences ¥

Export Method File. ..
Export Sequence File. ..
Export Daka File, .,

Data Reduction Toal, .,

Sample Densit

Exit... Ctrl+E

This Wizard provides
clear, step-by-step
instructions on how to
use the DVS system to
perform an experiment
which allows the
calculation of the bulk
density of a sample:

The experiment is

based on Archimedes principle, and involves weighing the
sample in two different carrier gases. The rest of the Wizard
windows are not shown here, they are self-explanatory.

Sample Density Wizard

‘Welcome to the Sample Density Wizard .

density of & sample.

Click the Mext button to begin..|

This wizard provides step by step instructions of how to perform an experiment to calculate the bulk

The experiment is based on Archimedes principle: the net upward buoyancy force is equal to the
magnitude of the weight of fluid displaced by the body. In order to use Archimedes principle to measure
the density of a sample, it is necessany to weigh the sample in two (2) different camier gases. For best
results, select two (2) different camier gases with significantly different densities. e.g. Air and Helium.

Mext l l Cancel
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9.2.5 Exit

Preferences »

Expart Method File, ..
Expart Sequence File. .,
Expart Data File. ..

Data Reduction Taoal, .

Sample Density Wizard. ..

Clicking the Exit option calls up the following dialog box:

Shutdown Confirmation

9P About ko shut down the DYS Advantage software. .

Are you sure wou wank ko guit?

I Ves l [ Mo ]

Clicking Yes shuts down the Control software. Clicking No
returns the Control Software interface.

Sampling Rates, ..

En = Rescale Mass Axis. .

j= bl Rescale % Partial Pressure Axis. .,
) T Emms Counker Weight, ., ,
= —— = Zontrol Mode. ..

v Diagnostics Tab Visible

(SIS EeE]
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The Configuration option provides access to various panels
and functions for changing Configuration settings which
control the operation of the DVS instrument.

9.3.1 Sampling Rates

Configuration

Sampling Rates. ..

Rescale Mass Axis, ..
Rescale %% Partial Pressure fxis, .,

Counker \Weight. ..
Contral Made, ..

v Diagnostics Tab Visible

Clicking the Sampling Rates option calls up the following
dialog box:

" Sampling Setup

Sampling B ate:

Cave Data Fate:

‘ ak. ‘ ‘ Cancel ‘

This window may be used to set both the interval at which the
data is updated on screen (Sampling Rate) and the interval
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at which data is saved to the DVS raw data file on the hard
disk (Save Data Rate).

The Sampling Setup window will open with the values set in
the General Preferences Settings window (see Section
9.2.1.1).

To alter either value, simply click on the relevant edit box or
the arrow next to it to reveal the drop-down menu which
shows all the available sampling rates:

T Sampling Setup @

Sampling Rate: |1 ;00 w0

Save Data Rate: |1 ;o0

<

2zec. A
B zec.
10 zec.
Dk 20 sec. el
1 mir.
2 min.

B min.
18 min._ %

Clicking OK will set the new values, while clicking Cancel will
reinstate the previous rates.

Note: The Sampling Rates menu item is disabled whenever
data is being saved.

Data saving must be stopped to enable this option for use.
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9.3.2 Rescale Mass/Partial

Pressure/Temperature Axis

Configuration

Sampling Rates. ..

rescale Mass fxis, .,

Counker \Weight. ..
Conkral Made. .,

v Diagnostics Tab visible

Rescale % Partial Pressure Axis, ..

OR Rescale Temperature Axis option will

These options allow
the vertical axes on
the Mass Graph panel
(Section 10.3) to be
rescaled at any time
before, during, or after
an experiment.

The Rescale Mass
Axis option will always
be active, whereas
either the Rescale
Partial Pressure Axis
be active

depending upon which is displayed on the graph (Section

10.3.2).

Note: The Rescale Axes options described above may also
be accessed by right-clicking on the Mass Graph panel
(Section 10.3.6) or by clicking the buttons which appear on
the top of the Mass Graph panel (Section 10.3.1.2).

Clicking any of these options calls up the following window:

Rescale Mass Axis

Ymin [ma]:

Y'max [mg):

pom
jomon =

Auto Scale Axis

|

oK
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The example shown above is the Rescale Mass Axis
window. The window will first appear with the settings defined
in the Preferences settings (Section 9.2.1.1).

With the Auto Scale Axis option ticked, the axis will
automatically scale to fit the entire range of values covered by
the plotted parameter.

Un-checking the Auto Scale Axis box activates the Ymax
and Ymin windows:

Rescale Mass Axis

Ymax [mg): (0.0100 3:
Y'min [mg): -0.0100 3:

[ Auto Scale Axis

T T

The units displayed for Ymax and Ymin will correspond with
the parameter on the axis being rescaled — Mass (mg), Partial
Pressure (%) and Temperature (°C).

The desired Ymax and Ymin values can either be entered
directly, or the up and down arrows can be used to increase
or decrease the limits.

Clicking OK then returns the Mass Graph panel showing the
newly rescaled graph.

Note: The parameters entered when rescaling the graph will
not be retained upon re-starting the Control software. To
retain the new parameters, they must be entered in the File
->Preferences option on the toolbar (see Section 9.2.1).
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onfigur ation

Sampling Rates, ..

Rescale Mass Axis, ..
Rescale % Partial Pressure Axis, ..

Counker Weight., ..
Control Mode, .,

v Diagnostics Tab Yisible

9.3.3 Counter
Weight

This option changes
the counter weight
value setting in the
software  for those
occasions when a
counter  weight is
being used to analyse
larger samples.

Clicking the Counter Weight option calls up the following

window:

T Set Counter, Weight

Counter Weight [mag): |0.0000 E|j

T T

The counter weight value may be entered directly or by using
the up and down arrows on the right hand side of the edit box.
The value specified will be added to all mass readings from

the balance.

Clicking OK will save the new data, while clicking Cancel will

reinstate the previous setting.
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Note: The Counter Weight menu item is disabled whenever
data is being saved. Data saving must be stopped to enable

this option for use.

9.3.4 Control Mode

Configuration

Sampling Rates. ..

Rescale Mass Axis. ..
Rescale % Partial Pressure Axis, ..

Counker Weight., ..

Conkral Mode, ..

v Diagnostics Tab visible

Clicking the Control Mode option
window:

This function
determines how the
partial pressure

generated from Solvent
A (left-hand bottle) and
Solvent B (right-hand
bottle) is regulated.

calls up the following

Select Control Modes

Solvent A:

Solvent B:

The control mode for each solvent may be set to Open Loop

or Closed Loop:

Select Control Modes

Solvent A:
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Closed Loop: This involves using feedback control to
regulate the amount of vapour that is
generated in the DVS system.

Closed loop control recognises if the actual
amount of vapour in the system is incorrect
and adjusts the system’s vapour generation
in order to reach the desired target partial
pressure.

Open Loop: This involves using a Solvent Lookup Table
(see Appendix D in Section 14) to
determine what vapour generation is
required for a given solvent at a given
temperature to achieve a particular partial
pressure. No feedback is used.

When the Select Control Modes window is first opened it
displays the options selected in the Preference Settings
(Section 9.2.1).

Note: The Control Mode menu item is disabled whenever a
Sequence is loaded or data is being saved. The Sequence
must be cleared or data saving stopped to enable this option
for use.

9.3.5 Diagnostics Tab Visible

Configuration

' When this option is
Sampling Rates. ., checked, the
Diagnostics panel
(shown  below) is
visible on the DVS
. Advantage Control
Counker Weight,. . _Software main
Caonkral Mode. . interface. When

Rescale Mass fxis, .,
Rescale % Partial Pressure fxis, .,

v Diagnostics Tab Visible
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unchecked, the panel is hidden.

* Dynamic Vapour Sorption - Advantage
Fle Corfiguabon Sobverks Method Sequerce Calbration Wideo Heb

Q2N

Siotur Plesdy

Mant Gragh | Inataument Dath | Sequence | Active Method | Video | Fun Experiment | Diiggrastics

pea Euromemn
Tme Hemaining ToAuto DUL: 18 Hienss &5 M, 71 See Taugel PP oam
Adrted Tagst P/Px 003
0507 161 G0aaT 201 T D Pt iR
e e e Targel Wel Flow [scem]. | 000
Target Doy Flow frcomb om
o =
Meavaing @
Torges Fibm Thichsmes 150 hchund PP 005
DOC Mode
et Fim Thick: 1 At Dew Pork 61,00
e Ly HoldHode o :
Actve PID Set. SET_V ok Achisl Sample Temp. BT
[ a7
tntierd Temp.: 1488 Shany
Hiaal Punp Digiatsion: =8 Dalance - Ml Misas Duipee
Codlrg
Lostbog. @ QEEE S
Heong

Suface Measuement Syatems © 2000

See Section 10.10 for more information on the Diagnostics

panel.

9.4

Solvents

Select Solvents, ..
Edit Solvents, ..
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This option allows the user to specify which solvents are
installed in the DVS. It also allows the user to update a
database of solvents which may be used in the system.

Note: The Solvents menu is disabled whenever data is being
saved. Data saving must be stopped before the menu may
be used.

9.4.1 Select Solvents

Salvents

Edit Salvents, ..

Select Saolvents., ., |

(See also Section 10.2.1).
Selecting this option calls up the following window:

" Salect Solvents @

SolventA

SolventB

[waTER v

The Select Solvents window allows the user to specify which
solvents are present in the system — Solvent A (left bottle) and
Solvent B (right bottle). Refer also to Section 6.3.2.1 which
details the changing of solvents in the DVS.

Clicking anywhere in the edit boxes or on the down arrows to

their right will reveal a drop-down list of all of the available
solvents which are stored in the Control Software database:
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I Select Solvents 3

SolventA

Ok Cancel

Note: It is very important that the software correctly ‘knows’
which solvents are present in the system — otherwise it will
cause the DVS system to generate incorrect partial pressures.

9.4.2 Edit Solvents

Salvents

Select Saolvents, .,
Edit Solvents...

Note: The DVS Advantage uses an equation from Perry’'s
Chemical Engineers Handbook (7th Edition) Table 2.6 to
convert from Dew Point to Partial Pressure and vice versa.

This conversion equation requires five constants for each
solvent involved in the calculation.

The constant values for a particular solvent can be found in
Perry’s Chemical Engineers Handbook (7th Edition) Table
2.6

When adding a solvent to the solvent database (Section
9.4.2) which is not contained in the Perry’s table mentioned
above, please refer to Appendix F (Section 16).
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Clicking this option calls up the Solvent List window:

" Solvent List K
Od
Solvent Ll |c2z |3 |c4 | €5
'+ |DODECANE 137 .47 11978 16 B398 £ 0906E -0F 2
 |ETHANOL 74475 -F1E4.3 -7.327 3134E-06 &
. |ETHYLACETATE EE.824 62276 -B.41 1.7914E17 B
. |HERANE 104,85 -6935.5 2702 1.2381E-08 2
. |METHANOL a1.768 6876 -8.7078 7.1926E-06 2
 |DCTANE 96.084 -7900.2 -11.003 7.1802E-06 2
WATER -7258.2 -7.3037 4.1653E-06 2

Done

The Solvent List shown above displays the constants used in
the Perry’'s Handbook equation to calculate their partial
pressures. This table allows the user to configure the
solvents that may be used in the DVS system.

9421 Creating and Editing Solvent entries

There are two buttons on the Solvent List toolbar: Create a

New Solvent Entry O and Edit the Selected Solvent &
as shown below:

>0

Create a new solvent entry 2
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Clicking this button calls up the Enter New Solvent window:

" Enter, New Solvent

Name: |
ci: [0 | ca: [0
cz [0 | s [0
c3 [0

Figure 9.4: The Enter New Solvent window

This button may be used to create a New Solvent entry in the
Solvent list. The solvent name and its corresponding constant
values from Perry’s Chemical Engineers Handbook (7th
Edition) Table 2.6 must be entered in the relevant edit boxes.

Clicking OK will then add the new entry to the list of available
solvents.

Edit the selected Solvent &
Clicking this button calls up the Edit Solvent window:

Mame: |

Cl1: [10465 | ca: [1z381E08
c2- [B3a5s | cs: |2
c3: [12702
[ ak I l Cancel ]

The window will display whichever solvent was highlighted in
the Solvent List.
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This button may be used to edit the settings for an existing
solvent entry in the Solvent list.

Note: Using this option should only be necessary if a mistake
was made when previously entering the settings for a solvent.

The solvent name may be altered (except in the case of
WATER) and also the corresponding constant values that
come from Perry’s Chemical Engineers Handbook (7th
Edition) Table 2.6.

After the desired changes have been made, clicking OK will
update the solvent details in the Solvent List.

9.5 Method

The Method menu can be used to create new DVS Methods
OR to edit existing DVS Methods.

S Preheat 3

Partial Pressure  #

A Method file contains a series of pre-defined Preheating or
Partial Pressure Stages. Methods are loaded in series to
form a Sequence (Sections 9.6 and 10.5), which allows a
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DVS experiment to run automatically without the need for any
user involvement.

Note: The Method menu may also be called up by selecting
the Active Method tab and right-clicking the mouse anywhere
on the panel (see Section 10.6.4).

There exist three different types of DVS Advantage Methods:

Preheat Method: Used to dry out the sample by
controlling the preheat
temperature over user-defined
time periods. The maximum
preheat temperature setpoint is
200°C.

Partial Pressure Method: Used to control the amount of
vapour that is sent into the
sample area.

DCC method: In order to maintain the accuracy
of the Optical Sensor reading it is
recommended that the user
perform a Dynamic
Contamination Correction (DCC)
cycle prior to running a partial
pressure method.

To do this, simply load the
“Clean.dcc” Method that can be
found in the DVS Advantage
Method  directory into the
Sequence immediately before the
Method that is to be run.

See Appendix E (Section 15) for
more information regarding the

Optical Sensor Dynamic
Contamination Correction
procedure.
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Note: Running a Clean.dcc Method before each new Partial
Pressure method in a Sequence is STRONGLY
recommended.

9.5.1 Preheat

Methad
Preheat * New Method... This option allows
Edit Method, . the user to create
Partial Pressure  # and edit Preheat

Methods for DVS
experiments.

| Note: The maximum preheat temperature setpoint is 200°C.

9511 New Method

Preheat Mew Methaod, ..

] Edit Methad. ..
Partial Pressure  #

Clicking Method->Preheat—New Method... calls up the
Preheat Method Editor window:
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Preheat Method Editor |X|
0

 Methad Stages | Method Settings

| | | I |
275 330 385 440 435
Time [mir.]

Stageft - | Start Temp.['C] | Stop Temp.['C) | Time [mir.]

Figure 9.5: The Preheat Method Editor window

The Preheat Method Editor window looks similar to the
Active Method panel on the main DVS Advantage dialog
screen (Section 10.6) — it similarly features a Method Stages
tab and a Method Settings tab.

Té..H.‘?Eh!??!.?.?ﬁ?ﬁ.‘?ﬁ.E Method S ettings

At the top of the window are two buttons which allow the user
to save Preheat Methods and to close the editor:
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s L W

Save Method @

Clicking the Save Method
Save Hethod button @ saves a Preheat
Default Mew Row Settings. .. Method to a file after it has
Insert IsoTherm Steps... been formulated in the Method
Inserk Isofctivity Steps... Ed itor.

Exit...

Note: The Save Method option only becomes active after a
Method has been created (see sections below).

Once the Save Method button has been pressed, a Save
Preheat Method window is opened, requiring the user to
name the new Preheat Method file:
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Sawve Preheat Method [ @

Save in: | |5 method v | €) T e m-
5 @sms_service
4 :a preheat test 1.pre
My Recent preheat test 2.pre
Documerts preheat test 3.pre
7= preheat test 4.pre
|_ preheat test 5.pre
Desktop preheat test 6.pre
preheat test 7.pre
- preheat kest &.pre
My Documents
My Computer
‘% File: riame: | v | [ e ]
Iy Metwark. Save as type: | Preheat Method [* pre) v | [ Cancel ]

The Save Preheat Method window automatically navigates to
the directory specified in File > Preferences - Default
Directories (Section 9.2.1.2), but a different location may be
specified using the Save in drop-down menu:
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Save Preheat Method

Savein: | () method vl @2 e E-
% My Recent Documents
=\ Desktop
t\ﬁ (£ My Documents
My Recent "¢ My Camputer
Documents e VAID [T
= |5 DWS-Advantage
L [ Jthoc]
Desktop e WaI0 (D]
= MemanyStick (E:)
. b DVD-Rw Drive [F:)
_,,./' ‘«aﬂ Femovable Disk [G:]
=%, MasterProductionDrawings on 'Smeuk\Data' |
My Documents ;g researchanddevelopment on ‘moisture’ [R:]
;‘g ComparyData on SmaukhData' (5]
- ;g DPearze on 'SmeukhData\Users' [1:)
3’1)5 \g My Network Places
My Camputer 123 musictheory.net
|5) Purchase arders
_ File name: | 4 | [ Save ]
My Hetwork Gave a3 type: | Preheat Methad [* pre] v | [ Cancel ]

As the pictures above show, Preheat Method files are saved
with the extension .pre (ie; preheat).

Normal Windows Explorer functions are available in the Save

Preheat Method File window.

Right-clicking on a pre-

existing file in the window calls up the following menu:
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select

fF Open

F B addto archive...

F & add to "preheat test 1.rar"
F & Compress and email...

F B Compress ko "preheat test 1.rar" and email

!
Send To

Cuk
Copy

Create Shaortcut
Delete
Rename

Properties

e T B e e e ]

Files can be deleted, renamed, etc, before the new Preheat
Method file is saved.

Right-clicking in a blank space in the window calls up the
following menu:

After the new Preheat Method file has been named in the
Filename box, clicking Save then saves the new Preheat
Method and returns to the main DVS Advantage dialog
screen.
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Save Probeat Methad FX
Savec | 1) wthed M o e@-
D 3
My Recert o |
Drcument: b |
=
L =
Dekwg |
g
e
w8
My Comguter
hi Fil e parheal et 1 g - S I'."lEW b
Hy Netwrk. Save ol vpe - -
Arrange Icons By k
Refresh
Mew b
Properties

Close Method Editor w

Clicking the Close Method Editor button @ pefore the
Method has been saved will call up the following message:

Close Confirmation x

9, ‘fouare about ko lose all changes you made to this method,
\.._':/

Are you sure you wank bo continue?

[ Yes l [ Mo

Clicking Yes returns the DVS Advantage main interface, while
clicking No returns the Preheat Method Editor window.
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Method Stages Tab: Creating a Preheat Method

i Methad Settings

Stagel | Start Temp.[*C) | Stop Temp.["C) | Tirme [min.]

Rows Data

A Preheat Method is created by defining Rows (Stages) in the
Temperature Table of the Method Stages tab. Each row
(Stage) defines the following parameters:

Stage.#

Stagett |

This denotes the number of the Stage and cannot be
edited - new Stages are added or appended, the
numbers will change automatically.
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Start and Stop Temp (°C)
These values define the Temperatures at which each
Preheat stage begins and ends, respectively.

Start Temp.[*C] | Stop Temp.[C]

If the Start and Stop Temp values are the same, then
the Stage will be set at one constant temperature. If the
values are different, then the Stage will ramp between
the Start and Stop temperatures.

The minimum allowable Temp setpoint is 5°C
The maximum allowable Temp setpoint is 200°C

Time (min.)

Tirne [min.]

This defines the amount of time taken (in minutes) for
the Stage to go from the Start Temp to the stop Temp.

If the Start and Stop temperatures are the same, then
the Time will define how long the Stage lasts on this
constant temperature.

The minimum allowable Time setpoint is 2 min.
The maximum allowable Time setpoint is 9999 min.

If the Start and Stop temp are different, then the Time
will define the period over which the temperature ramp
occurs.

Performing operations upon Temperature Table data

Once Row(s) of data have been inserted into the Temperature
Table (see below), the Start and Stop Temp, and the Time
values may be edited by clicking on them — this activates a
data entry box:
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Stagedt & | Start Termp[°C] | Stop Temp.["C] | Time [min.]

1 < 2000 5 2000 1800

~
I
I

The desired values may be entered either directly or by
using the toggle arrows — the arrows change the values
by 1.0 °C or minute on each click. The newly entered
value is confirmed by either clicking Return or selecting
another cell in the table.

The values entered do not need to be whole numbers —
decimal values are also accepted:

Stagett : | Start Temp[°C] | Stop Temp [°C] | Time [min.]

4 1 180.7 1325 169.8

In addition, it is possible to move from one cell to
another in the Temperature Table by using the arrow
keys on the control PC’s keyboard (as happens in
Microsoft Excel®).

Each cell is activated for editing when selected using
the arrow key:
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Stageft : | Start Temp[C] | Stop Temp [°C) Stageft : | Start Temp['C) | Stop Temp['C)
1 200 200 1 20.0 20.0
2 0.0 300 ' 2 an.ao ED-D E|:
3 40.0 40.0 3 40.0 40.0

Stagett : | Start Temp.[°C] | Stop Temp.[*C]

1 200 200
2 a00 an.a0
3 40.0 A0.0 B

Selecting multiple Rows

Multiple rows may be highlighted (ie; selected) one at a
time by holding down the Ctrl key while clicking the
panels to their left, as shown below:

100

Stageft . | Start Temp.['C] | Stop Temp[°C] | Time [min.] *

300 300 )
— 40.0 40.0 180.0
Wt

60.0 E0.0 180.0

Alternatively, a group of rows may be selected at once
by holding down the Shift key while clicking the first and
last row in the group — all rows in between them will

also be selected:
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Stageft . | Start Temp["C] | Stop Temp.[°C] | Time [mirn.] ~

— 400 400
N

60.0 60.0 180.0

[£

Finally, a group of Rows can also be selected by
highlighting one Row and dragging the cursor up or
down along the Rows to be selected.

Inserting, Appending and Deleting Rows

Rows are added to, and deleted from the Temperature Table
by right-clicking on the body of the table, which calls up the
following menu of options:

[rosensitaton &
uU

nserk Fow
Append Row

Insert Mulkiple Rows. .,
Append Mulkiple Rows. ..
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Note: The Delete Row(s) and Select All Rows options are
inactive when the Temperature Table is empty.

Insert Row

Clicking  this  option
inserts a new row in the
Append Row Temperature Table with
default values (200°C for
the Start and Stop RH
Insert Multiple Rows, .. values, Time equal to

Append Mulkiple Rows. ., 180minutes):

Insert Row

Delete Rowis), ..

Select all Fows

Stageft - | Start Temp.[*C] | Stop Temp.[*C) | Time [mit.]
] 1 2000 2000 180.0

The newly inserted row is denoted the selected row by
means of an arrow appearing in its left-most panel:
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— Stageft - |StartTemp.[°E] |St|:||:u Temp.[*C) |Time [mirn.]
) 1 2000 2000 180.0

If the Insert Row option is used subsequently, the new
row will be inserted above the selected row:

Stagef - | Start Temp.["C] | Stop Temp.["C] | Timne [mir.]

4 1 180.7 1325 163.5

Stagett : | Start Temp.[°C] | Stop Temp.[C] | Time (min.)
3 1 180.7 1325 169.8

Insert Row
Append Row

Delete Row(s),.,

Insert Multiple Rows, ..
Append Multiple Rows. ..

Select Al Rows

Stagedt - | Start Temp.[*C] | Stop Temp.[*C] | Time [mir.]
1 200.0 200.0 180.0

2 180.7 1325 169.8
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As shown above, the newly inserted Row appears
with default values, and is now the selected row, as

indicated by the arrow icon .

Append Row
This function adds a new
Insert Row Row with default values
Append Row to the end of the current
list, regardless of which
Delete Row(s)... Row is currently
selected:

Insert Mulkiple Rows., .,
Append Multiple Rows. ..

Select Al Rows

Stagett - | Start Temp.["C) | Stop Temp.["C) | Tirne [rnir. ]
» 1 2000 200.0 180.0

2 180.7 1325 163.8

Stageft |StartTem!°E] |,_ Irsert Fow

b 1 2000 ™ Append Row
2 1807 1

Delete Row(s], ..

Insert Mulkiple Rows., .,
append Mulkiple Rows,

Select All Rows

Stagel - | Start TemI°E] | Stop Temp.["C] | Tirne [rnir. ]

1 200.0 200.0 1580.0
2 1580.7 132.5 163.58
3 200.0 200.0
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As shown above, the newly appended Row appears
with default values, and is now the selected row, as

indicated by the arrow icon L

Delete Row(s)...

Insert Riow
Append Row

Insert Mulkiple Rows. .,
Append Mulkiple Rows., .

Select All Roves

This function will delete
the Row  which is
selected with the arrow

L . .
, or multiple Rows if
they are highlighted (in
blue, as discussed
above).

Deleting a Row selected with the arrow L takes

place as follows:
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Stageft o | Statt Temp.[°C) | Stop Temp.['C] | Time [min.] »
3 400 400 180.0
4 50.0 50.0 180.0
< » ’ ] E0.0 E0.0 180.0
3 0.0 70.0 180.0
7 20.0 20.0 180.0 b
Stage#t : | Start Temp.[YC) | Stop Temp.['C] | Time [min.] -~
3 400 400 180.0
4 50.0 50.0 180.0
» 5 G0.0 E0.0 180.0 —
Insert Row 00 180.0
Append Row ann 1ann ¥

Insert Multiple Rows...
Append Multiple Rows. ..

Select All Rows

Stage#t : | Start Temp.|YC] | Stop Temp.[*C] | Time [min.] ~

3 40.0 40.0 1800

4 50.0 50.0 1800

4 5 70.0 700 1800
E a0.0 a0.0 1800 1
7 90.0 90.0 1800 A/
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Once multiple Rows have been selected the deletion process
may take place as follows:

Insert Row
Append Raw

Insert Mulkiple Rows, ..
Append Multiple Rows...

Select All Rows

Confirmation Required

Stage#t | Start Temp‘. °C] | Stop Temp.[°C] | Tirme [min.]
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Insert Multiple Rows
This function inserts one or more rows containing
default values above the selected row.

The process is as follows:

Stage#t ¢ | Stat Temp.['C] | Stop Temp.['C] | Time [min.] ~
z 300 200 180.0
3 400 400 180.0
4 50.0 50.0 180.0 =
<D £0.0 50.0 1800
B 70.0 70.0 180.0 b

Stage#t & | Start Temp.[” Stop Temp.["C] | Time [min.) ~
2 300 300 180.0
3 400 40.0 180.0
4 500 50.0 180.0 B
3 5 60.0 EO.0 180.0
Insert Row 200 1800 A
Append Row

Delete Raow(s). ..

Insert Muliple

Append Multiple Rows, .,

Select all Rows

7 Insert Multiple Rows

Inzert Mo. of Rows: |3 El:

‘ k. ‘ ‘ Cancel ‘
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The Insert Multiple Rows window appears with a default
value of 1 Row. Up to 50 Rows may be entered into the
data entry box.

Upon entering the desired number of rows (in this case,
3) and clicking OK, the Preheat Method Editor is
returned, with the new Rows inserted above the
selected Row.

Note that the Row which was originally selected (in this
case, the Row with 60°C Temp) remains selected after
the multiple row insertion:

Newly inserted Rows

o

Stagelt o | Start Temp.[C) Sg emp.[*C] | Time [min.] L
200.0

200.0
2000

E0.0 180.0 >

N T80.0 v
Originally selected Row

Append Multiple Rows

This function appends one or more rows containing
default values to the end of the Temperature Table,
regardless of which Row is selected.

The process is as follows:
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Stageft . | Start Temp[*C] | Stop Temp[*C] | Time [min.] ~
' 2> 300 30.0 180.0
3 0.0 0.0 1800
4 a0.0 a0.0 1800
4] E0.0 E0.0 180.0
4
Staget : | Start Temp.[*C) 'Lp Temp.['C) | Time [min.] ~
» 2 ano 0.0 1800
3 400 40.0 1800
4 500 a0.0 1800
5 &0.0 G0.0 1800
Insert Row I
Append Fow -

Delete Row(s),..

Insert Multiple Rows, .,

Append Multiple Rows..,

Select All Rows

" Append Mult, sle Rows

Inzert Mo. of Rows: E| El:

‘ k. ‘ ‘ Cancel ‘

The Append Multiple Rows window appears with a
default value of 1 Row. Up to 50 Rows may be entered
into the data entry box.
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Upon entering the desired number of rows (in this case,
4) and clicking OK, the Preheat Method Editor is
returned, with the new Rows appended to end of the
Temperature Table.

Stageft : | Start Temp[’C] | Stop Temp[*C] | Time [min.] -
] B0.0 &00 180.0

ﬂn 200.0
7 2000 200,00 160.0
8 2000 200.0 180.0
wn 200.0

Appended Rows

The Row which was originally selected (in this case,
Row 2, or Stage#2) remains selected after appending
the multiple Rows:

& | Start Temp.['C] | Stop Temp.["C] | Time [min.] -~
< 4 2 )a300 an.a 180.0
K] 40.0 40.0 180.0
4 50.0 a0.0 180.0
4] E0.0 60.0 180.0
E 200.0 200.0 180.0 s

Select All Rows

This option allows automatically selects all Rows that
are in the Temperature Table, which is useful for
carrying out subsequent operations, such as deletion
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The process is as follows:

Stage#t : | Start Temp.['C) | Stop Temp"C] | Time [min.] *
] BO0.0 B0.0 180.0
B 200.0 2000 180.0
7 200.0 2000 180.0
a 200.0 2000 180.0 —
9 200.0 200.0 180.0 hs
Stagel o | Startt TemWC] | Stop Temp['C] | Time [min.] ~
R FON EO0.0 180.0
Insert Row 00,0 1800
Append Row : :
200.0 180.0
Delete Row(s), .,
200.0 180.0 —
Insert Multiple Rows, .,
200.0 130.0 b

Append Multiple Rows, .,
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Preheater Graph
The Preheater Graph plots temperature vs time, and reflects
the data entered into the Temperature Table:

Freheat Temp [

1 I 1 i 1
360 432 504 576 E48
Time [min.]

Stagett ﬂﬁmp.[‘t] | Stop Temp.('C] | Time (min.)

1 20.0 200 180.0
2 40.0 400 180.0
3 E0.0 E0.0 180.0
k 4 180.0 150.0 180.0

Both the Preheater Graph and Temperature Table also
appear in the Active Method Panel, which displays running
Methods. More information can be found in Section 10.6.
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Creating temperature Steps and Ramps

Using a Preheat Method, the temperature can be made to
change in discreet steps or to ramp gradually from a Start
Temp to a Stop Temp over a specified period of time.

Temperature steps

Temperature steps are created simply by making the
Start and Stop Temps of each Stage equal. The Time
setting of each Stage then defines how long each
temperature step will last:

200

180
_ 180

C
=

Preheat Temp [*

1 1
602 633

Stage® - | Start Temp.[*C] | Stop Temp.["C] | Time [mir. ]
1 200 20.0 E0.0
4 2 B0.0 £0.0 120.0
3 1200 120.0 180.0
4 200.0 200.0 500.0
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Temperature Ramps

Temperature ramps are created by making the Start
and Stop Temp setpoints different from each other:

Stagell | | Samt Temp[T) | Sicp Temp (T1  Fime o |
v me w0 w0

Stageft | Start Temp.["C) | Stop Temp.["C] | Tirmne [mir. ]

4 1 20.0 160.0 60.0

Note: Temperature steps and ramps can be included in the

same Preheat Method by simply editing the Preheat file's
Stages accordingly.
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Method Settings Tab: Gas Flow and Sampling Rates

et :[aﬁ Method 5 ettings

Total Gas Flow

200 [scom] W

Sampling Rates

Sampling Rate: |1 zec. W

Save Data Rate: (1 min. | »

The Method Settings Tab is used to define the Preheat
Method’'s Total Gas Flow and Sampling Rates, which are
defined below.

Total Gas Flow

This box allows the user to specify the preheat flowrate
from a set of gas flows in standard cubic centimetres
per minute (sccm). The default setting for a DVS
Advantage is 200 sccm.
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Clicking on the edit box or the arrow to its right reveals
the list of available flowrates:

4

Total Gas Flow

200 [szom] W

200 [zoem)

150 [gcom]

G i 120 [zzom]
Amping 1400 [zoem)

75 [zoom]

g lin| 20 [zccm]

e 20 [zozm] =

10 [zcom]
Save D{0 [scem) w

Sampling Rates

These drop-down lists allow the user to define the rate
at which data is saved and displayed when running the
Method. Both rates are set to the current General
Preference settings by default (Section 9.2.1.1).
Please also refer to Section 9.3.1.

Sampling Rate: The rate at which mass data is
updated on the software interface.
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The recommended setting is 20
seconds.

Save Data Rate: The rate at which data is saved to a
DVS raw data file on the hard disk.
The recommended setting is 1
minute.

Clicking on the edit boxes or the arrows to their right
reveals the list of available flowrates:

Sampling R ates Sampling Rates

Skmpling Fate: |1 zec. | w Sampling Fate:

Save Data Rate: (1 min. % Save Data Fate: |

1o, A
2 zec,

B zec.

10 zec.

20 zec.

1 mir,

2 mir.
Amin. ¥
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Note: The Sampling and Save Data Rates defined in
File>Preferences will appear in the Sampling Rates drop-
down boxes of the Method Settings tab when the Partial
Pressure Method Editor is first opened.

These settings can then be altered and saved to the new
Method file.

951.2 Edit Method

s ont
This option allows

Preheat Mew Methad, ., the user to edit

Edit Method. .. previously  saved
Preheat Method
! files.

Partial Pressure  #

Clicking the Edit Method option calls up the Select Preheat
Method File window which allows the user to select which
Preheat Method file to edit:

Select Preheat Method File @
Look, in: | 1) method v| 2 T e m-
B lasms_service
:3 preheat test 1.pre

My Recent preheat test 2.pre
Dacuments preheat test 3.pre

preheat test 4.pre

3

|_ preheat test S.pre
Dasktop preheat test &.pre
preheat test 7.pre

. preheat test 3.pre
’j preheat test 9.pre

Ny DS preheat test 10.pre

My Computer
‘% File name: || v | [ Open ]
My Hetwork Files of type: | Preheat Method [* pre) v | [ Cancel ]
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By default, the software will immediately go to the directory
specified in the Preferences option (Section 9.2.1.2) — another
directory may be selected in the window above if desired.

Upon choosing a file, clicking Open will open the Preheat
Method file for editing.

The file may be edited and saved as described above in the
New Method Section.

Note: If a Preheat Method is active (ie; running) as part of a
running Sequence, then it may still be edited. While the
Preheat Method is running, the Method—Preheat—Edit
Method option may be used as described in Section 9.5.1.2
to do this.

The newly edited Method will need to be saved under a new
name — but note that it is not automatically loaded into the
running Sequence. To do this, the running Sequence will
need to be edited to include the new Method as described in
Section 9.6.1.3.

9.5.2 Partial Pressure

Partial Pressure

m Methods may be
Preheat b used to
Mew Method. .. automatically
Edit Method. . control the vapour

partial pressure that
the DVS sample
chamber receives over a defined period of time. This is
achieved by associating multiple time periods (ie: Method
Stages) that have individual vapour partial pressure settings.
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The method stages are run sequentially.

9521 New Method

This option allows
Preheak 3 the user to create
new Method files.

I Edit Method., ..

Clicking Method->Partial Pressure> New Method... calls
up the Partial Pressure Method Editor window:

" Partial Pressure Method Editor,

File Edit Insert
0PV
Method Stages | Method Settings

Partial Pressure %]

Time [min.)

Stageft ;l Stage Type‘ Time [mln]l dm//dt [‘Z/mm.]l SlartZFfF'Ul SIUp‘ZF’HPul Temp.[°C] ‘ Video

The Partial Pressure Method Editor window looks similar to
the Active Method panel on the main DVS Advantage dialog
screen (Section 10.6) — it similarly features a Method Stages
tab and a Method Settings tab:
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At the top of the window are the buttons and menu items
which allow the user to build a new Partial Pressure Method
file. These functions are explained in the sections which
follow:

4& Edit  Insert

Clicking the Save Method

_ button e, or going to File
Default Mew Row Setkings. .. > Save Method saves a
Method to a file after it has
been formulated in the
Exit. .. Partial Pressure Method
Editor.

Method

Insert Isotherm Skeps. ..

Note: The Save Method option only becomes active after a
Method has been created (see sections below).

e bl e

ﬂ Method Stages | Method Settings

[ re——
caunEExEaE
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Once the Save Method function has been activated, a Save
Partial Pressure Method window is opened, requiring the
user to name the new Partial Pressure Method file.

Save Partial Pressure Method @

Save in: | () methad - | €] ¥ M-
Y @sms_service partial pressure kest 15,530
A :? partial pressure tesk 1.5a0
My Recent partial pressure kest 2.5a0
Documents partial pressure kest 3.5a0

partial pressure tesk 4,5a0
partial pressure kesk 5,5a0
partial pressure tesk 6,530
partial pressure kesk 7.5a0
partial pressure kesk .5a0
partial pressure test 9,530
partial pressure kesk 10,580
partial pressure kest 11,530
partial pressure kesk 12,580
partial pressure kesk 13,580
partial pressure kest 14,530

3

L

Desktop

&

My Diocuments

Ler

File: name: || v | [ Save ]

My Metwork, | Save as type: | Partial Pressune Method [* za0) v | [ Cancel ]

The Save Partial Pressure Method File window
automatically navigates to the directory specified in File >
Preferences - Default Directories (Section 9.2.1.2), but a
different location may be specified using the Save in drop-
down menu:
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Save Partial Pressure Method L

Save in:

&

My Recent
Documents

=\

&

My Documents

@

by Computer

=

by Metwork,

1) method

v

> G

% My Recent Documents
Desktop
(5 My Dacuments
d by Computer
e WAI0 [C)
IC3) DWS-Advantage
Y
e WAID (D)
=) MemoryStick [E:]
< DVD-Rw Dirive [F:]
“ Removable Disk [H:]

ég MasterProductionDrawings on ‘SmaukhData’ ||

ig rezearchanddevelopment on 'moisture’ (R:]
ég ComparyD ata on ‘SmaukhData’ [5:)
ég [Pearze on 'Smeuki\Data\Users' [U:]

\3 My Metwork Places

[C5) musictheary.net

|3 Purchase orders

est 15,530

File hame: |

4 |

Save ]

Save as type: | Partial Pregsure Method [*.za0)

w | [ Carcel ]

As the pictures above show, Partial Pressure Method files

are saved with the extension

operation).

.sao (simple automated

Normal Windows functions are available in the Save Partial

Pressure Method File window.

Right-clicking on a pre-

existing file in the window calls up the following menu:

Save Partial Pressure Method

Sav i | [ mathod

(e
Wy Plecent
Desurreis

€]

[

LTS _service

Hy Documerds

M Computns

HyHetk 5§

B e resn
Fi

[7]]

o1 1500

WO W W W W W W W W w
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B Compress and email...
B Compress ko "partial pressure test 2.rar" and email

Send To

Cut
Copy
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Rename

Properties
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Files can be deleted, renamed, etc, before the new Method
file is saved.

Right-clicking in a blank space in the window calls up the
following menu:

View 4

Arrange Icons By #
Refresh

Mew F

Properties

After the new Method file has been named, clicking Save then
saves the new Method and returns to the main DVS
Advantage dialog screen.

9.5.2.3 Default New Row Settings »

This  function  specifies
Save Method default settings for any new

Stage (or ‘Row’) inserted or
appended to a Method.

Default Mew Fow Setkings. ..

Insert Isotherm Steps.., L

Clicking the Default New
Row Settings button @, or
going to File > Default
New Row Settings... opens the following window:

Exit. ..
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T Default New Row Settings

Method Stage Type % Partial Pressure
Step Time [min.] « [150 3: Start % PP 10.0 3:
Step DMDT [Zfmin] O 3: Stop % PP: 100 3:
Temperature [*C) Video
26.0 3: ™ TakeVideo Image
l Save l l Cancel l

The four Stage parameters to be set are explained below:

Method Stage Type

© Default Mew Row Settings
% Partial Pressure
Stan X PP 0o
Stop X PP 0o

Lk b

Shep DMDT [Ehm)

Valen

™ Taka Video Image

o J [ ]

Method Stage Type

Step Time [min.] &« 150 El:
Step OMDT [Zdmin] O El:

The Method Stage Type box allows the user to choose the
Stage end determinant — Time or dm/dt:
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These Stages are time-based ie; the Stage will
run for the specified period of time regardless of
the state of the sample. This means that if the
sample has not yet reached equilibrium at the
end of the allotted Stage time, the instrument
will move to the next Stage regardless.

Clicking the Step Time (min) option will
activate the data entry box as shown below:

Method Stage Type

Step Time [min.] i+ 1150 E

Step DMDT [Zdmin) O El:

This box specifies the duration of each Stage in
the Method in minutes. The figure may be
entered directly, or by using the arrows at the
side of the box. A maximum Stage time of
9999 minutes is allowable.

DMDT is a mode which specifies a rate of
mass change as the criteria for moving on to
the next Stage in a Method - rather than a
Stage running for a specified period of time.

If running a Stage in DMDT mode, the value of

dm/dt required to establish equilibrium for the
Method Stage must be specified.
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Clicking the Step DMDT (%/min) option enables the
data entry box that specifies the required dm/dt (%/min):

Method Stage Type

Step Time [min.] El:
Step DMODT [%/min.) () (0100000 El:

Again, the figure may be entered directly, or by using
the arrows at the side of the box. A maximum dm/dt of
9.99 % per minute (and a minimum of -9.99) are
allowable. Also refer to earlier section in hardware for
recommendations on suitable Step dm/dt values to use.

Temperature (°C) and % Partial Pressure

© Default Mew Row Settings

# Parhial Preszure

Method Stage Type

Shep T o |
Shep DMDT [Xhn )

Start % PP 10.0 :

Stop % PP : El:

T emperahﬁ [*C]

200 Elj

These boxes specify the default Temperatures and Partial
Pressures to be used in new Stages.
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The maximum allowable Temperature is 60°C and the
minimum is 5°C. Partial Pressure may be set from 0% to
100% (although a maximum of around 98% p/p° is actually
attainable).

Time-based Method Stage
If Time is chosen as the Method Stage Type, then initial and
final Partial Pressures may be specified:

" Default New Row Settings rg|
Method Stage Type % Partial Pressure
C step Time [min.) & ’@q Start % PP - 0.0 =
Step DMDT Germn 1o | = Stop % PP: 0.0 =
Temperature [*C] Yideo
25.0 3: ™ TakeVideolmage
[ Save l l Cancel l

If the user wishes to keep the partial pressure in the default
Stage constant, then they can set their Start and Stop values
equal.

If it is desired to ramp the partial pressure, then the Stop
value may be set above or below the Start value, depending
on whether an upward or downward ramp is desired.

For example, the setting shown below would produce a
default Stage that would ramp the partial pressure up from 0%
to 20% across 10 minutes:

Method Stage Type % Partial Pressure

Start % PP : 0.0 3:
Stop % PP 20 3:

Step Time [min.]

129



DVS Advantage Operation Manual

dm/dt-based Method Stage
If the dml/dt criterion is chosen, then only the initial partial
pressure may be set:

" Default New Row Settings g|
Method Stage Type % Partial Pressure
Tzt ! - Start % PP : 0.0 El:
07T (%/min] &  |0.100000 5 Stop % PP El:
Temperature [‘C) Video
25.0 3: ™ Take Video Image
l Save l l Cancel l
Video
" Default New Row Settings 5]

Method Stage Type
Shap Tirm o |
Sbep OMDT [hmn]
Tempeatuse [C1

| Take‘ideo Image

Ticking the Take Video Image box ensures that, by default, a
sample snapshot will be taken at the end of any Stage which
is inserted into the Method.

However, it is important to remember that this setting will only
take effect if the Video preferences are set to follow the
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settings defined in the Method (refer to Section 9.2.1.3 for
more information on setting the Video preferences).

Note: The Video option is not currently available with this
version of the DVS Advantage Control software — this option
being checked or unchecked therefore has no influence on
the operation of the system.

Default New Row Settings flowing through to New
Methods

After all options are specified and the Save button is clicked,
any new Stages inserted into a Method will display the chosen
default settings.

For example, entering the Default New Row Settings shown

below and clicking Save returns the Method Editor
Window.....
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Method

Partial Pressure »

Edit Method. ..

Partial Pressure Method Ec
Edit
Save Method

Inzert

Insert Isotherm Skeps. ..

Exit...

]
oo

Biaged e oe T it e G PTG  TeniD e

Default New Row Settings

Method Stage Type

Temperature [*C)

250

Step Time [min.] o IZD.D 3:

Step DMDT (Z/min) [0 T00000 =

% Partial Pressure

Start % PP : IU-U 33
Stop % PP : FU-U 3:

Yideo

¥ Take “ideo Image
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....then any Row(s) inserted into a new Method will display by
default all of the parameters set in Default New Row
Settings.

Notice in the example below that as the Time Stage Type is
chosen, the dm/dt box is greyed out:
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T Partial Pres

OO

Hethod S1a0e1 | Melbod Setnge

2 o
_ m. C
g8 Fai
S =
i= -1
£ & 20
g £ =18
?: -‘23
0. 5

L] 0 o E 40 =0 L) m
Tove o |

Seagel o | SUoATige  Tisimin]  dwidPhen] S XPFe S XPRe TesolT) | Vides

Partial Pressure Method Editor,

Append Row

Insert Mulkiple Rows, ..
Append Multiple Rows B

oSHEEAZAEE
S LEEEMEREE
(0] St s

4 | Stage Type | Time [min.] ‘ dm/dt [%fmin.]‘ Starl“/eF'/F'U| SlUDZPKPU| Temp.[*C] | Wideo
3 Time 15.0 10,00 10.00 25.00 I
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Default New Row Settings flowing through to Isotherm

Segment Editor

When the Isotherm Segment Editor (@) is first opened the
Method Stage Type, Temperature and Video settings will
contain the default values specified in the Default New Row

Settings:

@

" Default New Row Settings

ethod Stage Type

o

Step Time [min.]

Step DMDT [%/min.

perature [*C]

% Partial Pressure

Start % PP IU-U 33
Stop % PP ISU-U 3:

¥ Take Video Image

” N
| Save ’ Cancel

“ Isotherm Segment Editor.

Method Stage Type

pifiperature [*C)

jmie [rhin. )

Step DMDT [*%/min.]

Half Cycle Definiton
Seg.#t

i*

L ‘ Start % P/Pa | Stop % F‘.JF'0|

200 =
0100000 ==

30.00 3:

W Take Viden Image

1 0.0

Step Size
0.00 0.00 Cycle
& Half Cycle
" Full Cycle
" Multiple Cycle
Cycles : IT 3:
oK } l Cancel l
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Re-starting
If the DVS Advantage Control software is re-started, the
Default New Row Settings are preserved.

9.5.2.4 Insert Isotherm Steps @

This function allows the
quick set-up of an Isotherm
Method — an experiment in
Default Mew Row Settings. .. which  the temperature
remains_constant while the
Insert Isotherm Steps. ., partial pressure is varied.

Save Method

Exit...

Please refer to the
Standard Analysis Suite
Manual for more information on the science of isotherms.

Clicking the Insert Isotherm Steps button @ o going to
File > Insert Isotherm Steps... calls up the Isotherm
Segment Editor:

@ " Isotherm Segment Editor
Method Stage Type Temperature [*C)
Step Time (min.] o |25-D 33 |25-UU 3:
Step DMDT (min) 0100000 =
Video
Half Cycle Definition ™ TakeVideo Image
Seglt .| Stat%P/Po| Stop%P/Po|  Step Size
1 o.o0 o.0o0 0.00 Cycle
@ Half Cycle
 Full Cycle
' Multiple Cycle
Cycles I'I 33
ok ] l Cancel l
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Note: When the Isothem Segment Editor is first opened, the
Method Stage Type, Temperature, and Video sections will
contain the default settings specified in Default New Row
Settings (Section 9.5.2.3).

Using the Isotherm Segment Editor panel, the following
parameters can be specified for the isotherm experiment:

Half Cycle Definition

hathenm Segmant Editor

Muthod Stage Trpe Tompesabars ['T]

SwpTempun] & [0 2 Ea -
e lMDT Fhen) T =

¢ PP SepXPPo St
om [T 0w

Half Cycle Definibon
Segf - | Starti’;F'a’F'u:u| Stnp?éF'.n’F'D| Step Size

1 0.00 0.00 0.0
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Methods may be defined in terms of Half Cycles. In the case
of an Isotherm experiment, a Half Cycle is a series of Stages
of specified RH all run at one temperature.

A Method may be constituted by one Half Cycle, or the Half
Cycle’s mirror image can be appended to its end to make a
Full Cycle. Multiples of a Full Cycle may also be conjoined to
form a Multiple Cycle Method.

These terms are explained further in the Cycle options
outlined later in this Section.

The Half Cycle Definition box specifies the number of
Stages - and their Relative Humidities - to be included in the
Isotherm Half Cycle Method.

Seg.#
——— This denotes the number of the Stage and
“eg# ¢ | cannot be edited - new Stages are added or
1 appended, the numbers will change
automatically.

Start and Stop %P/P,
These values define the Relative Humidities at which the Half
Cycle begins and ends.

Both the Start and Stop %P/P, values may be edited by

clicking on them — this activates a data entry box:

Half Cycle Definbon
Seg® | Stat Z£P/Po| Stop % P/Po Step Size

1 0.0 z 0.00 0.00
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The desired values may be entered either directly or by using
the toggle arrows — the arrows change the values by 1.00
%P/P, on each click.

The values entered do not need to be whole numbers —
decimal values are also accepted:

Half Cycle Definibon

Segf | Stat & P/Po| Stop & PAPo Step Size

& 1 1.23 |1 0.23 E|: 0.00

Step Size

The Step Size determines the size of the partial pressure
steps used to get from the Start %P/P, value to the Stop
%P/P, value.

When the Start and Stop values are the same, then clearly
there is no step required, and so the Step Size can remain at
the default value of zero.

Having the Start and Stop %P/P, values the same will

produce a Half Cycle Method made up of one Stage at a
constant RH, as shown below:
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. Segment Editor

od Stage Type Temperature [°C)

StepTime(mn) & 50 =] E——
Step DMDT (%/min]  (  [1700000 =]

Video

Half Cycle D efinition I~ TakeVideoImage
it % P/Po | Stop % P/ Step Size

.00 2000 . Cycle

= Half Cycle

 Muliple Cycle

Cyeles: |1 3:

| Start % P/Pa| Stop % P/Pa |
20.00 20.00

S
Stage Type | Tmelmn) | de/d[Timn) St TPPFo Sip
=

T 1) 20

w
o
=2

— =2

I @

fas i

o o
= E]
& H
= o
o £
o @
o =
o ]

10

Time [ﬁwm 1
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The blue line on the Method Stages graph shows the constant
Relative Humidity level at 20% P/P,, the red line shows the
Method temperature.

When the Start and Stop values are different, a Step Size
greater than zero must be specified.

If this is not done, then upon clicking OK on the Isotherm
Segment Editor, an error message appears as shown below:

" Isotherm Segmant Editor

Start % P/Po| Stop % P/Po Step Size
0.00 20.00 0.00

>

Suwt TP/Pe) Slap KPP Sl DN
om E1) om

Invalid cell values

Step size value in Segment Mumber 1 may only be set to zero if the Skart and Stop % PiPo
' are the same.

Please change the value before continue.

Clicking OK will then return the Isotherm Segment Editor
screen, with the Method Segment in question highlighted:
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Mthod Stage Typs Tompeesturs ['T]

SwpTmajun) & 50

Sap DADT Whmn) = |

Half Cycle Definibion
| Seg# | Stat%P/Po| Stop%P/Po|  StepSize

1 .00 0.0

In the above example, if a Step Size of 5 were entered, then
the partial pressure would rise from 0% %P/P, to 20% %P/P,
in 5% %P/P, steps as shown below:
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Isotherm Segment

Method Stage Type Temperature [*C)

StepTimefmn) & [50 =] 2600 =
Step DMOT (min] ¢ 1100000 =]

Video

Half Cycle Definition I~ Take Video Image
o - | Gtat%PiPo| Stop% PIPa|  Step Size
000 20,00 IE‘ 2

Cycle

4 Hal Cycte

 Mulipie Cyc®

Cycles 1 3:

| Stat%P/Pa| Stop % P/Pa|  Step Size

0.00 20.00 m

Isotherm Segment Editor

Methad Stage Type

Step Time (min) &+ [150 z T

Step DMDT [/min] |0 100000 =

Video

ctalf Cycle Definition I~ Take Video Image
Segdt . | Stat%P/Po| Stop%P/Po| StepSize

1 000 amw =

Cycle
= Half Cycle

 Ful Cycle

" Muliple Cycle

cpces: || =

Partial Prezzure %]

[7.] 2imeradwa | gdwes

Time [ﬁwm.]
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The Partial Pressure profile above shows %P/P, steps of 5%
from 0% to 20% P/P, (blue line). The red line represents the
experimental temperature.

Note: A ‘ramp’ (ie; a gradual change in %P/P,) may be
created by using a step size of 1%P/P,,.

Step sizes may be entered which do not ‘fit' into the %P/P,
range defined by the Start and Stop RH values. But in this
case the Stop %PI/P, value will be rounded down to the
nearest Step value.

For instance, a step size of 3, with Start %P/P, of zero and

stop %P/P, of 20 will produce a Method whose last stage is at
18%P/P, (ie; the last value below 20 which is divisible by 3):
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Iatherm Segmant Editor
Muthod Stage Trpe Tompesabars ['T]

SwpTeaben) & B0 3] Ba =
e lMDT Fhen) T =

Start % P/Pa | Stop %P/ Step Size

0.00 20.00 3 B

e Start % P/Po | Stop % P/Pa|
1o o0
i | | 3.00 200
o e £.00 £.00
° 2.00 300
1200 12.00
15,00 15.00
1200 12.00
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Inserting

If Insert Isotherm Steps has already been used to insert a
Half Cycle into the Method Editor, returning to Insert
Isotherm Steps and inserting another Half Cycle will not
overwrite the original one — the new Half Cycle method stages
will be inserted at the current row location of the Method
Editor, as shown below:

Initially, a Half Cycle is added to a blank Method Editor
screen:

Mathod Stage Trpe Tompessburs ['C]

E T A T U
e lMDT Fhen) T =

| Stat%P/Po| Stop%P/Pa|  Step Size

0.00 2.00 1.00

_ )Start ZP/MFo | Stop & P/Po |

0.0 0.00
1.00 1.00
2.00 2.00
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Another Half Cycle is then added, at the current row location,
and as the current row is the first row, all the existing rows are

moved down:

@
. S

Mothod Stage Trpe Tompestues ['T]

swoTmeie) & B0 2 Em
SwpDNDT (Sl [ =

Step Size

~~Stat z P/Fo| Stop % P/Fo |
5,00 7.00

1.00

| Stat % P/Po| Stop % P/Po |

i /7 5,00 5,00
: £.00 £.00
7.00 7.00
0.00 0.00
1.00 1.00
200 200
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Performing operations upon Rows

Current Rows

If any part of a segment is clicked (eg; to change a value),
then it becomes the active segment. This is indicated by a
small arrow that appears in the panel on the segment’s left:

Half Cycle Definibon
Segf .+ | StatEP/Po| Stop EP/Po Step Size

0.00 i oo =]

5.00 10.00 1.00
12.00 20.00 2.00

Highlighting Rows
Clicking on the panel to the left of a Segment will highlight all
of its contents:

Half Cycle Definibon
Seqf ¢ | Stat ZP/Pol| Stop E PAPo Step Size
Q.00 200 1.00

1
» — 5.00 10.00 1.00
3

12.00 20.00 2.00
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Inserting, Appending, and Deleting Rows

Right-clicking anywhere in the Half Cycle Definition panel

activates the following options:

Misthod Stage Type Tempeeshurn [T}

=T 4 1|

e Tmefon)
Sup OMDT ffmn)

™ Taka Vides )

Slat5PPe) SwpLFPa  Gwesie
om am m

Cycta
Seat

Insert Mew Row
Append Mew Row
Delete Rowi(s), .,

Insert New Row

This option inserts a row in the Half Cycle Definition
panel with default values (zero for the Start and Stop

RH values, and the Step Size).

The new Row is inserted above the selected Row

(which is indicated with an arrow):
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Half Cycle D efinibon
Segft . | StatZP/Po| Stop % P/Fo Step Size
1 0.00 5.00 1.00

10.00 20.00 2.00

25.00 40.00 5.00

Insert Mew Row
Append Mew Row
Delete Rows), .,

Half Cycle Definibion

Segft . | Stat & P/Po| Stop & P/Po Step Size
1 0.00 5.00 1.00
2 10.00 20,00 2.00

( 0.00 0.00
(F > 4 Paauin) ST

Append New Row

This function adds a new Row to the end of the
current list, regardless of which Row is currently
selected.

In this way, for instance, extra Partial Pressure steps
may be appended to an already-created isotherm.

For example, an isotherm can be quickly constructed
as shown below:
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Half Cycle Definibion
Segf - | Start?éF'.n’F'D| Stcup°/F'a’F'n| Step Size

80.00 10.00

..which would produce the following Partial Pressure
profile in the Method Editor window (when the Full
Cycle option is used — see later in this Section):

Partial Pressure (%]

1 1 | 1 1 L
170 2125 255 2975 340 825
Tirme [main. |

If, however, an extra segment is required which does
not fit into the 10% P/P, steps used in the isotherm

set-up above, the Append Rows function can be
used:
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R *1alf Cycle Definibion
Gt % P/Pa| Stop%P/Pa|  Step SIZEN

Half Cyc.e D efinition
Segft | Start % P.."F'o| Stop % P/Po ‘
1 0.0 80.00

Step Size
10,00

Half Cycle D efiniton

Insert Mew Row

Delete Rowis),

Hanh —ycle Def
Segft | Start % P/Po | Stop % P#/Po | Step Size
0.00 30.00 1000

0.00 0.0

) | Start & F'.."F'n| Stop X% F'f'F'n| Step Size
1 0.0 80.00 10,00

2 BO [ = 0w
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Clicking OK returns the Method Editor window,
which displays the isotherm that includes the extra
Stage required at 93% P/P,, (circled below):

[1.] 2imesadws | gdwes

1 1 1 -
266 304 342

Tirme [min.)

Delete Row(s)...
This function will delete the Row which is selected

with the arrow I:[ or multiple Rows if they are
highlighted. Deleting a Row selected with the arrow

takes place as follows:
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154

eDe
Segft = | StartXF'.-"F‘o| StopXP.-"F'o| Step Size

2 20.00 30.00 200
3 35.00 40.00 1.00
4 45.00 55.00 200
g £0.00 £5.00 1.00
5 70.00 80.00 10.00
)___, 7 25.00 g7.00 1.00
g 90.00 35.00 5.00

eDe
Seg#t ¢ | Stat%P/Pa| Stop%F/Pa|  Step Size
.00 30.00 200

Insert New Row

Append Mev Row 40.00 1.00
55.00 200

3 000 E5.00 1.00

3 7000 80,00 10.00

» 7 8500 87.00 1.00
8 an.00 95.00 500

[=

Half Cycle Definition

Confirmation Required

=]

» I N

g 30.00 95.00 5.00

: | Start % P/Po | Stop % P/Po | Step Size
1 000 0.oa 0.oa
2 20.00 30.00 200
3 35.00 40.00 1.00
4 45.00 55.00 200
5 £0.00 £5.00 1.00
g 70.00 80.00 10.00
7 90.00 95.00 5.00
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Multiple rows may be highlighted one at a time by
holding down the Ctrl key while clicking the panels to
their left, as shown below:

Half Cycle D efinibon
: | Start % P/Po| Stop % P/Po Step Size

Alternatively, a group of rows may be selected at
once by holding down the Shift key while clicking the
first and last row in the group — all rows in between
them will also be selected:

Half Cycle D efinibon
SegH .| Start X P/Pol| Stop X PAPo Step Size

2 [ ww | aw ]

1.00

Finally, a group of Rows can also be selected by
highlighting one Row and dragging the cursor up or
down along the Rows to be selected.

Once the multiple Rows have been selected the
deletion process may take place as follows:
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Half Cycle Definibon

Seg#t o | Stat%P/Po| Stop % P/Po|  StepSize

1 C 10.00 5.0

Half Cycle Definition
Seg#t ¢ | Stat%P/Pa| Stop % P/Po|  Step Size

h.00

Insert Mew Row
Append Mew Fow

Half Cycle D efinition
L | Start % P.-"F'Dl Stop & F'.-’F'0| Step Size

[ Confirmation Required

:| Stat%P/Po| Stop%P/Pa|  Step Size
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Other Operations

It is possible to move from one cell to another in the Half
Cycle Definition panel by using the arrow keys on the control
PC's keyboard (as happens in Microsoft Excel®).

Each cell is activated for editing when highlighted using the
arrow key:

Half Cycle D efinibon Half Cycle D efinibon
Seg#t & | Stat%P/Po| Stop X P/Po|  Step Size Seg#t ¢ | Stat%P/Po| Stop % P/Po|  Step Size
1 10,00 20,00 1.00 1 10.00 20,00 1.00
’ 2 Filli =] m 100 ’ 2 no Al =] 1w
3 50.00 E0.00 1.00 3 50.00 E0.00 1.00

Half Cycle D efinibon
Segf .| Stat%P/Po| Stop % P/Fo Step Size
1 10.00 20.00 1.00

2 30.00 40.00 1.00

» 2 5000 [HE =] 100

Other Errors

When a Half Cycle Definition contains multiple Rows, the Stop
%P/P, of a Row cannot be the same as the Start %P/P, of the
Row that immediately follows it.

For example, if two Rows were constructed as shown below:

Half Cycle Definibon

Step Size
1.00
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Clicking OK on the Isotherm Segment Editor window will call
up the following error message:

Invalid Segment Values fgl

'T Invalid segment values have been detected,
L3

The Start: % P/Po value in Segment Mo : 2 cannot hawve the same value as the Stop % PJPo
value in Seament Mo 1,

Please change either of these values before attempting to continue,

Clicking OK returns the Isotherm Segment Editor so that the
Rows may be edited accordingly.

Closing the Isotherm Segment Editor
If data is entered in the Half Cycle Definition panel, and then
the Isotherm Segment Editor is closed by clicking Cancel or

the close window button (@), the data will be lost.

The next time the Insert Isotherm Steps button (@) is
clicked, it will open the Isotherm Segment Editor with a
‘blank’ Half Cycle Definition:

Half Cycle Definbon
Seg# . | StartEP/Pol| Stop & PAPo Step Size
] 1 0.on Q.00 0.00
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Cycle
This selection area determines whether the Isotherm Method
is run in Half, Full, or Multiple Cycle mode:

" Isotherm Segmant Editor

Mathod Stage Trpe Tompessburs ['C]

SwpTwatn] & [E0 o Ew
SwpDMDT (SAmn) = [: CIE

* Half Cycle

Segl SunXP/Ps| Siep kPP Sl
om o0 om

" Full Cycle

" Multiple Cycle

Cycles : 3:

Half Cycle
The Half Cycle Definition Panel creates, as the name
suggests, a Half Cycle.

This means that whatever stages are specified in the panel,
they constitute a Half Cycle experiment:

For example, if the following stages are created:

Half Cycle Definibon
Segd | Start ZP/Po| Stop % P/Fo Step Size
[ ] 1 0.00 30,00 10.00

....then clicking OK on the Isotherm Segment Editor with the
Half Cycle option selected will produce a Relative Humidity
profile on the Method Editor window based on the Stages
shown above with no additions or changes (ie; increasing
Relative Humidity steps of 10% from 0% to 90%):
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Partial Pressure [%)

|
128
Time [min.]

Full Cycle

This option simply appends a mirror image of the original Half
Cycle experiment to the Relative Humidity profile.

With the Full Cycle option selected on the Isotherm
Segment Editor, the experiment shown above would appear
on the Method Editor window as follows:

Partial Pressure [7]

1 I I [ | I o
1425 190 2375 285 3325 380 4275
Time [min.]

Multiple Cycles

This option creates several Full Cycles in sequence. The
number of desired Full Cycles is specified in the data entry

box that is activated when the Multiple Cycle option is
selected:

= Multiple Cycle
Cycles I1 3:
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The number of cycles can be entered directly or by using the
arrows on the side of the edit box. The maximum number of
cycles that may be programmed is 10. As an example,
selecting ‘3’ cycles as shown above for the current Half Cycle
would produce the following Relative Humidity profile on the
Method Editor window:

hiotherm Segmant Editor &3

Half Cycle Definiton
- Seg# ¢ | Stat%P/Po| Stop%F/Fo|  Step Siee

3 1 0.00 30.00 10.00

Mathod Stage Trpe Tompessburs ['C]

SwpTeaben) & B0 3]
e lMDT Fhen) T =

St XPPe| SeoXPiPo|  SeeeSim
om 2000 1200

/’ % Multiple Cycle

Cycles: |3 =

[ T T, T L ]
] om m

Partial Pressure (%]
|
w
=1
1

| I . . ‘ . .
1375 278 4125 550 E87.5 825 962.5 1100
Time [min.]

| i
12375 1375
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Closing the Isotherm Segment Editor

The next time the Insert Isotherm Steps button (@) is
clicked, it will open the Isotherm Segment Editor with the
default Cycle setting of Half Cycle:

" “atherm Segmant Editor

nthod Stage Type Tompessburs ['C]

ﬁ SwpTempn] & B0 3 = |

e DMDT [Amn) =

Cycle

f* Half Cycle
" Full Cycle

" Multiple Cycle

Cycles : El:

Method Stage Type
This box sets the stage end determinant to either Time or
dm/dt (refer Sections 6.2.2 and 9.5.2.3 for an explanation of

these parameters):
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" Ilsotherm Segment Editer

B inge Troe

swTmein) & B0 o
r ﬁ

AP GepTRPe|  Sientes
om om

Method Stage Type

Ctep Time [min.] v |25.0 3:
Ctep DMODT [Edmin) El:

Clicking the Step Time (min) option will activate the data
entry box as shown below:

Method Stage Type

Step Time [min.]

Step DMOT [Efmin) 3:

This box specifies the duration of each Stage in the Method in
minutes. The figure may be entered directly, or by using the
arrows at the side of the box. A maximum Stage time of 9999
minutes is allowable.

Clicking the Step dml/dt (%/min) option enables the data
entry box that specifies the required dm/dt (%/min):
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Method Stage Type

Step Time [min.] .

Step DMDT [Zdmin \J*

0.100000 El:

Again, the figure may be entered directly, or by using the
arrows at the side of the box. A maximum DMDT of 9.99 %
per minute (and a minimum of -9.99) is allowable. Also refer
to earlier section in hardware for recommendations on
suitable Step dm/dt values to use.

Once the desired Method Stage Type has been selected in
the Isotherm Segment Editor, clickihng OK returns the
Method Editor window. The Method Stages tab displays the
chosen Method Stage Type (the Method Stages Type which
has not been chosen is greyed out):
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' Method Stage Type

Viden Step Time (min.) 250 z

St PPa) SopkPiPe) S Sae Lt Step DMDT [%/min)  (+  |0.100000 -

080 000 10,00

Partial Pressure Method Editor.
File  Edit

Method Stages | Method 5 sttings |

Insert

Fartial Pressure [%)

i i | | i i | i o
B4 1368 2052 2736 3420 4104 4788 h472 E156 E240

Time [rnit.]
Stage#t » | Stage Type | Timin.] | dm./dt [°/=a"min.]| Stalt%F‘x’F‘o| StopZF'.-’P0| Temp.[*C) | Yidea
3 dm/dt 0100000 n.oo
2 dm/dt 0100000 10.00
3 drn/dt 0.100000 20.00
4 dm/dt [1.100000 30.00
5 dm/dt [1.100000 40.00
5 dm/dt 0100000 50.00
7 dm/dt 0100000 £0.00
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Closing the Isotherm Segment Editor

Every time the Insert Isotherm Steps button @ s clicked,
the Isotherm Segment Editor window is opened featuring
the Method Stage Type defined in the Default New Row
Settings (Section 9.5.2.3).

No matter what Method Stage Type had last been set in the
Isotherm Segment Editor, the Default New Row Settings
will appear whenever the Segment Editor is next opened.

Temperature(°C)

This selection area sets the constant isotherm temperature.
The desired setting may be entered directly or by using the
arrows to the right of the data entry box.

" otherm Seg Etor ——3p Temperature [*C)
Swp LMDl Samn) | = 25':":' :

et SunXP/Ps| Siep kPP Sl
om o0 om

=)

The maximum allowable Temperature is 60°C and the
minimum is 5°C.

Once the Temperature is set and OK is clicked, the setting

appears numerically in the Method Editor's table, and
graphically as a red line in its Relative Humidity profile:
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Isatherm Segman

Muthod Slage Type

wwrenny = 5 ' /'Temperatum (*C)

SepLMOT (Wmn) s

Partial Pressure Method Editor,
Fille Edit Insert

[E00 =]

Method Stages | Method Settings

Time [min.)
77—\
Stageft « | Stage Type ‘ Time [mir.] | dm//dt [‘Z/mm.]l Start % P/Po | Stop % P/Po I Temp.[°C| Video )
» Time 5.0 000 0.00 2500 [
] =z Time 250 10.00 10.00 2500 r
- Time 250 2000 2000 2500 r =
] Time %0 3000 3000 500 r
| s Time: 50 4000 4000 25,00 r
| = Time 50 5000 50.00 25,00 r
| - Time 50 60.00 g0.00 2500 - 2
A 4
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Closing the Isotherm Segment Editor

Every time the Insert Isotherm Steps button @ is clicked,
the Isotherm Segment Editor window is opened featuring
the Temperature defined in the Default New Row Settings
(Section 9.5.2.3).

No matter what Temperature had last been set in the
Isotherm Segment Editor, the Default New Row Settings
will appear whenever the Segment Editor is next opened.

Video

Ticking this box ensures that a snapshot of the sample is
taken at the end of each Stage of the Method (provided the
Video preferences have been set to follow the Method
settings — Section 9.2.1.3).

" Isotherm Segment {dissr

Method $1age Trpe Tompmioters ] Yideo

[v Take Video Image

SepTemien) & [0 3] Fa 3
uuuuuuuu mawny [ 3
Ly
Segh . S %P SpiP b
c

If the Take Video Image option has been ticked, clicking OK
will return the Method Editor table; the Video box at the end
of each Stage will be ticked:
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SwpTmglsn] & 150 El

=

S PP Simp PP Swplae
[T} 00 0o

Partial Pressure Method Editor,
File Edit Insert

Yideo

- S / W Take Wideo Image

Methad Stages | Method Settings |

Partial Pressure [%]

Tirne [mmir.)

wes

[2.] ameiadua ] 3

)

Stage#t ¢ | Stage Type | Time(min) | dmtdt (%/min]| Start % P/Po| Stop %P/Po|  Temp D) Widen A
» Time 150 0.00 0.00 2500 Icd
H Time 150 _ 10.00 10.00 2500 Icd
s Time 150 _ 2000 2000 25.00 Icd
o Time 15.0 3000 30.00 25,00 Ird
] Time 150 _ 40,00 40.00 2500 Icd
6 Time: 150 _ 50.00 50.00 2500 v

7 Time 150 _ 60.00 £0.00 2500 Icd <

NV

In the Method Editor window, the Video boxes may be edited
further if desired (ie; un-ticked, re-ticked).
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Closing the Isotherm Segment Editor

Every time the Insert Isotherm Steps button @ is clicked,
the Isotherm Segment Editor window is opened featuring
the Video setting defined in the Default New Row Settings
(Section 9.5.2.3).

No matter what Video setting had last been specified in the
Isotherm Segment Editor, the Default New Row Settings
will appear whenever the Segment Editor is next opened.

Returning to the Method Editor main screen

After specifying all desired parameters in the Isotherm
Segment Editor, clicking OK will return the Partial Pressure
Method Editor main screen, with the newly created Method
installed — see the example outlined in Figure 9.6 below:

Clicking the Insert Isotherm Steps button @ or going to File
- Insert Isotherm Steps... calls up the Isotherm Segment
Editor:
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" Isotherm Segment Editor

Method Stage Type Temperature [*C]
Step Time [min.) @ |50.0 5 I25.DD 3:
Step DMOT (%/min) |0 700000 =
Yideo
Half Cycle Definibon [ Take Video Image
Segf | StartXP.-"F'o| Stop%F'.-"F'o| Step Size
1 0.0 30.00 10.00 Cycle
" Half Cycle
& Full Cycle
" Multiple Cycle

Cycles : I1 3:

X

l 0K ] [ Cancel

l

Figure 9.6: After the Isotherm Segment Editor is completed

as shown above and OK is clicked....
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]

% Partial Pressure Method Editor
File Edit Insert

Method Stages | Method Settings |

Partial Pressure [%)

I | I
4z 456 E84

Tirme [min.]

Staget ¢ | Stage Type | Time (min) | dm/dt(%/min)| Start%P/Po| Stop %P/Po| TempT] | Video

» Time E0.0 0.oa 0.00 2500 -
| 2 Time E0.0 10.00 10.00 2500 I
] 3 Time E0.0 2000 20.00 2500 -
] 4 Time E0.0 30.00 30.00 25.00 I
I 5 Time E0.0 40.00 40.00 2500 -
| B Time E0.0 50.00 50.00 2500 I
] 7 Time E0.0 60.00 60.00 2500 I

Figure 9.7:....the Partial Pressure Method Editor main
screen is returned, displaying the details of the newly created
Method

Note: If a Method was already contained in the Method
Editor, then any new Method stages created using the
Isotherm Segment Editor will be inserted into the Method
originally displayed.

Changes flowing through from Default New Row Settings
When the Isotherm Segment Editor is first opened, the
Method Stage Type and Temperature sections will contain
the default values specified in the Default New Row Settings
(see Section 9.5.2.3 above).
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9.5.2.5 Method Stages Tab

The Method Stages tab displays the relative
humidity/temperature profile of the Method, and also an
editable table of the parameters of each Stage of the Method.

Method Stages | Method Settings

Partial Pressure [%]
l
w
=
1

S|

1 | 1 1 [
570 684 N2 1026 1140

Tirne: [min.)
Stage# o | Stage Type ‘ Time [min.] | dmy/dt [Z/min, ]| Start 7 F‘KPnl Stop % P.-’Pn‘ Temp.['C) | Videa
4 Time g0.0 0.00 0.00 25.00 I
| 2 Time e0.0 10,00 10.00 25.00 -
| 3 Time e0.0 20,00 20,00 26.00 -
] 4 Time e0.0 30,00 30.00 26.00 -
] g Time: e0.0 40.00 40.00 26.00 I
| 6 Time 60.0 50.00 50.00 25.00 I
| 7 Time B0.0 B0.00 60.00 25.00 I

Methods may also be created and edited on the Method

Stages Tab without using the Insert Isotherm Steps button “
(Section 9.5.2.4 above) — however the Insert Isotherm Steps
function provides a very fast way of establishing the broad
features of a Method file. Alternatively, settings specified in
the Isotherm Segment Editor may be altered in this table.

The partial pressure table includes a column for Stage #,
which is not editable. The Stage Type column allows the
user to select the stage-end determinant (Time or dm/dt).
This is followed by editable Time (min) and dm/dt (%/min)
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columns (explained in the previous section). Start and Stop
%PIP, ,and Temp (°C) columns are also featured (again,
explained in the previous section).

Creating ‘ramps’

Any Row values may be altered by simply clicking on them,
as described in Section 9.5.2.4.

A ramp may be created by simply making the Start %P/P,
different from the Stop %P/P, in a Stage.

For example, if a Method is initially set up as shown:

Partial Pressuie [%]

100

150

Tirne [min.]

175

Stage#t © | Stage Type | Time (min) | dm/dt(%/min)| Start % P/Po| Stop%P/Po| Templ'C) | Video

3 Time 250
50

0o
10.00

0.00
10.00

2600
25.00

240
280
260
260
250

20,00
30.00
40.00
60.00
E0.00

20,00
30.00
40.00
50.00
E0.00

25.00
25.00
2600
2600
25.00

aaaaapr

» Time
2 Time

174

g0.0
E0.0

agelt : | Stage Type | Time [min.] | dm./dt [°/=.-"min.]| StartXF'.-"F'ol StopXP.-’F'o|

Temp.[*C] | Wideo
0.0 000 25.00 I
10.00 10.00 25.00 r
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Then changing the Stop %P/P, in the first stage from 0%P/P,
to 10% P/P, will create a ‘ramp’ from 0% to 10% P/P,. The
software automatically steps the ramp in increments of 1%
P/P,:

an ]
10
0+ I |.
0 25 50

" Partial Pre: sure Method Editor,
File Edit Inserf

0odo

Method Stages ivethod Seltings |

Partial Pressure (%]

Stage#t ¢ | Stage Type | Time (min) | dmdt(%/min)| Start % P/Po| Stop%P/Pal Temp(C] | Video
13 1 Time 250 0.00 m 25.00 ~
2 1000 2500 I
] 20,00 25.00 r =
] 4 Time 30.00 30,00 25.00 I
] El Time 40.00 40.00 25.00 I
] [ Time 250 50.00 50.00 25.00 I
I 7 Time 250 B0.00 E0.00 2500 I =

N

Stage# zl Stage Typal Time [min]l drn/dt [Zf’min]l E\mmpzpmnl Temp.['C) | Yideo |

’ 1 Time 250 - oo I <] 250 r
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Stage End Determinant
The stage end determinant may be changed between time
and dm/dt by using the drop-down menu:

" Partial Pres
Fie E3 Jmert

[ Methad Stages | peshod Semngs

Pasial Popssusn %]

Video

As mentioned above, the Video check box may be ticked or
un-ticked in each row, or Stage, depending upon whether the
user wishes for a sample snapshot to be taken at the end of
each stage.

Wideo
v

coHEESZIEE
LGN EWAREE

“ 5w
Tiea [ ]

o] StegeType | Timeimn) | dmid [%imin] Stat XPPo| Skop X PPo.
Tie 150 nm [T
Tive 158 1w nm

200 am

000 T

4000 0

Time 150
Tiom 150
Tire: 150
Time 140
Tia 150

w000 o
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Performing Operations upon Rows:
Right-clicking the Stages table calls up the following shortcut
menu:

nserkt Row
Append Fow

Delete Row(s), ..

Insert Mulkiple Rows. .,
Append Mulkiple Rows. ..

Select All Rows

Copy Row(s)

Paste Rowis)

Paste Rowis) Reverse

Paste Append Rowis)

Paste Append Row(s) Reverse

Note: The functions listed above can also be found in the
Edit and Insert drop-down menus on the Partial Pressure
Method Editor window:

7" Partial Pressure Method Editor
File Edit A=11
@ Select all Rows | Insert Row
Copy Rowis) @ ﬁ Append Row
“pqe  Paste Row(s) I
Paste Row(s) Reverse

Paste Append Rowis)
Paste Append Rowis) Reverse 100

" Partial Pressure Method Editor

Insert

bathod © nsert Mulkiple Rows, .,
Append Mulkiple Rows

Deleke Rowis), .. 177

(S0
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Insert Row, Append Row, Delete Row(s)
These items are explained in Section 9.5.2.4.

Note: Rows are inserted or appended with the values
specified in the Default New Row Settings (Section 9.5.2.3).

Insert Multiple Rows & Append Multiple Rows

These options call up a window asking the user to specify
how many Rows are to be inserted or appended. The same
panel appears for the Append Multiple Rows option:

7 Insert Multiple Rows

Inzert Mo, of Bows: n 3:

‘ k. | ‘ Cancel |

The number of rows to be inserted or appended may be
entered directly into the data entry box, or by using the arrows
to the right of the box. A maximum of 50 rows may be
specified.

The new Rows are inserted or appended after clicking OK.

Select All Rows
Selects all rows in the table:
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T

Copy Row(s)
This option copies the current or selected Row(s).

Paste Row(s)
This option pastes the copied Row(s) above the current Row.

The currently active or selected Row(s) will be those initially
copied unless new Row(s) are selected before pasting.

Paste Row(s) Reverse
If multiple rows have been copied, then this function pastes
them in their reverse order (bottom to top).

For example, if the following rows are copied (going from 0%
to 20% P/P, top to bottom):

Staget : | Stage Twpe | Time [min.] | dm/dt [%/min]
I

Tirne
Time 250 0.100000
Time 250 0.100000
Time 250 0.100000
Time 250 0.100000

\JmmbIII

...then Paste Row(s) Reverse will place the copied Rows
above the current row (in this case Row #1) in reverse order:
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Paste Append Row(s) Reverse

VN
Stage#t : | Stage Type | Time[min] | dm/dt [%/min.) b \
2 Time 250 0.100000 10.00
3 Time 250 0100000 0.00
4 Time 250 0100000 i
5 Time 250 0.100000 10.00
B Timne 250 0.100000 20.00
7 Time 250 0100000 20.00

Stop % P/FPo

10.00
10,00
10.00
10.00
20.00
30.00

Temp.["C] Video ~

25.00
2500
26.00
25.00
25.00
26.00

000 and

This performs the same action as Paste Row(s) Reverse —
only the copied rows are pasted to the bottom of the table.

9.5.2.6 Method Settings tab

This window, shown below, sets the experimental conditions

of the Method:

Method Stages | Method Seftings

ethod Stages | Method Settings

Update Sample Weight Option

v Update Sample Weight at completion of first method stage

DMDT Settings

DD T “Window (min. 5 33
Mimimum DMOT Stability Duration (min.): 10 3:
bawimurn OMDT Stage Time [mir]: 360 -

180

Total Gas Flow

200 [scom) w0

Sampling Rates

Sampling Rate: |1 zec. &

Save DataRate: 1min.
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Sampling R ates

/ Sampling Rate: |1 sec.

Save Data Rate: |1 min.

These drop-down lists allow the user to define the rate
at which data is saved and displayed when running the
Method. Both rates are set to the current General
Preference settings by default (Section 9.2.1.1).
Please also refer to Section 9.3.1.

Sampling Rate:

Save Data Rate:

The rate at which mass data is
updated on the software interface.
The recommended setting is 20
seconds.

The rate at which data is saved to a
DVS raw data file on the hard disk.
The recommended setting is 1
minute. More frequent data logging
gives rise to larger file sizes.

Clicking on the edit boxes or the arrows to their right
reveals the list of available flowrates:
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Sampling Rates

Sampling A ate:

Save Data Rate: |

Sampling Rate

Sampligd Rate: |1 zec.  w

Save Data Rate: |1 min.  »

2zeC. A
A zec,

10 zec.

20 zec.

1 rmin,

2 rmin.

B min.

18 min. %

Note: The Sampling and Save Data Rates defined in
File=>Preferences will appear in the Sampling Rates drop-
down boxes of the Method Settings tab when the Partial
Pressure Method Editor is first opened.

These settings can then be altered and saved to the new
Method file.

182




DVS Advantage Operation Manual

Total GasFlow

Total Gas Flow

/V

200 [zzom] (W

150 [secrn)
1200 [scem)
ng Rate| [zccm)
78 [azcm)

. B0 [zzom)

ampling Bf 20 [zcom) £
10 [zzom)
ave Data |0 [sccm] i

This determines the flow rate while the Method is running.
Values are chosen using the drop-down menu as shown
above, and will initially be set to the default value of 200sccm.

Note: The Flow Rate may also be set on the Instrument Data
panel (Section 10.4), but that setting is independent of
flowrates set for Method files.

It is important to make sure that the Flow Rate required for the
Method is set correctly in the Method Settings tab, as the
Instrument Data tab setting will have no bearing on the
Method setting.

If the Method Settings tab is not used to alter the Method's
Flow Rate, then the default value of 200sccm will be used
automatically when the Method is run.

For most experiments, 200sccm will be appropriate.
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Update Sample Weight Option
On the Control software’s Mass Graph tab (Section 10.3) is
displayed a sample weight:

seneeanTE
i Mass (mg)  |123.1234
m/m(0) % 1231.234
dm/dt (Z/min) |0.000000
Ctr.Wt. (mg) | 0.0000

e — mass{0) (mg) [10.0000

When the Update Sample Weight Option in the Method
Settings tab is checked, the mass(0) (mg) value is set to the
last mass value recorded at the end of the Method'’s first
stage.

This option is checked by default - if the option is un-checked,
then the mass(0) (mg) value will remain at the value to which
it was last set.

Update 5ample Weight Option

[v¥ Update Sample Weight at completion of first method stage
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dm/dt Settings

DMDT Settings

DMDT “window [min.); & EI:

Minimum DMOT Stability Duration [min. ) 10 3:

M aximum DMOT Stage Time [min.); 380 <

This area specifies the dm/dt settings if dm/dt has been
chosen as the stage end determinant — the actual dm/dt value
required to define sample ‘stability’ is set either in the Partial
Pressure Method Editor window, or in Insert Isotherm
Steps. Refer also Sections 9.5.2.1 and 9.5.2.3.

dm/dt Window (min)
This defines the time window (minutes) across which the
sample’s dm/dt is calculated.

The DVS Intrinsic software samples mass data every second
(regardless of the Save Data Rate). This means that a dm/dt
Window of 5 minutes would lead to the dm/dt value being
calculated across 300 mass data points (5x60sec).
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The dm/dt value is re-calculated every second (as each new
mass point is sampled). If a dm/dt Window of 2min were
used, then the dm/dt value would be re-calculated every
second across a mass data range of 120 points.

The recommended value is 5 minutes, which is set as default,
but a minimum of 1minute and maximum of 10 minutes may
also be set.

Min dm/dt Stability Duration

This sets the minimum time for which the sample’s mass
change must satisfy the dm/dt requirement set in the Method
Editor. Once the sample has satisfied the dm/dt requirement
for this minimum period, the experiment moves on to the next
Stage.

The recommended value is 10 minutes, which is set as
default. The possible values range from 10 to 2000 minutes.

Max dm/dt Stage Time

This defines the maximum time that the instrument will run
any Stage before moving automatically to the next stage,
irrespective of whether the dm/dt criterion has been met.

The recommended default is 360 minutes. The permissible
values range from 10 minutes to 2000 minutes.

9.5.2.7 Close Method Editor U

Save Method

Default Mew Row Settings. ..

Insert Isokherm Steps. ..
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Clicking the Close Method Editor button will call up the
following window:

Close Confirmation X

9 fouare about to lose all changes you made ta this method,
\.‘(/

Are wou sure you wank bo conkinue?

Yes ] [ Mo

Clicking Yes will exit the Method Editor and lose all changes
made.

Clicking No will restore the Method Editor screen, allowing the
Method to be saved if desired.

9.5.2.8 Edit Method

Method
Preheak r |

Partial Pressure Mew Methaod, .,

Edit Method. ..

This option allows the user to edit previously saved Partial
Pressure Method files.
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Clicking the Method—Partial Pressrue—Edit Method option
calls up the Select Partial Pressure Method File window
which allows the user to select which Partial Pressure Method
file to edit:

Select Partial Pressure Method File @@
Laak in: | (23 methad R ¢ N il =l
By |2 sms_service partial pressure test 15,5a0
:3 partial pressure kest 1.5a0

My Recent partial pressure test 2,580
Dacuments partial pressure kest 3.5a0

partial pressure kest 4,5a0
partial pressure test 5.5a0
partial pressure kest 6,5ao0

Desktop
partial pressure kest 7.5a0
. partial pressure test §.5a0
//' partial pressure kest 9,5a0

partial pressure kest 10,5a0
partial pressure kest 11.5a0
partial pressure kest 12,5a0

__‘j‘g partial pressure kest 13,520
- partial pressure test 14.5a0

My Documents

My Computer
‘;'] File name: | v
2
by Hetwark Files of type: Partial Pressure Method [*.2a0] »

By default, the software will immediately go to the directory
specified in the Preferences option (Section 9.2.1.2) — another
directory may be selected in the window above if desired.

Upon choosing a file, clicking Open will open the Partial
Pressure Method file for editing.

The file may be edited and saved as described above in the
New Method Section.

Note: If a Partial Pressure Method is active (ie; running) as
part of a running Sequence, then it may still be edited. While
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the Preheat Method is running, the Method—Preheat—Edit
Method option may be used as described in Section 9.5.1.2
to do this.

The newly edited Method will need to be saved under a new
name — but note that it is not automatically loaded into the
running Sequence. To do this, the running Sequence will
need to be edited to include the new Method as described in
Section 9.6.1.3.

, 5 |

Mew Sequence. ..

Load Sequence. ..
Edit Sequence. ..
Clear Sequence. ..

A DVS Sequence is a series of up to ten DVS Methods
(Preheat, Partial Pressure or DCC — refer Section 9.5) that
are run consecutively.

The Sequence menu allows the user to create a new
Sequence, load an existing Sequence, edit an existing
Sequence or to clear a previously loaded Sequence.

Note: A Sequence must first be loaded before the Edit
Sequence and Clear Sequence menu options can become
active.
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Also, the entire Sequence menu is disabled while data is
being saved. The data saving must be stopped in order to
access the menu.

Note: The Sequence menu may also be called up by going to
the Sequence panel and right-clicking anywhere on the tab
(see Section 10.5.1).

9.6.1.1 New Sequence

N JUENCE This option allows the user to

Load Sequence... create a new Sequence.

Edit Sequence...

Clicking the New Sequence option
Clear Sequence...

calls up the following Sequence
Editor window:

Sequence Editor El
0w

Salvent Method File(s}:

LE o A I S ST

e

SRS S

Contiol Mode

SolventA: [Openloop v | SolventB:|Openlocp  +|

The Sequence Editor allows the user to load the Methods that
are to be run and also configure which solvent is to be used
for each particular Method.

190




DVS Advantage Operation Manual

The settings displayed in the Sequence Editor are the same
as those displayed in the Sequence Panel (Section 10.5) - the
only difference being that the settings in the Sequence Editor
may be changed.

Control Mode
Seguence tanse [])

Qv

Lubeent Maituce Fibefak

Control Mode /

SolventA: | Oper Loop v SolventB: | Oper Loop v

These drop-down boxes allow the user to set the Control
Mode to be used for Solvents A and B. Both solvents are set
to the current General Preference settings by default (Section
9.2.1.1). Please refer to Section 9.3.4 for more detailed
information on Control Modes.
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Method File(s)

e

PR RV A

Method File[s):

bbbl el )

This area allows the user to select the Method files which will
constitute the Sequence — a maximum of ten Method files
may be used. The selected Method files can be either Pre-
heat Methods (.pre), Partial Pressure Methods (.sao) or the
special sensor cleaning method “Clean.dcc”.

The list of Methods must be filled from the top down.
To insert a Method into the new Sequence, the Load Method

button | at the end of the highest empty box must be clicked
— this will call up the Select DVS Method File window:
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Select DVS Method File

Loak in: | I method v | D F B -
Y @sms_service partial pressure test 14,530
uﬁ Clean.dcc partial pressure test 15,530
My Recert partial pressure best 1,5a0 partial pressure kest 16.5a0
Documerts partial pressure test 2,5a0 preheat test 1.pre
= partial pressure kest 3.5a0 preheat test 2.pre
|_ partial pressure test 4,5a0 preheat test 3.pre
Deskiop partial pressure kest 5,5a0 preheat test 4.pre
partial pressure test 6.5a0 preheat test S.pre
. partial pressure test 7.5a0 preheat test 6.pre
.’_/' partial pressure test §.5a0 preheat test 7.pre
My Dacuments partial pressure kest 9,5a0 preheat test §.pre
partial pressure test 10,5a0 preheat test 9.pre
partial pressure best 11,5a0 preheat test 10.pre
L;}E partial pressure kest 12.5a0
. partial pressure test 13,5a0
My Computer
‘:} File name: | v | [ Open ]
My Netwede | Files of type: [DVS Method Files(" sa0:" pre;”. doc) v| [ _cancd |

The Select DVS Method file window will automatically
navigate to the default Method Files directory specified in
Preferences (Section 9.2.1). From there, a different directory
may be chosen if desired.

Upon selecting a Method file and clicking Open, the
Sequence Editor window is returned featuring the Method File
loaded (along with its directory location) at the top of the list
(only one Method file may be selected at a time):
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C:ADWS -Advantage methodhpartial prezzure test 1.za0

Note: After a Method file has been loaded, the Load Method

button =/ remains active in case a different Method file needs
to be loaded in place of the original.

In this way, the Sequence may be populated with Method files
one-by-one as desired:
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Sequence Editor —

Q0w

Salvent Method File(s}:

1 \sc.lvenm v\ |CADVS dvartagsmethodyparial pressure test 1530

2. [SobentA | |CADVS Advartagetmethodypanil pressure test 2520

3. \sulvenm v\ | CADYS-Advartagetmethodipartisl pressuns test 3 sa0

4. [SolventA v |CADVS-Advartage\methodspattial pressure test 450

C o

[[[[[[E[[[

Contiol Mode

SolventA: [Openloop | SolventB: Openloop v

As the list is populated, the Unload Method button =)
appears next to the last populated box. Clicking this button
removes the last Method file from the list:

|C:\DVS-Advartage\method test4 pre @

—p Solvent

=l Solventd, W

D_..'.“

=l Solvent b W

| Solvent s w
ot Solvent & W

Sabvend [Cpantoce ¥ SeelB: | fomion %
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Once a Method file has been loaded the Solvent edit box to its
left becomes active. This allows the user to select which
solvent will be used with this Method in the Sequence.

The Sequence Editor appears with Solvent A (left-hand bottle)
as default — clicking the edit box or the down arrow next to it
will allow Solvent B (right-hand bottle) to be selected:

Solvent

Sn:nl'-.-'ent A A

Solvent A

Save Sequence and Close Sequence Editor

— @ @

Sabotnih [Cpanime | Sohenil: [Gomion ¥

Clicking the Save Sequence button @ allows the user to
save the newly created Sequence file.

Clicking the button calls up the Save Sequence window:
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Save Sequence E] E|

&

\\.'

Save in:

My Documents

) sequence

v

sequence best20seq.seq sequence test 15,5eq

5| sequence test 1.5eq
sequence kest 2,seq

sequence kest 7,5eq
sequence kest §,5eq
sequence test 9.5eq
5| sequence test 10,5eq
sequence kest 11.5eq
55| sequence test 12,5eq
sequence kest 13,5eq
sequence test 14.5eq

55| sequence test 16.5eq
sequence test 17.5eq

sequence test 22,5eq
sequence test 23,5eq
sequence test 24.5eq
5| sequence test 25,5eq
sequence tesk 26.5eq
5| sequence test 27,5eq
sequence test 28,5eq
sequence tesk 29.5eq

>4 @

sequence test 30,5eq
sequence test 31.5eq
sequence test 32.5eq

My Recent
Documents sequence test 3.5eq 5| sequence test 18,5eq ]| sequence test 33.5eq
= sequence kest 4.5eq sequence kest 19seq,seq sequence test 34.5eq
£ sequence kest 5, 5eq sequence test 20,s5eq
Desktop sequence kesk 6,580 sequence kesk 21.5eq

by Computer
*
‘._‘] File hame: A
2
by Metwark Save as type: Sequence [*.seq) v

By default, the software will immediately navigate to the
directory specified in the Preferences option (Section 9.2.1.2)
— another directory may be selected in the window above if
desired.

Upon specifying the Sequence filename name, clicking Save
will save the file and close the Save Sequence window and
the Sequence Editor window, returning the DVS Advantage
Software main panel. The newly saved Sequence will appear
in the Sequence Panel (Section 10.5).

Clicking the Close Sequence Editor button “ (or the Close

button [&3]) calls up the following window:
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Close Confirmation

D

You are about to lose all changes you made to this sequence.

Are you sure you want to continue?

[ fes l [ Mo

Clicking Yes closes the Sequence Editor window and returns
the DVS Advantage Software main panel. The new
Sequence file will not be saved.

Clicking No returns the Sequence Editor window.

9.6.1.2 Load Sequence
Sequence
Mew Seguence...

Load Sequence. .

Clear Sequence. ..

This option allows the user to load an existing Sequence file.

Clicking the Load Sequence option calls up the following
window:
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Select Sequence File

Look in: |=‘jsequence \;| ¢ | T =

LY Seql.seq

E) Seql.seq

My Recent Seq3.seq
Documents

Fra
L

Desktop

My Documents

9%

My Computer

‘E} File name: || b | [ Open l

My Network Files of type: |Sequence (“seq) vi [ Cancel ]

Figure 9.8: The Select Sequence File window

By default, the software will immediately navigate to the
directory specified for Sequence files in the Preferences
option (Section 9.2.1.2) — another directory may be selected
in the window above if desired.

Upon selecting a Sequence file and clicking Open, the

Sequence will appear in the DVS Advantage software
Sequence panel (Section 10.5):
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4 Dynamic Vapour, Sorption - Advantage

File Configuration Solvents Method Sequsnce  Calibration  Help

LU A

Sequence File

|CADVS Advantage\sequencetsequence test 36 seq

Solvent Method File(s):

1. | Solvents | |CADYS-Advantage method\partial pressure test 1.sa0

2. | Salventa | [CADVS-Advantagemethodipartial pressure test 2.s30

3. | SolvertA | |CADVS-Advantage methodipartial pressure test 3.sa0

4. | Solvents | |CADYS-Advantage method\partial prassure test 4.sa0

5. | Solvent4 | |CADVS-Advantage methodipartial pressure test 5.5a0

Control Mode:

SolventA: | Openloop | SelventB: | Openlacp

Mass Graph | Instrument Data | Sequence | Active Method | Fun Experiment | Diagnastics

Stalus: Ready. Surface Measuement Systenrs © 2008

The Sequence is now loaded.

Note: The Sequence panel does not need to be cleared in
order to load a Sequence. If a Sequence is already loaded,
the Load Sequence option can be used to overwrite it with
another Sequence. The overwritten Sequence file is not lost
from the computer hard drive.

9.6.1.3 Edit Sequence
Seguence
Mew Sequence...

L £...
dit Sequence,

Clear Sequence. ..
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This option allows the user to edit an existing Sequence file
which has been loaded (see Section 9.6.1.2 above).

Note: If there is no Sequence loaded in the DVS Advantage
Software, then the Edit Sequence option is disabled:

Seqguence

Mew Sequence. ..
Load Sequence...

The Edit Sequence function applies only to a Sequence file
that has been loaded.

Clicking the Edit Sequence option calls up the Sequence
Editor window for the Sequence file that is currently loaded in
the software.

For example, if the Sequence shown below is loaded:

b Dynamic Vapour Sorption - Advantage ‘Z”E‘E‘

File Configuration Solvents Method Sequence Calibration  Help

Ol

Sequence File:

|E:ADYS A dvantagehsequencelsequence test 3 seq

Solvent Method Filels):

1. | Sobentd | |C:ADVS-Advantagetmethodspartial pressure test 1.sa0 |
2. | Solventp | [C:\DVS-Advantagemethodspartial pressure lest 2.sa0 |
3. | sobenth | |C\DYS-Advantagsimethodipartial pressure test 3:sa0 |
4 | Sobentd | |C:ADVS-Advantage\methodspartal pressure test 4.sa0 |
5. | SobentA | |C\DVS-Advantagsimethodipartial pressure test 5sa0 |
& J[ |
= I \
@ | I |
a J[ |
| I |

Control Mode:

SolventA: | DpenLoop |  SalventB: | OpenLoop

Mass Graph | Instument Data || Sequence i| Active Methad | Run Experiment | Diagnostics

Status. Ready. Surtace Measurement Systems © 2008
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Selecting the Edit Sequence option will display the loaded
Sequence settings in the Sequence Editor panel:

Sequence Editor &l

Method Filefs):

CADVS-Advantagsimethod\partisl pressure test 1 530

. | Salvent & CADYS Advantage\method\partial pressure test 2.sa0

- | Solvent &

v
v

. | SolventA v | |CADVS-Advantagsimethodipartial pressure test 3 san
~ | |CADWS-Advantagemethodpartial pressure test 4.sa0
v

1
2

3

4

5. [Golvent & CADVS-Advantagstmethod\partisl pressure test § 530
6.

7

8

9.

LLLLLELLLL

Control Mode

SolventA: [Openloop | SolventB: [Openloop v |

The various functions as outlined in Section 9.6.1.1 may then
be used to edit the Sequence.

Upon completing the changes to the Sequence, the user may
close the Sequence Editor, in which case all changes to the
Sequence will be lost, or they may Save the edited Sequence
under a new Sequence filename (refer Section 9.6.1.1 for
details on closing and saving Sequence files).

Upon Saving the edited Sequence, the DVS Advantage
software interface will be returned, showing the newly edited
Sequence in the Sequence panel.

Editing a running Sequence (and Method)

A Sequence (or Method) may be edited while it is running
and data being saved. When a Sequence is running, the
Sequence panel appears as shown below, displaying the
active Method of the Sequence in green (see Section 10.5 for
a more detailed explanation of the Sequence Panel):
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" Dynamic Yapour Sorption - Advantage

Fle Configuration Soivents Method Sequence Callbration Help

Ol M

SequenceFile:

|CADYS Advantage\vequencetsequence test 20520 ]

// Method File{s): =

2. | Solvents | |CADYS-Advantage method\partial pressure test 2.sa0 ] )
3. | Solvents | [CADVS-Advantagetmethodipatial pressure test 3.san |
" e
& | /| —_— |
B | |
E| I |
- | | |
- | | |
2 I |
Cfntiol Mode:
SolventA: | Openloop | SolventB: | Openloop
| Mass|fraph | Instrument sthad | Fiun Experiment | Diagnostics|
tatus:fpaving Data Surface Measuement Systerns & 2008
Jata eqLence fi¥el;

Solvent Method File(s):

S | Solvent A | |C.\DVS-Advanlage\methud\pall\al pressure test 2 zao |

- | Salvent & | |E:\DVSrAdvantage\method\palt\al pressure test 3.sao |

With a Sequence running, the Sequence menu appears with
all options deactivated except for Edit Sequence....

Mew Sequence. ..
Load Sequence...
Edit Sequence..,
Clear Sequence. ..
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Clicking Edit Sequence calls up the Sequence Editor
window. The running Sequence will be displayed (however
the active Method will not be highlighted green):

Sequence Editor E|
Solvent Method File(s)

| v | |CADVS-Advartags\method\partial pressure test 1.5a0
2 [Gohentd v | |CADVSAdvartanehmethodipatisl pressurs test 2 san

3. [Solvents v |CADVS Advantageimethodipartial pressure lest 3520

LLLLLLLELL

Control Mode

SolventA: [Openlosp  v| SolventB: |Openlosp v

All of the Editing options function as described above in
Section 9.6.1.1.

Editing the running Sequence

To edit a running Sequence, some points need to be
remembered:

1.Replace like-for-like Methods
The active Method in a running Sequence can only be
replaced by a Method of the same type ie; a partial
pressure Method must be replaced by a partial pressure
Method, preheat by preheat, clean.dcc by clean.dcc:
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b Dynamic Vapour Sorption - Advantage

File Configuration Solverks Method Sequence Calibration  Help

Ay

Sequence File:

|CADVS Advantage\sequencetsequence test 22 seq

Control Mode:

Salvent Method File[s)

1. | Salvent B | |CADVS Advantage\method\partal pressure test 1.san ]

2

| I |

. Il - ]

5 | I N |

& | I N |
= . A s
& IS Earidar preE=nre 1 .
o I | F

B I

SolventA: | Openloop | Selvent

dvnarhial nressire bes

| Mass Graph | Inshument Data | Sequence | Active Method | Fun Experiment | Diagnostics|

Stalus; Saving Data... Suface Measwement Spstenrs © 2008

Sequence Editor

0w

Solvent Method File(s):

1. [SokentB v \:\DVS—Auvamage\mwm\w.seu
2. \s:.lvenm vl |CADVS Advantagstmegodhpreheat test 3 pre_J)

|
| L]
3. [Sobenta v/ ‘E\DVS—AdvanlagE\melhw3.sau | o
i
|
L 1

4 } N

: | b .

8 \

2 o o hiodpreheat test 3 pre

Contiol Mode 1 11 L 1 1 L™

SolventA: Openloop v SolventB: ClosedLop v |

If - as shown above - a different Method type is used to
replace the active Method in the running Sequence, a

205




DVS Advantage Operation Manual

message of the form shown below will appear when
saving the new Sequence:

Invalid Sequence Settings

'E Error: You are currently running a sequence.
L

The bype of the currently active method is: PREHEAT.
The type of the method 2 in your new sequence is: PARTIAL_PRESSURE.

Flease change kthe tvpe of method 2 in vour new sequence ko be a PREHEAT methad before attempting ko continue,

Clicking OK will return the Sequence Editor.

If a Method is not active, then it may be replaced by a
Method of any type.

2.Number of Stages
When replacing the active Method, the new Method
must contain at least as many Stages as the number of
the active Stage in the original Method.

For example, if the active Method of a running
Sequence contained ten Stages, and Stage 2 was
active when the Sequence was edited:
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Dynamic Yapour Sorption - Advantage

Fle Configuration Solvents Method Sequence Calbration Help

LY

Sequence File:

|CADYS Advantage\sequencesequence test 29 seq

Solvent Method File(s)

1ok | CADVSAdamgdweodpardpesae e 2020

2. | SolventA | [C:ADVS-Advantagetmethod\parial pressure test 11,520 |
3. | Sobvent | |C:\DYS-Advantage\methodypartial pressure lest 10.sa0 |
4. | Solvents | |C:ADVS-Advantagehmethod\patial pressure test 9,520 |
| J[ |
i I \
2| J[ |
e | J[ |
2| I |
10| I |

Control Mode:

SolventA: | Openloop |  SalventB: | Closzd Loop

| Mass Graph | \nsuumenQata| Sequence wl\ve Method | Run Experiment | Diagnostics
S

Surface Measurement Systems © 2008

Dynamic Yapour Sorption - Advantage

Fle Configuration Solvents Method Sequence Calbration Help

Methad Stages | Methad Setings |

Fartial Pressun

| Fressure (%)

IStageﬁ ¢| Stage Type ‘ Time [min.] | dmdt [%/
2 Time 20

20

Time (min)

] | dmdt (%/min)| Stat%P/Po| Stop%F/Fa | Templ"

0.00 26.00

Timne:

2000 2500

4 30,00 2500
5 Time: 20 40.00 2500
R Time 2n Annn 2800
Active Sequence Active Mathod Active Method Stages
Maximum Time Remaining: | 00 Days 00 Hours 43 Min, 55 Sec. | 00Daps 00 Hous 17 Min. 55 Sec. | | 00 Days 00 Hows O Min, 55 Sec.

| Mass Graph | Instrument Data | Sequenﬂ Active Method J’un Experiment | Diagnostics|

Status: Saving Data. Surtace Measwement Spstens © 2008
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.....then the newly edited Method would have to contain at
least 2 stages:

Sequence Editor

1. |Saventds v | |CADYS-Advantage’method\partial pressure test 13.5a0
2 [Sobentd v |[CADYE-Advantage\methodparia pressure test 11520

3 |5u\venlA v\ |CADVS dvantagetmethod\patial preseure test 10,530

4 [Sobents v [CADYE-Advantagemethodparial pressure test 3.5a0
5.

A [

6.
7
8.
9

Solvent &

Solvent & [

10

Solvent &

E[[[[[E[[E

Control Mode

SolventA: | Open Loop v SolventB: Closed Loop %

Dynamic Yapour Sorption - Advantage

Fle Configuration Solvents Method Sequence Calbration Help

Methad Stages | Methad Setings |

Pressure (%]

Parli
(0,) smesedus sdueg

Time (min.)

.
Stogett - N\Gtoge Type | Time[min] | dm/dk (%/mn)| Stat% P/Po| Stop %P/Pa | Temp['C)
2 Time: 20 0.00 0.0 25,00

2 20 | 0io0ood 1000 10.00 2500

3 Time: 20.00 2000

\ 5 Time 20 | ofoooon 4 ]

Stagett - |

Active Sequence Activs Mel ethod Stage
Maximum Time Remaining: | 00 Days 00 Hours 23 bin. 11 Sec. | | 00 Days 00 Hows 0 2 rs 01 Min. 11 Sec.

| Mass Graph | Instrument Data | Sequence | Active Method | Run Experiment | Diagnostics |

Status: Saving Data.
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This is because the newly installed Method in the new
Sequence picks up from where the original Method was
interrupted for editing (in this example, on the second
stage) — the new Method does not commence from the
beginning.

If the new Method contains fewer Stages than the
number of the active Stage, then a message of the form
shown below will appear when saving the new
Sequence:

Invalid Sequence Settings El

'E Errar: You are currently running a sequence.

Methad 1 is active and stage number 2 of the methad is running.
Method 1 of your new sequence conkains only 1 skage(s).

Please ensure that methad 1 in vour new sequence contains at least 2 stages before attempting o continue,

Clicking OK will return the Sequence Editor.

Note: The conditions described above apply both to
Preheat and Partial Pressure Methods.

3.Number of Methods

The newly edited Sequence must contain at least as
many Methods as the number of the active Method in
the original Sequence.

For example, if the original Sequence contained three

Methods, and Method 2 was active when the Sequence
was edited:
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4 Dynamic Vapour, Sorption - Advantage

Fle Configuration Solvenks Method Sequence Callbration Help

ey |

Sequence File:

|CADYS Advantags\senuencehssquence test 22,580

Solvent Methad Filefs):

Bhvent B | |CADVS Advantagetmethodipartial prassuvaﬁe |

2.
3. | Salvenla | [CADVS Advantage\methad\partial pressure test 3:sa0_g# |

1. | Solvent B | |C:'\D'\-’S-.f3.dvantage\methad\paltial preszure test 1.zao

2. Soventh  CADVSAdvantagelmethodipartl ressure lest 2520 |

3. | Solvent & | |C:'\D'\-’S-.f3.dvantage\methad\paltial preszure test 3. zao

Y —
» ]
i
A
A

Contiol Mode:

il

SolventA: | Openloop | SelventB: | Closed Loop |

| Mass Graph | Instrument Data | Sequence || Aotive Method | Run Experiment | Diagnostics |

Status: Saving Data. Surface Measurement Systems © 2008

..... then the newly edited Sequence would have to
contain at least 2 Methods:

Sequence Editor
i -
Solvent Methad File(s):

/’mma | [EADVS Advantagshmethodspatial p.w |
2. | [CADVS-Advantagetmethodipatial pressure test 7.sa
T — | — |

\ N~

E_LE_EE_

|

1. |SnlventE v| |I::'\D"v"S-.-'fxdvantage'\methnd'\partial pressure test 1.zao

2. |Snlvent.ﬁ. v| |E:"\D"-.-"S-.-“-".dvantage'\methad"\partial prezsure test 7.zao

N | o

Contriol Mode

SolventA: | Open Loop ~ SolventB: Closed Loop %
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This is because the newly edited Sequence picks up
from where the original Sequence was interrupted for
editing (in this example, on the second Method file) —
the new Sequence does not commence from the
beginning.

If the new Sequence contains fewer Methods than the
number of the active Method, then a message of the
form shown below will appear when saving the new
Sequence:

Invalid Sequence

'E Error: You are currently running a sequence,
.

Method 2 is currently running.

Please ensure that your new sequence contains at least 2 method(s) before attempting to conntinue.

Clicking OK will return the Sequence Editor.

4.Solvents and Control Modes
The Solvents and their Control Modes may be edited
freely on a running Sequence.

5.New Sequence automatically loaded and run
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Once the running Sequence has been edited according
to the requirements above, clicking the Save Sequence

button @ calls up the Save Sequence window, which
allows the user to name the newly edited Sequence:

Save Sequence

5

My Recent
Documents

\\ g'_‘{l
* =1
=]

My D ocuments

=
=
O
2 & \
Y 26l
=
=4
@

My Metwork

Save in: | ) sequence

"]

PIX

> 4 B G

sequence test20seq.seq sequence test 15,5eq

EI sequence best 1.5eq
sequence test Z,5eq
sequence best 3.5eq
sequence test 4.5eq
sequence kest 5.seq
E] sequence test 6,5eq
sequence test 7.5eq
EI sequence best §.5eq
. sequence best 9,5eq
.sequence test 10, seq
.sequence test 11,5eq
.sequence test 12,589
EI sequence kest 13, seq
sequence test 14,5eq

<

EI sequence test 16.5eq
sequence test 17.5eq
sequence test 18,5eq

sequence test 19seq.5eq

sequence tesk 20.5eq
E] sequence test 21.5eq
sequence test 22,s5eq
EI sequence test 23.5eq
. sequence test 24,5eq
.sequence test 25,5eq
.sequence test 26.5eq
. sequence test 27.5eq
EI sequence test 28.5eq
sequence test 29,5eq

sequence tesk 30,5eq

le hame: |sequenc:e test 31.zeq

D Save

e as bype:

| Sequence [ zeq)

[ Cancel ]

File name:

| zequence test 31.ze8q

Upon naming the new Sequence and clicking Save, the
DVS Advantage Control software Sequence panel is
returned, displaying the newly edited Sequence, which
is now running in place of the original Sequence:
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' Dynamic Vapour Sorption - Advantage (=T

File Configuration Solvents Method Seguence Calibration Help

P
Y
il —
|C:ADYS Advantags\senuence\sequence test 31.seq > |
—— —
Solvent Method File[s):
"

2. | Salvent & | [CADVS Advantage\methodipatidlpressure test 11,520 |
3. [ solvert A | |CADVS Advantage\method:partial phgssure test 10.sa0 |
4 | solvents | ‘E\DVS—Advanlage\methnd\palhalpre: e test 1 san |

Sequence File:

\ Il
[ ] [
\ I
} : } | C:ADYS-Advantagehsequence’sequence test 31 2eq
\ I

Control Mode:

SolventA: | OpenLoop |  SolventB: | Closed Loop

Mass Graph | Instument Dala | Sequence | Active Method | Run Experiment | Diagnostics

Status: Saving Data... Surface Measurement Systems © 2008

Note: The active (ie; running) Method of a Sequence may
also be edited. While the Method is running, the Edit Method
option may be used as described in Sections 9.5.1.2 and
9.5.2.8. This applies both to Preheat and Partial Pressure
Methods.

The newly edited Method will need to be saved under a new
name — but note that it is not automatically loaded into the
running Sequence.

To do this, the running Sequence will need to be edited to
include the new Method as described above.
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9.6.1.4 Clear Sequence

- This option clears any Sequence
that is loaded in the DVS Advantage
Mew Sequence... Software.
Load Sequence. ..
Edit Sequence. ..

Clear Sequence...

Note: If there is no Sequence loaded in the DVS Advantage
Software, then the Clear Sequence option is disabled:

Sequence

Mew Sequence. ..
Load Sequence...

The Clear Sequence function applies only to a Sequence file
that has been loaded.

For example, if the following Sequence were loaded:
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/" Dynamic Vapour, Sorption - Advantage ‘Z”EI&'

File Configuration Solvents Method Sequsnce  Calibration  Help

LU A

Sequence File

|CADVS Advantage\sequencetsequence test 36 seq

Solvent Method File(s):

1. | Solvents | |CADYS-Advantage method\partial pressure test 1.sa0

2. | Salventa | [CADVS-Advantagemethodipartial pressure test 2.s30

3. | SolvertA | |CADVS-Advantage methodipartial pressure test 3.sa0

4. | Solvents | |CADYS-Advantage method\partial prassure test 4.sa0

5. | Solvent4 | |CADVS-Advantage methodipartial pressure test 5.5a0

Control Mode:

SolventA: | Openloop | SelventB: | Openlacp

Mass Graph | Instrument Data |} Sequence | Active Method | Run Experiment | Diagnostics

Stalus: Ready. Surface Measuement Systenrs © 2008

...then clicking the Clear Sequence option calls up the
following window:

Clear Seguence Confirmation

P About to dear the currently loaded sequence from memory.

Are you sure you want to continue?

[ Yes ] [ Mo ]

Note: The Sequence file being cleared is not cleared from the
computer’'s hard drive. The file may still later be accessed
and loaded for use in the DVS Advantage software.

When a Sequence file is cleared, it is merely cleared from the
Sequence panel.

Upon clicking Yes, the DVS Advantage software interface is
returned, with the Sequence panel cleared:
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4 Dynamic Vapour, Sorption - Advantage

File Configuration Solvents Method Sequsnce  Calibration  Help

LU A

Sequence File

Solvent Method File(s):

Control Mode:

Solventa: | | SolventB: |

| Mass Graph | Instrument Data | Sequence | Active Method | Fun Experimert | Diagnostics|

Stalus: Ready.

Surface Measurement Systems © 2003

Calibration

9.7

Cecontaminate Optical Sensor,.,

Calibrate Balance. ..

Solvent Lookup Tables. ..
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Note: The Calibration menu is disabled whenever data is
being saved. Data saving must be stopped before the menu
options may be used.

9.7.1.1 Decontaminate Optical Sensor

This menu item sends
Calibration the Optical Sensor into
Dynamic Contamination
Correction mode (DCC).

Cecontaminake Optical Sensor. .

Calibrate Balance. . Please refer to Appendix
E (Section 15) for more
Solvent Lookup Tables. . details on the Optical
Sensor Dynamic

Contamination Correction.

9.7.1.2 Calibrate Balance

Calibration

Upon clicking the

: : Calibrate Balance
Deconkaminakte Optical Sensor, .. option, the following

window appears:

Calibrate Balance. ..

Solvent Lookup Tables., ..

Balance Calibration E'
L] E Please empty the sample pan.
L
[ oK l [ Cancel
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e At this point make sure the sample pan is empty and
clean and wait for the balance to stabilise.

e Click OK. The following prompt will then appear:

Balance Calibration

L] E Please load a calibration weight of: 100.0000 (mg)
L

I OK H Cancel ]

e Carefully place a certified calibration weight in the
sample pan.

e Click OK. The following panel will then appear:

" Balance Calibration

Stable - '

e The panel shown above then displays the current
measured mass. The light below this value will be red,
and will remain so until the balance reading becomes
stable (this typically takes 5 minutes). When the mass
reading is stable the light will turn green and the user
can then click OK to register the system’'s new
calibration constant.

218



DVS Advantage Operation Manual

9.7.1.3 Solvent Lookup Tables

Please refer to Appendix D (Section 14) for information on the

operation of the Solvent
Calibratian Lookup Tables. Only a
qualified SMS service
engineer should edit
Calibrate Balance. .. these values.

Deconkaminakte Optical Sensor, ..

Solvent Lookup Tables. ..

L BOGwr

vl Zamera Settings. ..
ol Advanced Snapshot Settings. ..

i — Calibrate Snapshok Scale Marker. ..

The DVS system’s video allows the user to take manual or
automated pictures of the sample; sample shapshots may be
taken manually when not saving data, or at a pre-defined
frequency when saving data or at the end of each Method
Stage when running a Method.

Please also refer to Sections 9.2.1.3 and 10.7 for more
information on the Video function.

The Video menu options allow the user to adjust various

parameters of the system’s Dino-Lite Digital Microscope
video camera and to set various image parameters.
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Note: The Video menu option will only appear if a DVS
Advantage system with Video has been purchased.

In addition, the Video menu option becomes inactive
whenever data is being saved (ie; when running a Method or
when simply saving data). Any desired parameters must
therefore be set before data saving commences:

Yideo

Additional Note: The Dino-Lite Digital Microscope video
camera connects to the DVS control computer via a USB port.
If the camera is not correctly connected at the time the control
software is opened, the following message will appear:

Fatal DVYS Error - Video Camera Initialisation Error.

@ The software cannot detect a Dinolite camera connected to the computer,
Flease check the Following before attempting bo continue:
1. Ensure that a DinoLite camera is correctly connected ko a USE port of the computer.

2. Verify the DinoLite hardware drivers have been installed correctly: Open Device Manager,
then select the Imaging Devices section and verify that the DinoLite Camera is shown correctly,

Please click the OK button to shuk down the DY¥S Advantage software.

Similarly, if any of the Video menu options are clicked but the
camera has become disconnected, the message below will
appear:
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Video Camera Mot Detected - Cannot Adjust Camera Settings @

'j The software cannot detect a Dinolite camera connected to the computer,
< Please check the Following befare attempting to continue:
1. Ensure that a DinoLite camera is correctly connected to a USE port of the computer,

2. Yerify the DinoLite hardware drivers have been installed correctly: Open Device Manager,
then selzct the Imaging Devices section and verify that the DinoLite Camera is shown correctly,

Plzase dlick the OK button to continue.

9.8.1 Camera Settings

This option allows the
user to adjust the
picture from the video
microscope to ensure

amera Sekkings. ..

Advanced Snapshot Settings. ..

Calibrate Snapshot Scale Marker., .. optimum image quality
of the sample
shapshots.

Clicking this option calls up the Adjust Camera Settings
window as shown:

%" Adjust Camera Settings @

Camera Settings

Biighiness

e T T
0 20 40 B0 80 100 126
Contrast

T
100 120 140 160 180 200

Gamma
e e
0 20 40 60 100

Hue
e e e
0 100 200 00 3860

Sahuation

T R T e Y
0 50 100 150 200 250 299

Reset to Defaul Setlings
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Note: The screen grab above shows no picture, but a live
video picture will appear in the black box shown above when
actually using the software.

This window provides a live video feed from the camera, and
allows the user to adjust the camera to the settings required
for the upcoming snapshots of the sample.

Once the desired Brightness, Contrast, Gamma, Hue and
Saturation have been found, the settings may be saved by
clicking the close buttona. These settings will be preserved
through software re-starts.

The factory default settings may be reinstated by clicking the

Reset to Default Settings button , Which are
then saved by closing the window as above.

Note: The Camera Settings option also allows the user to
observe a live video image of the sample once it is enclosed
in the sample chamber. However, the Video function does
not allow any live video footage to be recorded.

It is useful to know, however, that if data is being saved either
by running a Method or by simply saving data, the Camera
Settings option is disabled (as is the whole Video menu).

9.8.2 Advanced Snapshot Settings

This option allows the
i user to set parameters
Camera Setkings... relating to the
Advanced Snapshot Settings.. . snapshots taken of the
sample.

Yideo

Calibrate Snapshot Scale Marker. ..

When the DVS
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Advantage Control software is started up, the Video tab will
display no snapshot (Refer to Section 10.7 for more details on
the Video tab):

" Dynamic Vapsur Sarption - Advaniage
Fle Corfigrstion Solvents Method Sequence Calbeation Video Help

QLW

Mtamatic Yideo Mods:
Uon v, nsings i mthod

Sriaprthel Olverlay Setbrngs
Aehusl PP Achud Tempsishes

Sraithot Imags Fanse
e

‘Advanced Snapahot Seting:
Diploy SeeMahrs: VES @

ScdeMaker Largh  200mn

Drploy Ovedey G VES
Dy GidWidhe  200wn
Ovverloy Gid Heght. 2 00mm

T Srugebut Dpen Inage

Mt Gisgh | Inttrsed Dt | Gt | Activt Mathod | Vickse, | Flun Eipeinant | Disgnesics
St Flaack. Suslacn Minscusprent Syttrers © 008

In this case, clicking the Advanced Snapshot Settings
option will call up the following window......

Advanced Snapshot Settings

1 E Flease take a video snapshot before attempting ko adjust the Adwvanced Snapshot Settings.
L]

..... which simply indicates that a snapshot needs to be taken
before any settings may be adjusted. Clicking OK will return
the Control software main window.
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After a snapshot of the sample is taken (refer to Section
10.7.1), the image will appear in the Video tab as shown:

" Dynamic Vapeur Serption - Advaniage
Fle Cofgration Sohends Method Sequence Calbestion Weo Help

QLW

Ausamanc Yidea Mods
Uon v, nsings i mthod

Sriaprthel Olverlay Setbrngs
Aehusl PP Achud Tempsishes

Sraithot Imags Fanse
e

Artvanced Sinagatt Setirgs
Disploy Scole Maker: K

ScdeMaker Largh  200mn

Doy Oveday G W
Dy GidWidhe  200wn
Ovverloy Gid Heght. 2 00mm

T Srugebu Dpen Inage

Mt Gisgh | Inttrsed Dt | Gt | Activt Mathod | Vickse, | Flun Eipeinant | Disgnesics

St Flaack. Suslacn Minscusprent Syttrers © 008

Clicking the Advanced Snapshot Settings option then calls up
the following window:
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" Advanced Snapshot Settings g\
Scale Marker Settings

™ Display Scale Marker

Reference
Length: 200 mm

Pixels: 191 px

Dveilay Grid Settings

-

Widh o) [200=]
Height[rrn] ,?
Brush Size [px]: El:

SECEEAN

Save Cancel

As shown above, the window displays the current snapshot
along with boxes which allow the adjustment of various
settings.

9.8.2.1 Scale Marker Settings

* hdvanced Snspahot Settings 3 Scale Marker Settings
I~ Display Scale Marker
Reference
| Length: 2.00 rnm
Gvectay T oege ]
| . Pixels: 1971 px
_trecios |

A line marking the scale of the snapshot may be displayed.
Ticking the Display Scale Marker box displays the marker in
the top, right-hand corner of the picture as shown:
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" Advanced Snapahst Settings

=

——re— Scale Marker Settings

v Dizplay Scale Marker

Reference
Length:; 200 mm
Finels: 191 px

As shown above, the Scale Marker Settings box also
displays the Reference length of the scale, and the number of
pixels to which this length corresponds.

The Reference length may be set in the Calibrate Snapshot
Scale Marker option (explained below in Section 9.8.3).

9.8.2.2 Overlay Grid Settings

" Advanced Snapahst Settings

Owerlay Grnid Settings

[ Digplay Overlay Grid

wfidth [rinin]: 200 Eli
Height{rim): 2.00 Eli
Brush Size [px): 2 Eli

Lime Calour -
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The Overlay Grid Settings box is activated only when the
Display Scale Marker box is ticked:

Scale Marker Settings Scale Marker Settings
< Display Scale Marker : Iv Dizplay Scale Marker
Reference Reference
Length: 200 mm Length:  2.00mm
Piuelz: 191 pu Pixels: 191 px
Owerlay Grid Settings Overlay Grnid Settings

~

itk [rrn): El:
Height[mm): 3:
Brush Size (pl: El:

_LreCdow |

[ Dizplay Owerlay Grid

‘wiidth [mm): 200 3:
Height{mm]: 200 3:
Brush Size [px): 2 3:

Lirve Colour

Once activated, the Overlay Grid Settings box allows the
user to superimpose a grid over the snapshot images. This
grid assists dimensional analysis of the sample snapshots.
The Overlay Grid Settings box also allows for the grid to be
edited.
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Clicking the Display Overlay Grid box superimposes the grid
on the latest snapshot as shown:

T Advanced Snapshot Settings \Z\
Scale Marker Settings

v Display Scale Marker

Reference
Length: 2,00 mm
Pixels: 191 px

Ovwerlay Grid Settings

I Display Overlay Grid

Wwhdth {mm]: 2,00 —=

Height{mm): 2.00 33
Brush Size (px): | 2 33

Line Colour I -

Save Cancel

T Advanced Snapshot Settings \Z\
Scale Marker Settings

v Display Scale Marker

Reference
Length: 2,00 mm
Pixels: 191 px

Ovwerlay Grid Settings

v Display Overlay Grid

whidth ). 2.00 =

Height{mm): 2.00 33
Brush Size (pe): | 2 33

Line Colour I -

Save Cancel

The settings that are in place (Width, Height, Brush Size and
colour) when the Display Overlay Grid box is ticked will
determine the features of the grid.
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Once the Display Overlay Grid box has been ticked,
however, these settings become inactive:

Overlay Grid Settings Owverlay Grid Settings
[ Dizplay Overlay GridH [v Dizplay Overlay Grd
Wwidth [mm]: |2.00 - wiidth (mm): | 200 =

Height{mm]: 2.00 El: Height[mm]: 3:
Bruzh Size [px]: 2 El: * Bruzh Size [px]: El:

Lire Colaur - -

To edit the Overlay Grid, the Display Overlay Grid box must
therefore be un-checked. The editable parameters are as
follows:

Width (mm): Defines the horizontal distance
between the vertical lines of the grid.
The available settings run from 2mm
to 10mm.

Height (mm): Defines the distance between the
horizontal lines of the grid. The
available settings run from 2mm to
10mm.

Brush Size (px):Defines the thickness of the grid lines

in pixels. The available settings run
from 1mm to 10mm.

The desired settings may be entered directly or by using the
arrows at the right of each data entry box.

229



DVS Advantage Operation Manual

230

Line Colour:

Clicking the Line Colour button calls
up the following window, from which
the desired grid colour may be
selected:

Basic colors:
Bl FHE[ NN
HM MEfENEN
ENNEENEN
ENEEEEEN
AEEEEEEN
HEENETE

Custom colors:

- rrrrrir
I I Y O O O

[ Define Custom Colors »» ]

[ 0k H Cancel ]

Clicking the Define Custom Colours
button calls up the window shown
below, which allows custom colours
to be selected and saved:
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B asic colors:

T
HMrEENENN
ENENEEEEN
ENEEEEEN
AEEEEEEEN
L i i Inl I
Cusgtom colors;

4

rrrrrrr
Huge: Bed EI
et e ] o]
Define Custarn Colors > ColorSalid ) |y EI Elue: EI
’_ QK ] ’_ Cancel ] [ Add to Cuztarn Colaors ]

Clicking OK on the Colour window
then returns the Overlay Grid
Settings box with the newly selected
colour in place.

After setting the above parameters and clicking the Display

Overlay Grid box once more, the grid will reappear in its
newly edited form:
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Advanced Snapshot Settings

3]

Scale Marker Settings
[¥ Display Scale Marker

Reference
Length  200mm

Phels: 191 px
Dverlay Grid Settings

[¥ Display Dverlay Grid

width [ zin=]

Heighi{mm} 200 =
Brush Size (pl | © =
tine Coior | [

Save Caneel

Owerlay Grid Settings

[~ Dizplay Oweray Grid

Width [mm): I 200 5:
H eight{mmm; I 200 5:
Brush Size [px): I 2 3:

Line Colour | -

" Advanced Snapshot Settings

Owerlay Gnd Settings

[ Dizplay Overlay Grid

Wfidth [rom): I 300 3:
Height{mm]: I 4.00 3:

Bruzh Size [px]: 0=

Lire Colour | -

Scale Marker Seltings

[V Display Scale Marker

Reference
Length:  200mm

Phels 191 p

Overlay Grid Settings

¥ Display Dverlay Grid

widh [} 300 =

Heighlirmm}. ET |
Brush Size (p) [ 10 =

tine Coimr | [

Save

Carcel
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Clicking the Save button then saves all of the
settings recorded in the Advanced Snapshot Settings
window, and returns the DVS Advantage Control software
main interface.

These newly saved settings will be applied to all sample
shapshots taken subsequently, and will be retained through
software re-starts.

For example, after saving the settings above and going to the

Video tab, clicking the Take Snapshot button will
result in the new image being recorded as shown (also refer
to Section 10.7 for more details on taking snapshots and the
Video tab):

l Take Snapshat I
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9.8.3 Calibrate Snapshot Scale Marker

YWiden

The Scale Marker will
need to be calibrated if
Adwvanced Snapshot Settings. .. the distance between
the camera and
sample changes, or if
the camera’s focus is
altered. This will ensure that the distance represented by the
Scale Marker on the sample snapshots is physically accurate.

Carmera Sekkings. ..

Calibrate Snapshok 5c

Clicking the Calibrate Snapshot Scale Marker option calls
up the following wizard which guides the user through the
calibration process:

" Calibration Wizard - Video Snapshot Scale Marker

‘Welcome to the Video Snapshot Scale Marker Calibration Wizard.

This wizard sllows you ta calibrate the number of pixels used to diaw the video snapshot scale marker against a refersnce measurement object of
defined size.

Click the Mext button to begin the calibration process.

Mote: Each time the video camera focus is changed you will need to re-calibrate the Video Snapshat Scale Marker,

e ] [ ]

The wizard takes the user through a step-by-step process of
taking a snapshot of a reference measurement object (eg; a

234



DVS Advantage Operation Manual

piece of paper with 1mm markings), and drawing a line on this
shapshot which defines a particular length.

The wizard is self-explanatory and as such it is not replicated
in this manual.

However, it should be noted that the calibration must take
place with the camera at the same focus as will be used in the
experiment. In addition, the reference measurement object
must be the same distance from the camera as the sample
will be in the DVS Advantage system.

To that end, it is advised that the reference measurement

object is placed in the sample pan and hung in the system in
order to perform the calibration.
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! .| S :» About... I

99.1.1 About

Clicking this option calls up the following panel, which details
the software’s version number and other system details. A
link to online help is also provided.

" About DYS Advantage

DV S-Advantage Control Software

Version: 2.1.0.9
L Model: [OWVS1
- ) Range: LOW
Videor NO

[ SYSTEMS |

www. smsuk co.uk
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10 Software panels

10.1 Introduction

The DVS Advantage Control software is composed of six
panels, each of which serves a specific purpose relevant to
setting up, running and monitoring an experiment.

The panels are entitled as follows:

Mass Graph
Instrument Data
Sequence
Active Method
Run Experiment
Diagnostics

These panels are accessed by clicking on tabs at the bottom
of the control software interface, as shown below:
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" Dynamic Vapsur Serpiion - Advaniage

Fle Corfigration Sovents Method Sequence Calbeation Video Help
QLWOOMP TN
Mzt v Ty
123 ~008 Mass [mg) 123
LY ES 1231 754
mam il o [ ] | 11000000
Cir. Wi [mg) 00000
g - mana(0] fma) [0
AL - T2 A
M0 -ao " () X Pabdl Presiue
1 g ) Tawpmskss [T
¥ £
5 WG -am :? Koy
H H Aehud % Parhsi Pressue
S2nes e
T Diwizians.
EiREr ] 1.+
20 man Sl -
a7 -a;n
Pan Graph:
ek doven tha CTRIL by,
mna =nm then cleh, and dhiag the el
Pocussa Butien ontha gisph.
50000 - = -0on
L e
< T .
Surlacn Manssumment Syrinrs © 2006
tazs Graph | Instrument Data | Sequence || Active Method | Video | Run Experiment | Diagrostics

This section explains the functions and operations of each of
these panels.

10.2 Common Functions

There are some buttons which appear across the top of all of
the panels, each of which are explained below:

10.2.1 Select Solvents
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This function is also accessible via the Solvents
& option on the software toolbar, which is outlined in
Section 9.4.1.

10.2.2 Tare Balance

This function tares the balance ie; sets the current
@ mass value to zero.

Clicking the button calls up the following window:

Confirmation Required

\_‘.i} About to Tare the balance, Are you sure?

I es l [ Mo ]

Clicking No will retain the current balance reading.

Clicking Yes will set the current mass reading to zero.

10.2.3 Set Initial Mass

This function defines the M(0) value for the
experiment. Clicking this button sets the current
mass reading as the M(0) (initial mass) value.

Upon clicking the button, the following window appears:

Confirmation Required

9 -
\‘_.J‘j About to set the Initial Mass, Are you sure?

[ Yas ] [ Mo
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Upon clicking Yes, the newly defined Initial Mass will appear
in the display on the Mass Graph panel (see Section 10.3
below).

10.2.4 Clear Graph

This function clears the graph on the Mass Graph
panel of all data and re-commences the plot from the
left hand side of the graph.

Clicking this button calls up the following window:

<P About to clear all data from the graph...

Are yol sure vau want ko da this?

[ ‘fes l ’ Mo ]

Upon clicking Yes, the Mass Graph is cleared of all displayed
data (including partial pressure and temperature). The data
will re-commence plotting from the left-hand side of the graph.

10.3 Mass Graph panel

The Mass Graph panel shown below charts the raw mass,
partial pressure and temperature data measured by the
instrument.

Also displayed on this panel are numerical mass data and
controls for altering the format of the chart.
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* Bynamé Vapsur Sorption - Advaniage
Fle Corfigration Sovents Method Sequence Calbeastion Wleo Hele

L WLOOMP TN

Mt v Tiem
12

mam

L1500

LTS

I

Tiemes (20 rn /]

Maea Giach | Intinamsark D1ats | Gmatvcas | Acties Mathod | Wids | Fun Enpaverent | Diagnatcs

St Fnady

Mans [mg] 1T
miall) 2 1271 71
ol i) (L 0000000
Tl W fmg) 00000

Tiema Divizians

Hmnide  w

P Giraph
el dsn tha CTFIL by,

then clck el g the kel
en o he geiph.

E T — ]

10.3.1 Mass vs Time graph

The Mass vs Time graph displays two parameters vs time.
On the left-hand axis is permanently displayed the raw mass
data (mg) measured by the system, while the right-hand axis
displays either partial pressure (%) or temperature (°C).

At the top of the panel are located several buttons which
control the manner in which the data is displayed:
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125.0000

124.5000 -

124.0000 -

123.5000 -

123.0000 -

Mazs [mag]

122.0000 -

121.5000 -

121.0000 -

120.5000 -

120.0000

\ Mass v Time

-30.00

-81.00

-72.00

-63.00

-54.00

122.5000 -

-45.00

-36.00

-27.00

-18.00

-9.00

0.00

Time [30 sec. /div]

anssald [ened %
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10.3.1.1  Time Axis — Scrolling & Time Axis
Paused

[ : By default the Time Axis — Scrolling button is
|U:u activated. This ensures that the time axis
= scrolls from right to left as the data is
displayed. The plotted lines must first reach the right-hand
end of the time axis before scrolling commences.

Clicking the Time Axis — Paused button freezes the time
axis. The data lines continue to move left-to-right across the
chart until they reach the right-hand end of the time axis — the
data then continues to be plotted to the right-hand side, off
screen.

10.3.1.2 Rescale Mass/Partial
Pressure/Temperature Axis

a a These buttons allow the vertical axes
Mi P 7 displaying mass, partial pressure and

" " temperature to be rescaled at any time
before, during, or after an experiment.

These functions are also accessible via the Configuration
toolbar option, which is detailed in Section 9.3.2.

10.3.2 Y2 Axis

Dipsarsic Fapwt Savriien B rastogn

SLBO0OmMP TR = Y 2-Axis

(%) % Partial Pressure

) Temperature [*C]

Keyp:

g Actual % Partial Pressure
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This box allows the user to switch between displaying Partial
Pressure (%) and Temperature (°C) on the graph’'s
secondary (right-hand) Y-axis.

Clicking the % Partial Pressure option will display the
measured system partial pressure with a blue line. The target
partial pressure is displayed by a green line, as indicated in
the key shown above.

Clicking the Temperature (°C) option displays the actual and
target sample temperature using red and green lines,
respectively:

Y2-Axis

() % Partial Pressure

(%) Temperature [*C]

Key:

Actual Temperature [*C)

Time Divizions
/ A0 zec. div W

10.3.3 Time Divisions
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This box determines the scale of the graph’s time axis.

The default value is 20 minutes per division. Clicking in the
edit box or the down arrow reveals a drop-down menu which
displays the available options for rescaling the time axis:

Time Divisions

20 mir. Adiw w

A0 zec. Adiv
1 min.Adiv
Pan G1 5 pin /div
Hall 10 rrin. Adiw her
o] 20 mit. Adiv
30 min. Adive
B0 rinddis
120 rain. Adiv

Upon selecting the desired scale by clicking on it, the Mass
Graph will be displayed with its new time divisions. The
selected time scale is also displayed on the horizontal axis
label:

./ Time: (1 min, /iv]
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10.3.4 Pan Graph

- ? Pan Graph:
QL WLO0OmPT R

e Haold down CTRL key, then
o |t click and drag left mouze
button on graph

------

.......

The Pan Graph function is self-explanatory. Upon following
the instructions displayed above, a hand icon will appear over
the graph which allows the user to pan the graph in any
direction:

246



DVS Advantage Operation Manual

Mass v Time
10.0018 - -B9.71
10.0015 - -59.71
10,0011 - \ / -49.71
10.0007 - I I -39.71
@
10.0004 - -29.71 e
7 &
-, 10.0000 - -1971 3
i 2
= =
9.9957 -3 °
9.9993 - --0.29
9.9989 - --10.29
9.9986 - --20.29
9.9982 - --30.29
Time [30 sec. /div]

When panning the graph, the two data lines remain in the
same positions in relation to each other.

As the lines are moved up and down on the graph, the values
on the vertical axes change to follow their movement.

In addition, as the data lines are moved laterally, the vertical
lines showing the time divisions move along with them.

10.3.5 Mass Data box

SQE&BOOMP TR

i —> Mass (mg) 0.0000
oo [l = m/m(0] % 0,000

i dm/dt (% /min) | 0.000000
— Ch. Wt [mg) | 0.0000
mass[0] (mg] | 10.0000
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The mass data box continuously displays and updates the
mass data being recorded and calculated by the system.

Mass (mg):

m/m(0)%:

dm/dt (%/min):

Crt. Wt (mg):

mass(0) (mgQ):

The last measured value of the sample mass.

This parameter is the ratio of the current
mass referenced to mass(0) as a percentage.

This function is the current slope of the mass
data expressed as a percentage of the initial
mass M(0). It is calculated by fitting a linear
regression to a default time window of the last
five minutes of data (Sections 6.2.2 and
9.6.1.1).

Displays the current value of the counter
weight being used. This value is added to all
mass readings from the balance (Sections
6.1.4.1 and 9.3.3).

Displays the recorded M(0) value

10.3.6 Right-clicking the Mass Graph panel

Right-clicking anywhere on the Mass Graph panel calls up the
options that appear in the Configuration menu

Rescale Axes
(Section 9.3.2)
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2 WQONP T

P> Rescale Mass Axis...

Rescale % Partial Pressure Axis, .,

10.4 Instrument Data panel

The Instrument Data Panel shown below displays measured
instrument parameters as well as control switches for the

main DVS functions.
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" Dynaméc Vapsur Sorpiion - Advaniage
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-
Active Subert ) bt A ) Sulvent B
Sobventblome WATER WATER
ContsclMode: Upen Lcp OponLocp
gl Tomp. ['C) % Pastid Prossun Optical Senase Gtatus Frahost Temg. "I
Tonget At Taps: Actus Tonget it
Masnang
& 1m 100 b | 0 i
50 L ] 1] Poctisie ) = lr
® 40 B i [T I ;
o an 0 Fak J E-
o o o Fr [ =
5 0 0 Total Gins Flum J 5
=0 3 b-T [ow LT3 ET
Wit Gingh | Instrrmart Dot | Ganch | Actvs Mathod | Vi | o Eoqavivare | Digpcatis
St A Surlacn Nsaroend Syiners © 7000

When a Sequence is running (see Section 9.6), the
Instrument Data panel serves only as a display of the
system’s parameters — none of the parameters it indicates
may be altered by the user.

However, if there is no Sequence running, then the user may

use the Instrument Data panel to input setpoints for almost all
of the system parameters displayed.
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10.4.1 Solvents Box

Solvents

Active Solvent () Solvent A ) Solvent B
SolventName: WATER WATER
ContiolMode: Closed Loop Closed Loop

This box indicates the Control Mode in use for each solvent
(see Sections 9.2.1.1 and 9.3.4), and which solvent has been
designated Solvent A and Solvent B (see Section 9.4.1).

In addition the bottle icons indicate which solvent - A or B - is
Active (in use) in the present experiment. The Active solvent
is illuminated green as shown above.

If the user wishes to perform an experiment without loading a
Sequence, then they may use this area to choose the Active
Solvent by clicking on the desired label — Solvent A or Solvent
B (see Figure 10.1 below):
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Active Solvent ' SolventA " Solvent B
Figure 10.1: The Active Solvent may be toggled between
Solvent A and Solvent B

Once a Sequence is running or Data is being saved, however,
then the solvent selection function deactivates until the
Sequence has finished or Save Data is switched off:

Active Solvent o O nt B
Figure 10.2: Active Solvent selection is inactive while a
Sequence is running or Save Data is activated

10.4.2 Sample Temperature

Sample Temp. [*C]

/ T arget Actual
B0 ]
a0 a0
40 ]
an an
20 20
5 4]

| 280 = 25.00°C |
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This box allows the user to input and view the system’s
temperature setpoint and to read the measured system
temperature.

The setpoint, or Target temperature, may be entered into the
data entry box beneath the left-hand column labelled ‘Target'.
The desired temperature may be entered directly, or the up
and down arrows can be used to alter the value in increments
of 1°C. The column is coloured red to reflect the numeric
value of the target temperature — remember that a maximum
target temperature of 60°C is allowable in most cases

Note: In some cases, a higher sample temperature is
attainable, depending upon the system incubator supplied
with the DVS unit. In such cases, an SMS Service Engineer
will be required to alter the system .dat file, and then the
control software will display the appropriate sample
temperature range.

The measured, or Actual temperature is indicated in the right-
hand column. Again, the level of red-fill in the column reflects
the figure displayed in the box below it.

This feature is useful for those situations in which the user
wishes to run an experiment without employing a Sequence.
The user may use this box to alter the system temperature at
will.

If the Save Data function is activated (see Section 0), then the
Target temperature may still be altered using the Sample
Temp box.

If, however, a Sequence is running, then the setpoint entry
box becomes inactive — the sample temperature setpoint will
already have been defined in the Sequence itself (see Figure
below). However, the Target column is still important in that it
displays the target temperature being employed by the
Sequence.
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Sample Temp. [*C]

Target Actual
=] B0
0 50
40 40
30 a0
20 20
] ]

Figure 10.3: When a Sequence is running, the Target
temperature setpoint data entry box becomes inactive.

10.4.3 Partial Pressure

, % Partial Pressure
Target Actual

100 100

a0 80

=] =]

a0 40
'''' ) I 20 20

1] 0

foon = | ooz |
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The Partial Pressure box operates in exactly the same way as
the Sample Temperature box. Please refer to Section 10.4.2
for details.

Note: When the Optical Sensor is cleaning itself (ie: a DCC is
active — Appendix E, Section 15), the Target and Actual PP
(%) controls are disabled.

10.4.4 Preheat Temperature

ej -3 Pgeheat Temp. [*C]
i T arget Actual
200 200
— 150 — 150
~ 100 ~ 100
5 5
Fuo Fo

This box displays parameters only, and cannot be used to edit
setpoints.

The Preheat Temp displays the Target and Actual sample
preheater temperatures which are defined in the Preheat
Method file (Section 9.5.1). This display only updates when
the Preheater is running. The Actual preheat temperature is
measured by a thermocouple located within 2cm of the
sample pan.
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Total Gas Flow

s grams s f 200 [scom) v

i

This drop-down menu allows the user to choose the total gas
flow for the system in standard cubic centimetres per minute
(sccm). The default setting for the DVS Advantage is 200
sccem.

The flowrate may be altered by clicking on the value in the
edit box or the adjacent down arrow, which reveals the other
available flowrates:

Total Gas Flow

200 [scom] (W

180 [zcom)
120 [zoom)
100 [zcom)
75 [gcom)

) 11l [22N] I
20 [zoom)
10 [zcom)
0 [zzom]

The Total Gas Flow box allows the flowrate to be set when
there is no Sequence running. If the Save Data function is in
use, the box is still active.
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The box does become inactive once a Sequence is loaded,
however. The flowrate is then defined by that specified in the
Sequence, and is displayed in the Total Gas Flow box:

Total Gas Flow

10.4.6 Optical Sensor Status

This box displays the current status of the Optical Sensor:

Optical Senzor Status

P/

b eazuring: )
DCC Mode;
Hold Mode:

Fauilt:

Measuring:

DCC:

Indicates that the Optical Sensor is online and
actively measuring.

Indicates the Optical Sensor is in Dynamic
Contamination Correction (DCC) mode. This
mode is initiated automatically by the
software or when the “Decontaminate
Sensor” menu item is manually selected by
the user. For more information regarding this
please refer to Appendix E, Section 15 —
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Hold:

Fault:

Optical Sensor Dynamic Contamination
Correction.

Indicates the Optical Sensor is in Data Hold
mode. This mode is entered once the DCC
mode has completed. For more information
regarding this please refer to Appendix E.

Indicates an optical fault with the Optical
Sensor. This mode indicates that the Optical
Sensor needs to be manually cleaned. For
more information regarding this please refer
to Appendix E.

Whenever a state is active, its ‘LED’ is illuminated — otherwise
it remains greyed-out.

10.5 Sequence panel

The Sequence panel shown below shows the settings for the
Sequence that is currently loaded. It displays the series of
Method files that make up the Sequence along with the
Control Mode, Sampling Rates, DMDT Values and Gas Flow
settings that are also saved as part of the sequence file.

Please refer to Section 9.6 for details on creating, editing, and
loading Sequence files.
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" Bynaméc Vagsur Sorpiion - Advaniage
Fle Corfigration Sovenis Method Sequence Calbeation Wideo Hel

LW

Sequence File:
CADNS Advartigahasquanceing] aq

Sedvent Method Filefsl
Sebeet & | | CADVS dchvart ngetvrnshodumetted] s

1
2
2
Il

5
3
7
&
9,

Doty Mo

Sebvent A: | panLosn Sebvent B: | DpsnLocn

biaia Giagh | Intinamsact D1ath | pnmnce | Acties Mathod | Widks | Flun Espavarent | Diagnastcs

St A E T — ]

Also note that when a Sequence is running, the active Method
is highlighted green as shown below:
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4 Dynamic Vapour, Sorption - Advantage

File Configuration Solvents Method Sequsnce  Calibration  Help

oMM

Sequence File

|CADVS Advantage\sequencetsequence test 36 seq ]

Solvent Method File(s):

T SoheA | CDSAdemsmetedpadpssstex ez

2. | Salventa | [CADVS-Advantagemethodipartial pressure test 2.s30

3. | SolvertA | |CADVS-Advantage methodipartial pressure test 3.sa0

4. | Solvents | |CADYS-Advantage method\partial prassure test 4.sa0

5. | Solvent4 | |CADVS-Advantage methodipartial pressure test 5.5a0

Control Mode:

SolventA: | Openloop |  SolventB: | Openloop

| Mass Graph | Instrument Data | Sequence | Active Method | Fun Experimert | Diagnostics|

Stalus: Saving Data... Surface Measuement Systenrs © 2008

In addition, the name and location of the currently loaded
Sequence file is displayed at the top of the panel in the box
labelled Sequence File:

Sequence File:

CADWS-Advantagesequencehseguence test 35.zeq

T~ MR

S g | et e s i Mo | o et | S

[me e e s | e 8 0
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10.5.1 Right-clicking the Sequence panel

Right-clicking anywhere on the Sequence panel calls up the
same list of functions as appears under the Sequence toolbar
option (Section 9.6):

[ o g g e EI-E|

f‘f_ﬁ? £ ew Sequence. ..
T ﬁnad Sequence. ..

5 S Edit Sequence...

Clear Sequence...

When a Sequence is running, however, these options become
inactive, with the exception of Edit Sequence (see Section
9.6.1.3 for more details on editing running Sequences):

/' Edit Sequence. ..

St Mommd S § S0

Note also that while a Sequence is running, the Select
Solvents, Tare Balance and Set Initial Mass buttons at the top
of the panel are rendered inactive — these functions are
specified in the Sequence itself and cannot be ‘manually’
performed while a Sequence is running.
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10.6 Active Method panel

The Active Method panel displays the details for the currently
active method of a running Sequence.

The active Method may be either a Preheat Method (Figure
10.4), a Partial Pressure Method (Figure 10.5) or the special
sensor cleaning method Clean.dcc. The display updates
according to what type of method is active.

o Slat Teep[T) Stop Temp '] Tine jrun |

Maximum Time Hemaining: 00 Dy 02 Houns 59 Min. 55 Sec. | 00 Doy 02 Hours 59 Min. 55 Sec. | 00 Days 02 Hours 53 M 55 Sec. |

Matt Grigh | Instument Dita | Sequence || Acti pthod | Video | Run Experinent | Disgnathies |

Sustace Meansement Systems & 2000

Figure 10.4: The DVS Control software Active Method panel
showing an active Preheat Method running.
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PELY

[ictod Sroges | Methad Semega |

Waxinwum Vi fluminive: [ 00 Days 00 Ficuas 14 Min 54 Sec: | | 00 Doy 00 Hours 14 Min. 54 Sec 00 Diays 00 Houey 14 Min. 34 Sec. |

Matt Graph | Inatiurrent Dath | Seouence | Artve Methed | Video | Fun Dxperiment | Disgrater
Sishar: Saving Datn_ Surface Meammmert Syatems © 2000

Figure 10.5: The DVS Control software Active Method
panel showing an active Partial Pressure Method running.

10.6.1 Active Method graph

The Active Method graph for Preheat, Partial Pressure and
DCC Methods displays the profile of the current method as a
function of time.

Each method stage is colour coded, to give a visual indication
of how far the method has progressed.

263



DVS Advantage Operation Manual

Preheat Methods
The current active stage is shown in green, future stages are

shown in red and completed method stages are shown in light
red, as shown below:

Time (min.]

Partial Pressure Methods
The current active stage is shown in green, future stages are

shown in dark blue and completed method stages are shown
in light blue, as shown below:

Partial Pressure (%)
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10.6.2 Active Method table

The Active Method table displays the details of the Method'’s
Stages as specified in the New Method toolbar option (see
Section 9.5.1.1).

In addition, the active Stage of the Method is highlighted
green, as shown below:

Mias Gigh | Intinasant Dita | Gaauincs |
s gD Suslacn M s rrnert Systners © 2008

Stagel  : | StegeType | Timelmin) St %PFa | StopxPPo | Templ(D) |

-
r
I
r
I
r
I
=
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10.6.3 Maximum Time Remaining
These boxes indicate the time remaining until the end of the
active Sequence, Method and Method Stage:

Active Sequence Active Method Active Method Stage

Maximum Time Remaining: | 00 Days 01 Hours 43 bin. 51 Sec. | | 00 Days 00 Hours 13 Min. 51 Sec. | | 00 Days 00 Hows 01 Min. 51 Sec.

10.6.4 Right-clicking the Active Method

panel

Right-clicking anywhere on the Active Method panel calls up
the same list of functions as appears under the Method
toolbar option (see Section 9.5):

Preheat r
Partial Pressure »




DVS Advantage Operation Manual

When a Sequence is running, these options remain active, as
shown above.

10.7Video Panel

The Video panel allows the user to take manual snapshots of
the sample using the system'’s digital camera. The panel also
displays the current snapshot and picture settings, as well as
allowing the user to open previously saved pictures:

PR

Pastovercn Setings
Automanc Videa Mode.
Timedt Irtweva: 1 riruefs)

Snspnd Overlay Sbigs
Tarye! % P Achua Temgeachin

Sranthal Inags Faenst
e

Advanced Snapahot Setings

Mrsgleny Scde Moy K0
ScoeMukes Larghe 2 00mn
Doy U Gired. L

Drvey Grid Wi J00 e
ey Gnd Heght: & 00

e

Mids Giah ) Hsthod | Vickeo Disgraaties
Stbus Al Surlicn Minscuarrned e © 7008

10.7.1 Take Snapshot
Clicking the Take Snapshot button allows the

user to manually save a snapshot of the sample when data is
not being saved.
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Clicking the button calls up the Enter Video Image Filename
window, which prompts the user to save the image under the
desired filename:

Enter, ¥ideo Image Filename E|E_<|

Savein: | () data M Qe E-
Y |Sicalibration
:3 &) sample - Fri 26 Sep 2008 09-04-22_1,BMP

MyFecent | [2L]sample - Fri 26 Sep 2008 09-04-22_2 BMP
Documents  [El)sample - Fri 26 Sep 2008 09-04-22_3.EMP

?—-% &) test1.bmp

Desktop

i}

My Documents

o

My Computer
‘:‘] File name: hd
D
My Metwark Save as type: EMP Files [*. bmp) w

Note: The file will be saved in the format specified in File —
Preferences — Video.

In addition, the Enter Video Image Filename window will
automatically open at the same location as where the DVS
data files are saved. The location of the picture files may of
course be changed using the Save In drop-down menu at the
top of the window.

Once a filename is entered and the Save button is clicked, the
Video panel shows a ‘please wait’ message before displaying
the newly recorded sample snapshot:
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Yy

The recorded picture’s top left-hand corner displays the date
and experimental data according to set Preferences (see
Section 9.2.1.3). In the bottom left-hand corner is displayed
the directory location to which the picture was saved, and the
filename (with extension).

This data appears to be very small when displayed on the
Video panel. However, these images are high-resolution, and
as such, are meant to be viewed ‘up close’ in a picture-
viewing program. When the picture is viewed at a zoom of
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100% (ie; the ‘normal’ picture size), the data is clearly
displayed.

Note: Whenever the software is started up, the Video panel
will be blank until a snapshot is taken. From that point on the
panel will display the most recent snapshot until the DVS
control software is shut down.

Additional Note: Whenever data is being saved (ie; when
running a Method or when simply saving data), the Take
Snapshot button becomes inactive.

If images are to be taken while saving data, it must be done
through either the Method settings or according to a regular
time interval. Which of these approaches is used may be
selected in File — Preferences — Video — Automatic
Snapshot Operation Mode (see Section 9.2.1.3).

10.7.2 OpenlImage
Clicking the Open Image button allows the user

to open the image most recently recorded and displayed in
the Video panel.

Opening the image allows the user to see the picture full-size,
and to take advantage its high resolution — it is possible to
zoom in close to the sample picture and discern a greater
amount of detail.

Note: The image will be opened using the picture viewer set
as default in the control computer's windows operating
system.

Clicking Open Image immediately calls up the image
displayed in the Video panel:
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The picture viewer may then be used to zoom in to see the file
at 100% of its normal size (the magnification shown above is
62%). In the example shown above, the default picture
viewer in use is Microsoft Office Picture Manager ©
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Note: The Open Image button remains active even when
data is being saved so that images may be examined as they
are taken throughout the data-saving process.

10.7.3 Preference Settings

j ference Settings

Avtornatic Video Mode:
Timed Intersals: 1 minute(z).

Snapshot Overlay Settings
Target % P/Po: Actual Temperature

Shapzhot Image Format:
BHP

The Preference Settings box on the Video panel displays
the image preferences selected in File — Preferences —
Video (see Section 9.2.1.3).

10.7.4 Advanced Snapshot Settings

Advanced Snapshot Settings

Dizplay Scale Marker: MO
Scale Marker Length: 2,00 mm

Display Overlay Grid: MO
Overlay Grid %idth: 3.00 mm
Ovwerlay Grid Height: 4.00
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The Advanced Snapshot Settings box on the Video panel
displays the image settings selected in Video — Advanced
Snapshot Settings (see Section 9.8.2).

10.8 Run Experiment panel

The Run Experiment panel is used to configure a DVS
experiment:

* Bynamé Vapsur Sorption - Advaniage
Fle Corfigration Sovents Method Sequence Calbeastion Wleo Hele

@ 45 ls

Sielected Data Disectoy:
CADVS Advartagahciuty

[ Selnctnd Rackup Dasctory: optionsl]

Sanple Homn: o s gt 20 et |

Sampls Dasripion: gt 100 chase |

Run Sequence  Save Data Only
and & ave Datn

d

Miais Giagh | Intinamsark D1ath | Gmatmcas | Acties Mathod | Vidhs | Flun Euquimers | Dibgnatcs

St el E T — ]

An experiment may be configured by following the steps
outlined below:
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Step 1:  Select the Data Directory

il |

Selected DataDirectony:
C:ADYS-Advantagedata

This directory specifies the location to which the raw data files
from the DVS experiment will be saved.

This should be set to a directory location on the local PC
attached to the DVS instrument rather than a network
directory so that network connection failures do not affect the
running DVS experiment.

The directory displayed automatically is the one specified in
the Preferences toolbar option (see Section 9.2.1.2). The
software is supplied with the following Preference specified by
default:

C:\DVS-Advantage\data
To choose a different directory, click on the _| button at the

end of the Selected Data Directory box — the following window
will appear:
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Browse For, Folder, @

Select DWS Data Directory

[T Data ~
-5 DELL
I25) Documents and Settings
1) download
|5 DRIVERS
(23 DvS Adv+
= |3 DYs-Advantage

15) config

10 data G
< T >
[ Make Mew Folder ] [ Ok ] [ Cancel ]

Upon selecting the desired folder and clicking OK, the newly
specified directory appears in the Selected Data Directory
box.

Step 2:  (Optional) Select the Backup Directory

I~ Selected Backup Directory: [optional)

r

This option specifies the backup directory to which a copy of
the raw data files will be stored once the DVS experiment has
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completed. This option should be set to a directory location on
the network.

This option may be used to ensure that the DVS experiment is
not interrupted by a network connection failure.

In order to activate the Select Backup Directory option, the
tick-box next to the section header must be clicked:

v Selected Backup Directonr optional)

Selection of the Backup Directory works in the same way as
for the Data Directory, as shown above.

Delete original data file after successful backup operation:
If the raw data file backup operation is successful and this
option is selected, all raw data files produced by the
current DVS experiment that were saved to the Data
Directory (as specified in Step 1) are deleted.

¥ Selected B ackup Directony [optonal)

@ete original data file after successful backup Dp@

This option is also activated using a tick-box:

Note: If the backup operation is unsuccessful, the raw data
files will not be deleted from the Output Directory, so that the
DVS data will never be lost.
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Steps 3 & 4: Enter Sample Name & Enter Sample
Description

Sample Name: [max length 30 chars.]

Sample Description: [max length 100 chars.)

Enter Sample Name
Enter the name of the sample being tested. The maximum
length of the name that may be entered is 30 characters.

Enter Sample Description

A detailed description of the experiment may be entered in
this field. The maximum length of the sample description is
100 characters.
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Step 6: Start the experiment
To start the experiment, simply click one of the following

Run S equence and SaveDataOnly
Save Data

Run Sequence and Save Data

Clicking this switch starts running the loaded sequence and
saving DVS raw data to the Output directory. Clicking this
option illuminates both buttons green:

Fun 5equence and Save DataOnly
Save Data

IR
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Save Data Only

Clicking this switch starts saving DVS raw data to the Output
directory. This mode allows experimental conditions to be
modified without running a Sequence.

Note: The filenames of the raw data files produced by a DVS
experiment are automatically created by appending the date
and time to the sample name.

Eg: Sample Name = SampleX

If a DVS experiment is started at 10:49:32am on Wednesday
the 19" of November 2006, the DVS raw data file created will
be named:

SampleX - Wed 19 Nov 2006 10-49-32.dat

10.9 Status Bar

QLBO0ONP T R

Mazz Graph | Instument Data | Sequ

Statuz: Ready...
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The status bar is located in the bottom left hand corner of the
DVS Advantage interface. Once the system is saving data the
status bar text will change from Status: Ready to Status:
Saving Data. When saving data the text will also flash to
indicate that saving data is active.

10.10 Diagnostics Panel

* Bynamé Vapsur Sorption - Advaniage
Fle Configration Sovents Method Sequence Calbeation Video Help

@ 45 ls A

Timn Rnmaising ToAuto DEL 01 Finn 54 M, 4 G gt PP om

Stanus Outout g | 05071 450440 SOTSE 1E1 ST 0T

[ o s Tasget Wet Flowhicon). 0100
o £l
Target Fibn Thochress 15 et PP (13
skl i, Tricknmes: 100 : Akl Do Pt )
e P Gt S Akl Garnghe Tevp: | BAUE
Do Pt =7

Enbierd Tewg 1488 Siah
Hisl Purm Dageessiny w5 Dabance - s Mo Ourpnd

Vi Gtagh | Intinmaed Data | Gapsves | Action Mathod | Vicks | Plun Eiqubirnant | [rneponi

St el E T — ]

The Diagnostics Panel, shown above, displays various data
relating to the system’s Dew Point Analyser (which measures
the system partial pressure), Eurotherm control computer, and
the system balance itself.

This panel is designed to provide information required by
SMS Service Engineers when working with the DVS
Advantage.

Incidentally, some of the DPA data displayed on this panel is
also saved into the DVS raw data file when data is saved:
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Note: The Diagnostics panel is only visible if the menu option
Configuration>Diagnostics Tab Visible has been checked.

See Section 9.3.5.

P Y- EO P LI e T T T |

EEmg A e
camimoleeuik=02%0

1DPA DCC Status | DPA Dew Point DPA Ambient Temp.  DPA Status

DPA Heat Pump Depression

MEASURING
MEASURING
MEASURING
MEASURING
MEASURING
MEASURING
MEASURING
MEASURING

hAE A ST

Again, this information is relevant for SMS Service Engineers
when saving data to check the system’s performance.
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149.8 CONTROLLING
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149.8 CONTROLLING
149.8 CONTROLLING
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11 Appendix A — Instrument
Specification

Model

DVS
Advantage 1

DVS
Advantage 2

DVS
Advantage 2

Low Range

High Range

Sample capacity 1.5¢g 10g 100g
Dynamic range 150mg 19 10g
Minimum sample

weight img 10mg 100mg
Sensitivity 0.1ug 1ug 10 pg
Sample pre-heater | oo, 50000 | 25%-2000C | 25%- 200°C
temperature

Temperature 5 - 60°C 5 - 60°C 5 - 60°C
range

Humidity range 0 — 98%RH 0 — 98%RH 0 — 98%RH
Humidity +1.5% +1.5% +1.5%
accuracy

Vapour

concentration 0—98% p/p 0-—98% p/p 0 —98% p/p
range

Vapour pressure o o o
accuracy +1.5% p/p +1.5% p/p +1.5% p/p
Gas Flow Rates 0 — 200 sccm 0—200sccm | 0-—200 sccm

* Current temperature setting for oven.
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12 Appendix B — Salt Validation
Calibration.

A DVS Salt Validation module allows the user to verify that
the system’s Mass Flow Controllers are accurately generating
the desired partial pressures.

In short, the calibration verifies that the partial pressure levels
in the DVS are what the instrument says they are.

Performing Salt Validation Calibrations is important as
accurate measurement of partial pressure is absolutely
essential to the working of the DVS instrument.

With no accurate idea of the partial pressures being
generated in the DVS, any results generated by the
instrument become meaningless.

Note: It is recommended that Salt Validation Calibrations are
carried out at least every six months.

12.1 How to perform a Salt Validation
on the DVS

The calibration is based upon the principle that the vapour
pressure above a saturated salt solution in equilibrium with its
surroundings is a constant at a particular temperature.

The procedure also involves using a module included in the
DVS Standard Analysis Suite software. Please refer to the
Standard Analysis Suite Manual for information on how to
operate the relevant module for salt validation.
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12.1.1 Salt solution

The first step in the procedure involves preparing a small,
saturated salt sample. This is done by placing approximately
20-30mg of test salt in a sample pan adding drops of de-
ionised water until a slush or paste is formed.

12.1.2 Choice of Salt

Several different salts can be used for the calibration; Table 1
below lists five salts commonly used to validate the DVS
partial pressure generation:

Salt Water %p/p, at Water %p/p, at
25C 40 C

LiCl 11.3 11.2
MgCl, 32.8 31.6
MgNO; 52.89 48.42
NaCl 75.3 74.7
KNO; 93.7 89.0

Table 1: Salt p/p, values for calibration Saturated salt
deliquescence points [1]

It is recommended that at least three salts are used which
cover the full range of partial pressures — this ensures a
comprehensive system validation. For example, it would be
advisable to use LiCl, MgNO;, and KNO3 to cover the full
range of partial pressures.

12.1.3 Temperature

Next, the water vapour partial pressure above the solution
must be measured. This can be done at 25°C or any other
desired temperature between 10C and 50C. It is
recommended that a temperature is chosen which is closest
to the one commonly used in experiments.
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12.1.4 Method

To execute the validation, a method must be set up which
begins at a partial pressure approximately 5% above the salt
solution partial pressure. For example, if using MgNO; at
25 C, the method would start at around 58% p/p, (ie; 5%
above 52.89%). This first stage would need to last for one
hour.

Following this, the partial pressure needs to be ramped down
to 5% below the salt partial pressure (ie; 10% below method’s
initial p/po). This ramp should take place across 300 minutes.
In the case of MgNO; at 25 C, this would mean ramping down
to 48% p/po.

Finally, the ramp needs to be reversed, going back up to the
starting partial pressure. Again, this occurs across 300
minutes. In the case of MgNO; at 25 C, this would mean
ramping back up to 58% p/p,.

The partial pressure profile that could be used for MgNO; at
25 C is shown below in Figure 12.1:
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" Partial Pressure Method Editor, |X|
File Edit Insert

Method Stages | Method Settings |

Partial Pressure [%)

I | | !
356 462 528 594

Tirme [min.]

Stage# ¢ | Stage Type | Time(min) | dm/dt(%/min)| Stat%P/Pa| Stop%P/Po|  Temp['C)
1 Time: E0.0 5a.00 58.00 25.00

2 Tirne: 200.0 _ 5500 45.00 2500
3 Time: 300.0 _ 43.00 2500

58.00

Figure 12.1: The proposed partial pressure profile for a salt
validation using MgNO; at 25 C.

Once this method has been run, the data may then be
analysed using the Salt Validation module.

12.1.5 Results

At the point where the DVS-generated %p/p, is equal to the
%p/p, above the saturated salt solution, the rate of change of
mass with partial pressure (dm/d(%p/p,)) of the salt solution is
zero. At this point, the DVS-generated %p/p, is the saturated
salt literature value — irrespective of what the partial pressure
sensors are reading.

By plotting the target %p/p, vs. dm/d(%P/P,) as shown in
Figure 12.2 and finding the intercept where dm/d(%p/p.) = O,
the generated %p/p, can be calibrated against the actual
partial pressure above the saturated salt solution at this
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temperature - thus enabling the user to validate the accuracy
of the instrument’s partial pressure sensors.

»
>

[

-

dm/d(%P/P,) = 0 Satd

partial
pressure

of salt
solution

%PIP,

Change in mass (%)

dm/d(%P/P,) = 0

time
Figure 12.2: dm/d(%p/p,) is zero at the saturated partial
pressure of the salt solution
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13 Appendix C — References

[1] L. Greenspan, Journal of Research of the National Bureau
of Standards-A, vol. 81A (1), 1977, 89-96.
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14 Appendix D — Solvent Lookup
Table

Note: Only qualified service engineers should ever change
the Solvent Lookup Table values.

Note: The Solvent Lookup table is only in effect when the
DVS Advantage is running in OPEN LOOP mode.

Note: This information is provided for informational purposes
only.

The DVS uses Mass Flow Controllers (MFC'’s) to flow gas
through the DVS Advantage system to produce the desired
Partial Pressure. In order to generate a certain partial
pressure (PP), one of the MFC's flows a percentage of dry air
(called the Dry Flow) into the DVS system while another MFC
flows a certain percent of solvent into the system (called the
Wet flow). The sum of the two flows adds up to 100%.

eg: Say the desired Partial Pressure is 40%. The Wet Flow
MFC produces 40% of wet air and the Dry Flow MFC
produces 60% of dry air to produce the desired 40% PP.

MFCs may slightly over- or under-generate the amount of gas
flow they are requested to produce. This means that the
system may be asked to produce 40%p/p, but the system
actually produces 42%p/po.

The DVS system automatically overcomes this by using the
Solvent Lookup Table to slightly adjust the requested gas flow
rates of the MFCs to ensure correct generation of the partial
pressure.

SMS service engineers alter the Solvent Lookup Table during

the calibration process. In the DVS Advantage each solvent
has its own partial pressure lookup table.
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The lookup row used in the table is based upon the Sample
Temperature and the Total Gas Flow setting.

Lookup Example:

Assume that the DVS Advantage system is operating under

the conditions listed below:

e Requested Partial Pressure = 58%.

e Sample temperature = 25 °C

e Total Gas Flow = 150 sccm

e The Solvent Lookup Table has the settings in the

figure below:

Solvent Lookup Table Editor

X

o JoPIP, LOOKUpP Cotumn B
Partial Pressure Tablefor | WATER |
' \ /plp, Lookup Col
TQI\’\Q Flow 0.00 10.00 20,00 30.00 4000 s000 co.of” 70.00 80.00 90.00 98.00
20 100 0.00 10.00 2000 3000 40.00 50.00 BO.00 7000 80.00 90.00 98.00
20 150 0.00 10.00 20.00 30.00 40.00 50.00 £0.00 70.00 80.00 90.00 98.00
20 200 0.00 10.00 20,00 30.00 40.00 50.00 E0.00 70.00 80.00 90.00 98.00
30 100 0.00 10.00 20.00 30.00 40.00 50.00 £0.00 70.00 80.00 90.00 98.00
FIOW \\NKTED 0.00 10.00 20,00 30.00 40.00 50.00 E0.00 70.00 80.00 90.00 98.00
/3[| 200 0.00 10.00 20,00 30.00 40.00 80.00 90.00 98.00
/ 40 100 0.00 10.00 20.00 30.00 40.00 80.00 50.00 38.00
Temp / 40 150 0.00 10.00 20,00 30.00 40.00 80.00 90.00 98.00
40 200 0.00 10.00 2000 3000 400 80.00 90.00 98.00
50 100 0.00 10.00 20.00 50.00 £0.00 ] 80.00 90.00 98.00
50 150 0.00 10.00 20,00 40.00 50.00 E0.00 70. 80.00 90.00 98.00
50 200 0.00 10.00 20.00 40.00 50.00 £0.00 70.00" 80.00 90.00 98.00
B0 100 0.00 10.00 20,00 40.00 50.00 E0.00 70.00 80.00 90.00 98.00
B0 150 0.00 10.00 20,00 40.00 50.00 B0.00 F0.00 0.00 90.00 98.00
B0 200 0.00 10.00 2000 40.00 50.00 E0.00 70.00 a0\00 90.00 98.00

umn A

Interpolation Cell B

Figure 14.1: Solvent Table Editor panel
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Step 1: Find the correct lookup row in the table:
This is a two stage process:

Locate the Temp:
Starting from the top row in the table, find the row with
the first temperature value that is greater than the
sample temperature.

Note: If there is no Temp greater than the sample
temperature the maximum temperature is used.

Result = 30 °C.

Locate the correct Flow (nb: The Temp is the same value
found in step 1):
The lookup row is the row with the correct
temperature found in step 1 and a flow value that is
greater than the current Total Flow rate.

Note: If there is no flow greater than 200sccm so the
max flow is used.

Result =200 sccm

We now have located the correct lookup row: Temp =
30°C and Flow = 200.

Step 2: Identify the Partial Pressure Lookup Columns A
and B

Using the lookup row found in step 1, PP Lookup Column
A is identified by the Column Header that has a value
greater than the Requested Partial Pressure.

PP Lookup Column B is the column to the immediate left
of Column A.
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Note: If no partial pressure column header is greater than
the requested partial pressure then the very last partial
pressure column is used as PP Lookup Column A.

Result = PP Lookup Column Header A value = 60.0
PP Lookup Column Header B value = 50.0

Step 3: Identify Interpolation cells A and B: (These values

292

are used in later calculations)

o If PP Lookup Column A was found in step 2
above.

Interpolation Cell A:
Row: Temp = 30 °C, Flow = 200
Column: PP Lookup Column A = 60.0
Cell Value = 59.90

Interpolation Cell B: located on the same row as Cell
A, but is found in PP Lookup Column B.

Row: Temp = 30 °C, Flow = 200

Column: PP Lookup Column B =50.0

Cell Value = 49.90

e If the PP Lookup Column was NOT found in step 2
and the very last partial pressure column is being
used the Target Partial Pressure lookup cells are:

Target PP Lookup Cell A:
Row: Temp = 30 °C, Flow = 200
Column: PP Lookup Column A = (last
column)
Value = cell value at the location specified by
the above row/column combination

Target PP Lookup Cell B: Not used
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Step 4: Calculate the Actual PP Delta value:

If the PP Lookup Column A was found in step 2, then the
Actual PP Delta value can be calculated.

The Actual PP Delta value is the difference between the
PP Lookup Column A header value (60.00) and the PP
Lookup Column B header value (50.00).

Note: If the Partial Pressure Lookup Column A was not
found in step 3, the Actual PP Delta value is set to zero.

Result: 50.0 - 40.0
Actual PP Delta=10.0

Step 5: Calculate the Requested PP Delta value

The Requested PP Delta value is the difference between
the Requested Partial Pressure (58.0) and the PP Lookup
Column B Header value (50.00).

Result =58.0 - 50.0

Requested PP Delta = 8.0

Step 6: Perform Interpolation and Adjustment

Which calculation is performed here depends if the
Requested Partial Pressure Column was located in step
3.

a. |If Partial Pressure Lookup Column A was found in
step 3:

Calculate the interpolation value: the difference
between Interpolation Cell A and Interpolation Cell B
from step 3.

Result =59.90 - 49.90
Interpolation value = 10.00
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Calculate the adjusted partial pressure according to
the following formula:

Adjusted PP = Interpolation Cell B + (Requested PP Delta *
Interpolation value) / Actual PP Delta

Result =49.90 +[ (8.0 *10.00)/10.0]
Adjusted PP =57.90

b. If the Requested Partial Pressure Column was not
located in step 3:

Calculate the adjusted value according to the
following formula:

Adjusted PP = Target Partial Pressure Lookup A + PP Delta
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15 Appendix E — Optical Sensor
Dynamic Contamination
Correction

To alleviate the problems of measurement accuracy due to
contamination the Optical Sensor has a contamination
compensation process called Dynamic Contamination
Correction (DCC).

A DCC consists of 2 stages:

1. DCC stage: During this stage the mirror surface is
heated to remove contamination and the DCC LED on
the DVS Advantage software interface is illuminated.

2. Hold stage: During this stage the system stabilises
onto the active dew point and the HOLD LED is
illuminated.

Note: The FAULT LED may be illuminated after a DCC has
completed. This indicates that the mirror needs to be cleaned
manually. See the Optical Sensor Maintenance section below

Optical Sensor Maintenance — Manual Cleaning

Clean the mirror surface and optics window using a cotton
bud soaked in distilled water. If the sensor has been exposed
to oil based contamination then use one of the following
solvents instead of distilled water: (methanol, ethanol, or
isopropyl alcohol).

When does a DCC occur?

e A DCC operation may be started manually by
selecting the Calibration>Decontaminate Sensor
menu item in the DVS Advantage software.
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A DCC will automatically occur whenever power to
the DVS Advantage Electronics box instrument is
switched on.

A DCC will also automatically occur at regular
intervals when the DVS Advantage software is
running. The interval rate is defined in the
DVSAdvantage.ini file by the AUTO_DCC_MINS
value. This value should only be changed by a
qualified SMS service engineer.

You may also load a DCC method as part of a
sequence:

In order to keep the Optical Sensor reading accurate
we strongly recommend that you perform a DCC
cycle prior to running a method. To do this you can
simply load the “Clean.dcc” method that can be found
in your DVS Advantage method directory into your
sequence before the method that you wish to run.

Note:

It is STRONGLY recommended that a Clean.dcc

Method be run before each new partial pressure method in a
sequence.
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16 Appendix F - Process for setting
up new organic solvents in the
DVS Advantage

16.1 Background and overview:

The DVS Advantage can work in two modes as far as vapour
generation is concerned: closed or open loop. In closed loop,
when the user asks for say, 30% Partial Pressure (pp), the
mass flow controllers (MFCs) will initially provide 30% ‘wet’
flow, 70% ‘dry’ flow. The Dew Point Analyser (DPA) will then
measure the actual value of the partial pressure generated,
and feed this back into the software which will then
automatically adjust the requests made to the MFCs, and the
process repeated until 30% is measured by the DPA. In open
loop mode, the process is the same, with the distinction that
the DPA measured pp value is not fed back into the software
for the purpose of making adjustments, such that asking for
30% pp will result in the MFCs generating 30% wet flow and
70% dry flow. The value is still recorded in the data file for
the experiment, but no adjustments are made by the software
based on its value.

In the open loop system, to compensate for variance from
ideal mixing and the volume of the solvent vapour of high
vapour pressure solvents, a partial pressure table is used by
the software. In essence this acts as an offset function; at
lower %p/po values where the generated %p/p, is likely to be
higher than the requested %p/p,, the offset will be negative; at
higher %p/po where the generated %p/p, is likely to be lower
than the requested %p/po, the offset will be positive. The
value that the user inputs into the software is hereafter
referred to as ‘user requested value’ the latter value from the
partial pressure table is referred to as ‘software requested
value’.
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Whilst for water, being a relatively low vapour pressure
solvent, the offsets are relatively minor, for solvents with
higher vapour pressures, such as Dichloromethane, the offset
may be of the order of 5-10 %. i.e; at a requested %p/p,y of,
say, 10%, without use of this table the instrument will
generate of the order of 15% depending on conditions. The
%p/po table would be set up such that when the user requests
10% (user requested value) the software in fact requests 5%
(software requested value), with the end result that 10% is
generated. More importantly than the size of the offset is that
for new solvents, this table has to be set up.

It is also worth mentioning at this point the effect of flow rate
on the absolute pp value. Although the influence of flow rate
is likely to be subtle, it should however be considered if one
intends to use a completely rigorous approach. Especially
with high vapour pressure solvents, higher flow rates will
increase the effect of evaporative cooling. This in turn will
affect the saturated vapour pressure, as the temperature of
the solvent will be slightly decreased, which in turn will affect
the actual vapour pressure obtained.

The offset that is required in Open loop mode, and the pp
feedback that occurs in closed loop mode both rely on the
values of the pp that are obtained from the DPA. The DPA
however, provides a temperature value, namely the dew point
of the gas/solvent vapour mixture. The software calculates
the pp from the dew point using the following equation:

In(p) = Cy + Co/T + Csln(T) + C,T

Where:
p = partial pressure in Pa,
T = dew point temperature in Kelvin, and
C..s are 5 constants unique to the solvent.
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The value of these constants can, for the most part be found
in Table 2-6, Perry’'s Chemical Engineer's Handbook, 7"
Edition, 1997, Eds: Robert H. Perry, Don W. Green, Pub:
M°Graw Hill.

In the event that your solvent is not listed within this book, you
will need to obtain data points on the Temperature/saturated
vapour pressure curve, and then fit this to the above equation
to obtain values for the constants. Please contact the
Application Science department of SMS in the UK office if you
require help with this curve fitting.

16.2 Procedure

The procedure for setting up the partial pressure table for new
solvents is as follows, note that this is only required if working
in Open Loop mode:

1. Obtain the 5 constants either from curve fitting
software and an appropriate data set of
temperature/saturated vapour pressure, or from
Perry’s handbook.

2. (Refer Section 9.4.2)
Bring up the Edit Solvents panel by clicking on
Solvents -> Edit Solvents. Click on the New
Solvent button (the left of the two buttons) and
complete the name and the 5 constants fields. Click
Done.

3. Set up and run an experiment using that solvent. This
is not absolutely necessary but will provide an idea of
the magnitude of the changes to be made, and also
serve as a check that the set of 5 constants used are
giving sensible results.
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300

When the experiment is finished, plot a graph of Time
versus Actual and Target partial pressure, using the
Custom Plot function of the isotherm macros within
the DVS Analysis Suite.

Open the partial pressure table by clicking on
Calibration - Solvent Lookup Table Editor.

The partial pressure table is constructed with user
requested values of the partial pressure along the top
row, in increments of 10%, Temperature in the first
column from the left, in increments of 10°C, and flow
rate in the second column from the left in increments
of 50 sccm (see Figure 16.1). The main values of the
table correspond to the temperature and flow rate as
the first two columns to the left; the remaining
numbers correspond to the actual values requested
by the software when the values at the top of the
column are input as target %p/po. In order to make
effective changes to this table, values need to be
entered for both the temperature below and
temperature above that at which you intend to work,
and also at the different flow rates the you are likely to
use.
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Solvent Lookup Table Editor @

=

N User-reﬁuested %pl/po values
'aitial Pressure Table for. v v

Temp

20
20
20
30
30
30
40
40
40
50
=il
50
&0
B0
B0

— —
Flo 0.00 10.00 2000 30.00 40.00 50.00 E0.00 70.00 20.00 40.00 3800 J
100 10.00 0.00 000 4000 50 E , § g §§

150

2000 30.00 40.00 50.00 £0.00 70.00 20.00 40.00 3300
200 e o 3000 4000 50.00 E0.00 7o.00 a0.00 40,00 9200
100 000 1000 aonn annn Rnnn 60.00 7000 a0.00 30.00 9800
150 0.00 10.00 g £0.00 70.00 20.00 40.00 3800
200 000 1000 2000 3t Box A 60.00 7000 80.00 90.00 9800
100 0.00 1000 2000 3000 4000 50.00 E0.00 0.00 20.00 90.00 9200
150 0.00 10.00 2000 30.00 40.00 50.00 £0.00 70.00 20.00 40.00 3800
200 0.on 1000 2000 3000 4000 50.00 60.00 000 a0.00 30.00 9800
100 0.00 10.00 2000 30.00 40.00 50.00 £0.00 70.00 20.00 40.00 3300
160 0.00 1000 2000 3000 4000 50.00 E0.00 7o.00 a0.00 40,00 9200
200 000 1000 2000 3000 4000 50.00 60.00 7000 a0.00 30.00 9800
100 0.00 10.00 2000 30.00 40.00 50.00 £0.00 70.00 20.00 40.00 3800
160 0.00 1000 2000 3000 4000 50.00 E0.00 70.00 a0.00 40,00 5200
200 000 1000 2000 3000 4000 50.00 60.00 7000 a0.00 90.00 9800

Figure 16.1: The Solvent Lookup Table Editor

For example if you were working at 25°C, at a flow
rate of 200 sccm, you would need to ensure that the
correct values were entered at both 20 and 30°C and
at the flow rate of 200 sccm. At the very least
changes made at one temperature should be mirrored
at the other temperatures.

It is possible to measure the changes in real time,
rather than shutting down and restarting the system to
see the effect of any changes. This speeds up the
process considerably.

This step refers to changing the numbers within the
cells of the table. The cells in box A correspond
respectively to the software requested values
corresponding to a user requested values of 0%, and
10% at 20°C and a flow rate of 150 sccm. Obviously
for the value for 0%, the instrument will never be able
to generate less than that value, so this value in the
left cell of Box A will always remain at 0%. To correct
the value next to it, currently set at 10 %, refer to the

301



DVS Advantage Operation Manual

10.

11.

value obtained in the actual/target PP plot for a target
%p/p, of 10%. Subtract the target %p/p, from the
actual %p/po value to give the difference between the
two values; subtract this difference from 10 and enter
this value into the cell. For example, if in your
experiment when the target pp was 10%, the actual
%p/po value was 13%, the number to enter into the
cell within the table is 7.

Close the Solvent Lookup Table Editor, saving any
changes if prompted, and return to the real time
measurement window. Give the instrument a few
minutes for the new values to take effect and reach
equilibrium, then take note of the new value and use
that to fine tune the value input into the partial
pressure table- a further iteration may be required.

Repeat this process for all cells within the range 10-
98. It may not be possible to quite reach the
maximum value of the pp depending on the solvent in
guestion due to evaporative cooling.

Set up and run another experiment using the solvent,
to act as a check for the values entered.

Your table should now be set up and your new solvent values
entered correctly.
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17 Appendix G - Software
Installation/Removal

17.1 Software Installation

Prior to installation, the user must ensure that the computer
system meets the minimum system requirements (Section 5).

The software installation procedure consists of the 2 steps
listed below:

17.1.1 Installing the DVS Advantage
Software

1. Insert the DVS Advantage Software CD into the CD-
Drive.

2. Browse to the Control Software folder on the
installation CD.

3. Double click the Setup.exe file and the following prompt
will appear:

DVS Advantage Control Software Setup

:.‘?/ To start DVS Advantage Control Software Setup, click ©K. To quit without installing, click Cancel.

Cancel |

4. Click the OK button to start installation of the DVS
Advantage Control Software.

5. The installation wizard will then perform a check to see
if Microsoft .NET Framework v1.1 is installed.
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6. If the installation wizard detects that Microsoft .NET
Framework v1.1 is installed then the process will
immediately proceed to step 13.
If the installation wizard detects the Microsoft .NET
Framework v1.1 is NOT installed the following steps will
occur:

Microsoft .NET Framework 1.1 Setup

7. Click the Yes button.

8. The Microsoft .NET Framework v1.1 License
Agreement confirmation panel will then appear:

& Microsoft .NET Framework 1.1 Setup E“E|E|
.- | || License Agreement
Ed
M |Cr050'ft - (& copy of thisz license is svailable for printing at
hittp:fizo microsoft corfelink?LinkId=12283 )
b SUPPLEMENTAL END USEER
| LICENSE AGEEEMENT FOR
v

WATTROSTOET O ETW ARTE

| hawe read, understood and agree ta the terms of the
End User License Agreement and so signify by clicking
I "l agree" and proceeding to use this product.

" | donaot agree

Install Cancel

9. Select the “l agree” option and click the Install button.
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10. The installation wizard will then install the .NET
framework.

11. Once the installation of the .NET Framework has
completed the following notification will appear:

i% Microsoft .NET Framework 1.1 Setup |:||E| X

Inztallation of kicrozoft MET Framewark 1.1 iz complete.

12. Click the OK button.

13. The DVS Advantage Control Software Setup Wizard will
then appear:
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i DVS Advantage Control Software E”E|E|

Welcome to the DVS Advantage Control Software ‘;.,
Setup Wizard ‘.

The installer will guide you through the steps required to install the 0VS-&dwvantage Control Software
O YOUr Computer.

WwiARMIMG: This computer program is protected by copyright lawe and international treaties.
Unauthorized duplization or distribution of this program, ar any partion of it, may result in severe civil
or crimingl penalties, and will be progecuted ta the masximum extent possible under the law.

Cancel

14. Click the Next button.

15. The DVS Advantage Software License Agreement
confirmation screen will then appear:
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i DVS Advantage Control Software

License Agreement “ )
Please take a moment to read the icense agreement now. If pou accept the terms below, click |
Agree”, then "Mext". Otherwise click "Cancel".

SURFACE MEASUREMENT SYSTEMS SOFTWARE LICENSE TERMS *

1. DEFIMITIONS

a) "Software” means one or more programs capable of operating on a
controller, processor or other hardware Product ("Device"™). Software is either
a separate Product, included with another Product ("Bundled Software"), ar
fixed in a Device and not rermovable in normal operation ("Firrmeeare™).

b) "SMS" Means (i) Suface Measurement Systems, Maorth America, a

ramnany arnaniced nndar the lawe nf tha Stata nf Pannavhania if the

O 1 Do Mot Agree

’ Cancel l ’ < Back ] I Mest » l

16. Select the | Agree option and then click the Next
button.

17. The Select Installation Folder screen will then appear:
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i DVS Advantage Control Software

S
(e

Select Installation Folder

The installer will install %S Advantage Control Software ta the following folder.

Toingtall in this folder, click "Mext". To install to a different folder, enter it below or click "Browse".

Folder:

C:ADYS-Advantages Browse. ..

Install DS Advantage Control S oftware for poursell, or for anyone who uses this computer:

O Just me

’ Cancel l ’ < Back ] I Mest »

18. Ensure the Everyone option is selected.

19. The default installation folder is: “C:\DVS-Advantage”
and it is strongly suggested that this is not changed.

20. Click the Next button.

21. The Confirm Install screen will then appear:
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i DVS Advantage Control Software Z”E|E|

Confirm Installation ‘;.,

The installer iz ready to install WS Adwantage Control Software on your computer.

Click "Mext" to start the installation.

’ Cancel l ’ < Back ] | Mewt >

22. Click the Next button to install the software.

23. Once the software has completely installed the following
screen will be shown:
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i DVS Advantage Control Software

Installation Complete ‘;.,

DS Advantage Control Software has been successfully installed.

Click "Cloze" to exit.

Please use Windows Update to check for any critical updates to the .MET Framewaork.

24. Click the Close button.

25. A final success confirmation message will then appear:

DVS Advantage Control Software Setup [z|

Setup succeeded,

26. Click OK.

27. The installation of the DVS Advantage Control Software
is now complete.
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17.1.2 Installing the Dino-Lite USB camera

Note: Please ensure the Dino-Lite Digital Microscope USB
cable is not connected to the PC USB port before starting the
installation process.

17.1.2.1 Microsoft Windows Vista™

1. Switch on the PC and insert the DVS Advantage
Software CD is in the CD-drive.

2. Browse to the Support Installation Files\Dino-Lite
Driver 2.9.0 folder on the installation CD. Double click
the DNC-P-Ver.2.9.0.0.exe program to start the
installation process.

A

DNC-P-Ver.2.
9.0.0

3. The Installation Wizard will appear. Click the Next
button at the bottom of the dialog.
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Dine-Lite Plus and Pro Software Installation Ver 20 | i ==

‘Welcome to the InstallShield Wizard for Dino-Lite Plus and Pro

4. Please read and accept the DinoCapture End User
License Agreement by clicking the Yes button.
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Dino-Lite Plus and Pro Software Installation Ver 2.0

License Agreement
=

DinoCapturs End User Licenss Agresment -

Thank wau for tying out the DinoCapture software! By using this software DinoCapture E
Soitware") pou agiee to accept a license under and be bound by the following terms and
conditions [the "Agreement”].

Nor-Commercial Use Only

DinoCapture Software is made available ta you for your non-cammercial use anly. This means
that you may use it at work or at home. But you first need to obtain Anbo's permission if you
wart to gell the DinoCapture Software or any information, services, or software associated
with or derived from it o if you want ta modily, copy [sxcept as provided below], license, or
create derivative works from the DinoCapture Software.

This Agreement allows vou ta install and use the DinoCapture Software on a single compute
fiar working with Dino Digital Microscope. You may make copies of the DinoCapture Saftware
and distribute such copies to athers within your emplayer arganization provided that any such
recipient has had an opportunity to review and agree to be bound by this Agreement. 1

5. In the Choose Destination Location windows, click
the Browse button to the select your own destination
folder or click the Next button to continue.
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Dino-Lite Plus and Pro Software Installation VE_ ‘

Choose Destination Location

6. In the Ready to Install the Program windows, click
the Install button to start the installation process.
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Dino-Lite Plus and Pro Software Installation Ver 20

7. When the Windows Security warning dialog
appears, click the Install this driver software
anyway option to continue.

i Windows Security ™ ==

G(‘ Windows can't verify the publisher of this driver software

< Don't install this driver software
You should check your manufacturer's website for updated driver seftware
for your device.

Install this driver software anyway

Only install driver software obtained from your manufacturer's website or
disc. Unsigned software from other sources may harm your computer or steal
information.

L;,:jl See details

8. Once the installation process is completed, the
InstallShield Wizard Complete windows will appear.
Click the Finish button to continue.
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Dino-Lite Plus and Pro Software Installation Ver 2.0 i

InstallS hield Wizard Complete
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9. Connect the Dino-Lite Digital Microscope USB cable
to the PC USB port.

10. The Found New Hardware windows will appear.
Click on the Locate and install driver software

(recommended) option.

-
[+7] Found New Hardware - : Ig

Windows needs to install driver software for your DinoLite
Plus and Pro

Locate and install driver software (recommended) i
Windows will guide you through the process of installing driver software §
for your device. H

< Ask me again later
Windows will ask again the next time you plug in your device or log on.

® Don't show this message again for this device
Your device will not function until you install driver software.

Cancel
L

11. When the hardware is successfully installed the tooltip
message will appear at the bottom of the screen

=== Dinolite Plus and Pro *

P Device driver software installed successfully.
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12. Ensure that the DVS Advantage Software CD is in the
CD-drive. Browse to the Support Installation
Files\Dino-Lite Driver 2.9.0 folder on the installation
CD. Double click the ReSetRegFile.bat file and the
following dialog will appear:

Cpen File - Security Warning [‘&J

The publisher could not be verified. Are you sure you want to
run this software?
[T Mame: ..tion Files\Dino Lite Driver 2.9.0°\ReSetRegFile.bat
l—"uJ Publisher: Unknown Publisher

Type: Windows Batch File

From: C\Support Installation Files\Dino Lite Driver 2.9....

[¥] Always ask before opening this file

I Fa 1 This file does not have a valid digital signature that verifies its
\@ publisher. You should only un software from publishers you trust.
ks How can | decide what software to un?

e

13. Click the Run button to complete the installation
process.

Note: If the Windows Vista User Account Control appears
during the installation process, enter the username and
click OK or if the current user is an administrator then
click Continue.

17.1.2.2 Microsoft Windows XP

1. Switch on the PC and insert the DVS Advantage
Software CD is in the CD-drive.

318



DVS Advantage Operation Manual

2. Browse to the Support Installation Files\Dino-Lite
Driver 2.9.0 folder on the installation CD. Double click
the DNC-P-Ver.2.9.0.0.exe program to start the
installation process.

4

DNC-P-Ver2.
9.00

3. Inthe Open File — Security Warning dialog, click the
Run button to proceed.

Open File - Security Warning

The publisher could not be verified. Are you sure you want to
run this software?

Name: DNC-P-Ver.2.9.0.0.exe
Fublisher: Unknown Publisher

Type: Application
From: C:\Support Installation Files\Dino Lite Driver 2.9.0

[ Bun Dl Cancel |

Always ask before opening this file

This flle does not have a valid digital signature that verfies its
publisher. You should only run software from publishers you trust.
How can | decide what software to un?

4. The Installation Wizard will appear. Click the Next
button at the bottom of the dialog.
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Dino-Lite Plus and Pro Software Installation Ver 2.0

‘Welcome to the InstallShield Wizard for Dino-Lite Plus and Fro

us and Pio

5. Please read and accept the DinoCapture End User
License Agreement by clicking the Yes button.
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Dino-Lite Plus and Pro Software Installation Vi

License Agreement
Ple:

DinoCapture End User License &greement

Thank you for trying out the DinoCapture softeare! By using this software" DinoCapture:
Software"] you agres to accept a license under and be bound by the fallowing terms and
conditions [the "Agreement”].

Mon-Commercial Lse Only

DinoCapture Software iz made available to you for your non-commercial use only. Thiz means
that you may use it at work or at home. But you first need to obtain AnMo's permission if pou
want to sell the DinoCapture Software or any information, services, of software associated
with or derived from it or if you want to modify, copy [except as provided below), icense, or
create derivative works fram the DinoCapture Software.

This Agreement allows you t install and use the DinaCapture Software on a single computs
for warking with Dina Digital Microscope, You may make copies of the DinoCapture Software
and distribute such copies to others within your emploper organization provided that any such
recipient has had an opportunity to review and agree to be bound by this Agreement. IF

6. In the Choose Destination Location windows, click
the Browse button to the select your own destination
folder or click the Next button to continue.
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7. In the Ready to Install the Program windows, click
the Install button to start the installation process.
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Dino-Lite Plus and Pro Software Installation Ver 2.0

Ready to Install the Program
Tl

8. When the Software Installation warning dialog
appears, click the Continue Anyway button to
continue.

Software Installation

' : The software you are installing has not passed Windows Logo
L testing to verify its compatibility with Windows XP. (Tell me why
this testing is important.

Continuing your installation of tl‘ls software llay impair
or destabilize the of your

either immediately or in the future. Ilcmmﬂ slmnjy
recommends that you stop this installation now and
contact the software vendor for software that has

M)E STOP Instaliation |
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9. Once the installation process is completed, the
InstallShield Wizard Complete windows will appear.
Click the Finish button to continue.

Dino-Lite Plus and Pro Software Installation Ver 2.0

InstallShield Wizard Complete

wtalled Dinc-Litke Plus and Pro. Click Finish to exit the:

10. Connect the Dino-Lite Digital Microscope USB cable
to the PC USB port.
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11. The Found New Hardware Wizard will appear.
Check the Install the software automatically
(Recommended) option. Click the Next button to
continue.

Found New Hardware Wizard

Welcome to the Found New
Hardware Wizard

This wizard helps you install software for:
Dinolite Plus and Pro

\) If your hardware came with an installation CD
B2 or floppy disk, insert it now.

What do you want the wizard to do?

O Installfrom 5 1 o [Advanced)

Click Next to continue

R

12. When the Hardware Installation warning dialog
appears, click the Continue Anyway button to
continue.

Hardware Installation

] E The software you are installing for this hardware:
L
DinoLite Plus and Pro

has not passed Windows Logo testing to verify its compatibility
with Windows XP. (Tell me why this testing is important.)

Continuing your installation of this software may impair
or destabilize the p ion of your syst
either immediately or in the future. Microsoft strongly
recommends that you stop this installation now and
contact the hardware vendor for software that has
passed Windows Logo testing.

(]_ Cortinue Aryway J>| STOP Installation |
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13. When the hardware is successfully installed the
Found New Hardware Wizard will appear. Click the
Finish button to complete the installation process.

Found New Hardware Wizard

Completing the Found New
Hardware Wizard
The wizard has finished installing the software for:

< —E DinoLite Plus and Pro

Click Finish to close the wizand

(=D

14. A tooltip message will appear at the bottom of the

screen to acknowledge a successful hardware
installation.

i) Found New Hardware

Your new hardware is installed and ready to use.

L
B4+ i untitled - Paint N &)- v B M 1217

17.1.3 Configure the Dino-Lite camera

This section only applies to the Dino-Lite Microtouch
version of the camera.

1. Switch on the PC and ensure that the Dino-Lite Digital

Microscope USB cable is connected to the PC USB
port.
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On the Windows Desktop, double click the
DinoCapture icon to open the Dino-Lite Capure
application.

InoCapture

On the Dino-Lite camera, press the Microtouch
button at the bottom of the camera.

On the DinoCapture application, select Setting >
Microtouch -> Disable to disable the Microtouch
feature.

il Capture  Help e
Microtouch Y| w Disable

w Run DinoCapture by MicroTouch
Audio Setting Double Touch
Real-Time Image Setting
Resolution 4

On the main menu again, select Setting > Run
DinoCapture by MicroTouch to disable this feature.

Capture  Help

Microtouch *
Run DinoCapture by MicroTouch
Audio Setting
Real-Time Image Setting

Resolution r
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17.1.4 Additional notes for IT
Administrators for Windows Vista
computers

Once the DVS Advantage Control Software has been installed
and configured, users can log in to the Windows Operating
System using their personal Windows user account, however
there are several issues that IT Administrators may need to
address:

17.1.4.1 Running the DVS Advantage software
for the first time

In some cases when the DVS Advantage Control Software is
run for the first time on a Windows user account the DVS
Advantage Control Software Installation Wizard will start to
run and may request the installation CD to be inserted into the
CD-ROM.

In this case the user account requires Local Administrative
rights to the DVS Advantage computer to allow the Installation
Wizard to install missing components from the installation CD.
Once the Installation Wizard has completed, the Local
Administrative rights to the DVS Advantage computer are no
longer required and may be removed.

17.1.4.2 User Security Permissions

All Windows user accounts used to run the DVS Advantage
Control Software require Modify permissions on the
installation directory and all files and folders within it.

Note: If users do NOT have the required security permissions
the following error message will appear:

DVSAdvantage.exe - Common Language Runtime Debugging Services n

'E Application has generated an exception that could not be handled,
* Process id=0xf0c (3852), Thread id=0x90c (2316).

Click OK to terminate the application.
328 Click CAMCEL ko debug the application,
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Permissions for all users should be configured on the
installation directory as shown below:

Modify Permissions
Pemnizsions for Domain Users \

Full Control

Moddy

Read & Execute
List Folder Contents
Read

‘Wwiite

For special pemissions or for advanced settings, _
ek A Advanced

17.1.4.3 Disable Automatic Updates

The installation of software downloaded by the Windows
Automatic Update feature can interfere with the operation of
the DVS Advantage control software.

We suggest that the Automatic Updates are turned off and
that any updates are performed when the DVS Advantage
control software is not running.

To turn off Automatic Updates follow these steps:
Open the Windows Control Panel and double-click on the

Windows Update option. In the Windows Update dialog
box, click on the Change settings option on the left panel.

++ Check for updates

Change settings
View update history

Restore hidden updates
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The following dialog box will appear:

con Cancel

In the Windows Update dialog box, please ensure that the
Never check for updates option is enabled.

|e| @ Mever check for updates (not recommended)
L%

= Your computer will be more vulnerable to security threats
latest updates.

Click on the OK button to accept the changes. (If the
Windows Vista User Account Control appears, enter the
administrator’s detail and click OK or if the current user is an
administrator then click Continue.)

17.1.4.4 Disable Java Updates

Similar to Automatic Updates, Java updates can also interfere
with the operation of the DVS Advantage control software.
SMS suggests that Java updates are turned off and any
desired updates are applied when the DVS Advantage control
software is not running.

To switch off Java updates following these steps:
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Open the Windows Control Panel and double-click on the
Java option. In the Java Control Panel dialog box, click on the
Update tab.

| £ Java Control Panel ‘

General | Update I Java | Security | Ad\ranced|

About

In the Java Control Panel dialog box, click on the Update tab.

In the Update option, please ensure that the Check for
Updates Automatically option is unchecked.

5

| | Java Control Panel i —|-E} -]
General |{ Update || Java | Security | Advanced

Update Notification

The Java Updatz mechanism ensures you have the mest updated
“1| version of the Java platform. The options below let you control how
=== updates are obtained and applied.

Notify Me: Before downloading =

|| Check for Updates Automatically Advanced. ..

Click the "Update Now” button below to check For updates. An ican
will appear in the system tray if an update is available. Move the il
cursor over the icon to see the status of the update.

Java Update was last run at 14:06 on 22/01/08, Update Now

Click the Never Check button option in the following dialog
box:

Java Update - Warning Iﬁ‘
PR —
You have chosen to never check for updates and may ' -
miss future security updates. AN T

We strongly recommend letting Java periodically check For newer versions to ensure you have
the most secure and Fastest Java experience.

[ Ehedkfionthly "] [ Never Check |
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Click on the OK button to accept the changes.

17.1.4.5 Update Power Options Features

Hibernation of the computer prevents the DVS Advantage
control software from communicating with the DVS Advantage
instrument.

If hard disks are switched off at any point it will mean that the
DVS Advantage control software cannot save experimental
data to the hard disk.

You must ensure that the each Windows user account that
will be used is updated so that it has the settings listed below:

Open the Windows Control Panel and double-click on the
Power Options. The following dialog box will appear:

| = el

o

Select a power plan
Bower pl

y - sk a plan

active by selecting . of chocse & plan and CusTOmEe it by changng is power settings. Je1 me moxe
Eiou kowes dlani

Click

the DVS

Shiw sdfitiensl plans

Advantage Change plan settings option.
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i@ DVS Advantage

ange plan sethingts

In the Edit Plan Settings window, click on the Change
advanced power settings option.

(=E
@Ov @ « Edit Plan Settings | 43 || Search 3

Change settings for the plan: DVS Advantage

Choose the slecp and display settings that you want your computer to use.

() Some settings are managed by your system administrator. Why can't 1 change some
seftings?

W Putthe computertoslesp: | Never

Lhange advanced power settings

| —

In the Power Options window, ensure that the DVS
Advantage setting is active.

3 Power Options e [
Advanced settings

< Select the power plan that you want to customize, and
\@ then choose settings that reflect how you want your
computer to manage power.

W Change seftinge that are cuprently unavailable
e

q‘DxS Advantage [Active] _VD

Additional settings -
Wireless Adapter Settings
Sleep

USE settings

Power buttons and lid

PCI Express

Processor power management
Search and Indexing i

m

EEEEEEE

Dicnlaw

Restore plan defaults
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In the Hard disk selection, ensure that all the Turn off hard
disk after options are set to 0 i.e. Never.

- Hard disk
= Turn off hard disk after
Setting: Mever

In the Wireless Adapter Settings, ensure that all the Power
Saving Mode options are set to Maximum Performance.

- Wireless Adapter Settings
-] Power Saving Mode
Setting: Maximum Performance

Click on the Sleep settings and set all the Sleep after options
to Never. Set all the Allow hybrid sleep options to Off and
set all the Hibernate after options to Never.

- Sleep
- Sleep after
Setting: Mever
= Allow hybrid sleep
Setting: Off
—| Hibernate after
Setting: Mever

17.1.4.6 InstallShield Update Manager

If this application is installed on the computer, you will
need to ensure that updates for the program do not affect the
operation of the DVS Advantage control software by ensuring
the following settings are used:

Open the Windows Control Panel and double-click on the
Program Updates options (if it exists).
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In the Update Manager dialog box, click on the Update
Settings tab.

Ensure that the automatically check for updates option is
disabled.

Check for Updates

() The InstaliShield Update Manager will autc
an icon alerting you that updates are avai
to install. If no updates are available, vou

(@ The InstalShield Update Manager will not
run a check for updates. To do this, oper
recommended that you chedk for available

Click the OK button.

17.1.4.7 Date and Time Settings

An error will occur if the date or time is changed whilst the
DVS Advantage control software is running.

In the Control Panel, select the Date and Time options. Click
on the Change time zone button.

Date and Time ' =]
Dste 80 Trnt | Addvonal Clods:

Date:

07 Apnil 2008

<) -

‘\ ’  y 15:22:40

I Change gdate and time...

(GMT) Greenwich Mean Time = Dublin, Edinburgh, Lishen, Londen

Duylight Saving Time ends on 26 October 2008 at 0200, The clock is nat set
1o adjust for this change.

e week belore this change oecurs
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In the Time Zone settings, ensure that the Automatically
adjust clock for Daylight Saving Time option is unchecked.

. Time Zone Settings . l_ =

Set the time zone:

Time zone:

(GMT) Greenwich Mean Time : Dublin, Edinburgh, Lisbon, London =

¢ Automatically adjust clock for Daylight Saving Timg

Current date and time: 07 April 2008, 15:23

|
1. Click the OK button to continue.

2. Select the Internet Time tab (if visible)

| Date and Time I Additional Clacks | Internet Time |_

5. Click on the Change settings button. (If the Windows
Vista User Account Control appears, enter the
administrator’s detail and click OK or if the current
user is an administrator then click Continue.)

6. Ensure that the Synchronize with an Internet time
server option is unchecked.

~ Intemet Time Settings n =)

Configure Intemet time settings:

IBynchronize with an Internet time serven

=

7. Click the OK button to exit.
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17.1.5 Additional notes for IT
Administrators for Windows XP computers

Once the DVS Advantage Control Software has been installed
and configured, users can log in to the Windows Operating
System using their personal Windows user account, however
there are several issues that IT Administrators may need to
address:

17.1.5.1 Running the DVS Advantage software
for the first time

In some cases when the DVS Advantage Control Software is
run for the first time on a Windows user account the DVS
Advantage Control Software Installation Wizard will start to
run and may request the installation CD to be inserted into the
CD-ROM.

In this case the user account requires Local Administrative
rights to the DVS Advantage computer to allow the Installation
Wizard to install missing components from the installation CD.
Once the Installation Wizard has completed, the Local
Administrative rights to the DVS Advantage computer are no
longer required and may be removed.

17.1.5.2 User Security Permissions

All Windows user accounts used to run the DVS Advantage
Control Software require Modify permissions on the
installation directory and all files and folders within it.

Note: If users do NOT have the required security permissions
the following error message will appear:

DVSAdvantage.exe - Common Language Runtime Debugging Services n

'E Application has generated an exception that could not be handled.
= Process id=0xF0c (3852), Thread id=0x90c (2316).

Click QK to terminate the application,
Click CAMCEL to debug the application.
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Permissions for all users should be configured on the
installation directory as shown below:

Modify Permissions
Pemnizsions for Domain Users \ Allow Deny

Full Control

Moddy

Read & Execute
List Folder Contents
Read

‘wiite

O000ooa

W

For special pemissions or for advanced settings, _
click Advanced Sideates

17.1.5.3 Disable Automatic Updates

The installation of software downloaded by the Windows
Automatic Update feature can interfere with the operation of
the DVS Advantage control software.

We suggest that the Automatic Updates are turned off and
that any updates are performed when the DVS Advantage
control software is not running.

To turn off Automatic Updates follow these steps:

Open the Windows Control Panel and double-click on the

Automatic Updates option. The following dialog box will
appear:
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Automatic Updates. f'5_<\

Automatic Updates |

Windows can regularly check for important updates and install them for you.
{Turning on Automatic Updates may automatically update Windows Update
software first, before any other updates.)

How does Automatic Updates work?

() Automatic (recommended)

Automatically download recommended updates for my
computer and install them:

() Download updates for me, butlet me choose when to install them,
() Notify me but don't automatically download or install them.

@ilum off Automatic Updates |

Your computer will be mare vulnerable unless you install
updates regularly.

Install updates from the Windows Update Web site.

In the Automatic Updates dialog box, please ensure that the
Turn off Automatic Updates option is enabled.

Automatic Updates ‘

Windows can regularly check for important updates and install them for you,
(Turning on Automatic Updates may automatically update Windows Update
software first, before any other updates.)

How does Automatic Updates work?

() Automatic (recommended)

Automatically download recommended updates for my
computer and install them:

() Download updates for me, but let me choose when to install them,

() Motify me but don't automatically download or install them.

‘Your computer will be more vulnerable unless you install
updates regularly.

Install updates from the Windows Update Web site.

Click on the OK button to accept the changes.
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17.1.54 Disable Java Updates

Similar to Automatic Updates, Java updates can also interfere
with the operation of the DVS Advantage control software if it
is installed. SMS suggests that Java updates are turned off
and any desired updates are applied when the DVS
Advantage control software is not running.

To switch off Java updates following these steps:

Open the Windows Control Panel and double-click on the
Java option (if it exists). The following dialog box will appear:

< _Java Control Panel

s General, Update | Java | Security | Advanced

Ahouk

“igw version information about Java Control Panel.

Metworlk Settings

Metwork settings are used when making Internet connections, By default, Java
will use the network settings in your web browser, Only advanced users should
modify these settings.

Metwork Settings. ..

Temporary Internet Files

Files you use in Jawa applications are stored in a special Folder For quick execution
later, Only advanced users should delete files or modify these settings,

[ Delete Files. .. ][ Settings... ]

In the Java Control Panel dialog box, click on the Update tab.

In the Update option, please ensure that the Check for
Updates Automatically option is unchecked.
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£ Java Control Panel

General |; Lipdate’| 1ava Security | Advanced

Update Motification

wversion of the Java platform. The options below let you contral how

( & 3 The Java Update mechanism ensures you have the most updated
=
\ updates are obtained and applied.

Motify Me:

<_[ | Check for Updates Automatical

Click the "Update Now" button below to check For updates, An icon
will appear in the system tray if an update is available, Mave the
cursor over the icon to see the status of the update.

Java Update was last run at 15:34 on 17/04/07, Update Mo

Click on the OK button to accept the changes.

17.1.5.5 Update Power Options Features

Hibernation of the computer prevents the DVS Advantage
control software from communicating with the DVS Advantage
instrument.

If hard disks are switched off at any point it will mean that the
DVS Advantage control software cannot save experimental
data to the hard disk.

You must ensure that the each Windows user account that
will be used is updated so that it has the settings listed below:

Open the Windows Control Panel and double-click on the
Power Options. The following dialog box will appear:
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Power Options Properties IEI@

Power Schemes ‘Advanced Hibemate | UPS

¢ Select the power scheme with the most appropriate settings for

this computer. Note that changing the settings below will modify
the selected scheme

r schemes

Settings for Home/Office Desk power scheme

Tum off monitor: |Fﬂer 10 mins ~ |
Tum off hard disks: | Never |
System standby: | Never v |
System hibemates: | Never » |

The Power Schemes tab should be active. Ensure that the
Power schemes are set to the following configuration:

Turn off hard disks: Never
System standby: Never

System hibernates: Never
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Power Options Properties

Power Schemes | Advanced | Hbemate | UPS |

| Select the power scheme with the most appropriate settings for
this computer. Mote that changing the settings below will modify
the selected scheme

Power schemes

Settings for Home/Office Desk power scheme

Tum off monitor: |Fﬁsr 10 mins v |
Tum off hard disks | Newver ~ |
|System standby: | Newer ~ |
|System hibemates: | Newer ~ |

Now select the Hibernate tab and ensure that the Enable
hibernation option is unchecked.

Power Options Properties

Fower Schemes || Advanced | Hbemate | UPS |

memary on your hard disk and then shuts down. When your

@ When your computer hibemates, it stores whatever it has in
computer comes out of hibemation, it retums ta its previous state

Hibemate
Enable hibem:

Disk space for hibemation
Free disk space 48,291 MB
Disk space required to hibemate: 2,007 MB

oK | [ canced ][ mopy |
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17.1.5.6 InstallShield Update Manager

If InstallShield is installed on the PC, ensure that updates for
InstallShield do not affect the operation of the DVS Advantage
control software by ensuring the following settings are used:

Open the Windows Control Panel and double-click on the

Program Updates options (if it exists). The following dialog
box will appear:

o Qirigras e okaded m S ek or et
® i adoman: theds for uceiates n et med: Never (Charge Lidate Setircy

e (e ]

In the Update Manager dialog box, click on the Update
Settings tab and ensure that the automatically check for
updates option is disabled

at you ravely s,
ek pinde ot

1 the. s comguter
Pt ragram, exgmcinly # Tt crograns s2fiane

¥ procram i selecied, fe IngaiSrietd Undate Manager wil check for udates for that program. TF m orograr i nselected, the Lpdste Manager
ol rat checit for Lnelaies far that pregyam.

Check for Updates

4 L ey ey, B uclates e avalatie, piu wl
00 Bbring vou 4% upated e pnlable. When yiu gelact Ba 636, i vl . Yo decde wheh
3 stal 1F o undates e andabie, you il ot receve any noSfaton.
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17.1.5.7 Daylight Savings

An error will occur if the date or time is changed whilst the
DVS Advantage control software is running.

Ensure the “Automatically adjust clock for daylight saving
changes” setting of the computer is unchecked.

Date and Time Properties @@

Date & Time | Time Zone

(GMT) Greenwich Mean Time | Dublin, Edinburgh, Lisbon, London v

tically adjust clock For daylight saving changes:

’ [ [e]9 I[ Cancel J[ Apply

Ensure this option is UNCHECKED

17.1.5.8 SMTP Email Configuration

Note: The Email Settings feature is not available in 21 CFR
Part 11 versions of DVS Advantage software.

To allow users of the DVS Advantage Control Software to use
the SMTP email functionality in the DVS Advantage software,
the following steps need to be performed:

Ensure the SMTP Service is installed

1. Open the Windows Control Panel, double-click the
Add or Remove Programs icon.
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2.

346

In the Add or Remove Programs panel, click
Add/Remove Windows Components at the left side
bar menu option. The following dialog will appear:

Windows Components Wizard

Windows Components
You can add or remove components of Windows P

Tao add or remove a component, click the checkbaox. A shaded box means that anly
part of the companent will be installed. To see what's included in & componert, click.
Details.

Companents:

[ &P Indesing Service 0.0 MB
alntemet Explorer 0.0 B
W BB ntemet Infromatinn Services 1151 13R MR ¥

Description:  Includes Windows Accessones and Utilties for pour computer.

Total disk space required: BE.2 ME "
Details..
Space avalable on disk: 4E702 7 MB Cais

[ < Back ” Nexst > ][ Cancel ]

In the Windows Components Wizard panel, ensure the
Internet Information Services (lIS) option is checked.
Click the Details... button and the following dialog will
appear:
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Internet Information Services (I1S) [g|

To add or remove a companent, click the check box. A shaded box meats that only part
of the component will be installed. To see what'z included in a component, click Details.

Subcomponents of Intermet Information Services (IIS]:

& Documentation 35MB A

O &Q File Transfer Protocol [FTP) Service 0.1 MB

O @Frontpage 2000 Server Extensionz 43ME

'}ﬁ] Irternet Information Services Snap-n 1.3 MB

#FASMTP Service 1.1ME

o woild wide \Web Service 23ME
“

Description:  Installs Required 115 program files

Total disk space required: BE.2MB
Space available on disk: 46702 6 ME

Details. ..

Ok ] [ Cancel

In the Internet Information Services (1IS) panel, ensure
the SMTP Service option is checked.

Click the OK button to confirm selection.

In the Windows Components Wizard, click the Next
button to proceed.

Insert the Window XP Professional CD if prompted.

‘Configuring Components
Satup is maldng the configuration changes you raguested

=L Piease wat whie Setup configures the components. This may take
4 several mnutes, depending on the components stlected

Status: Completing configuration of SMTP Sanvice..

M O T O T T J
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9.

l' X

Click the Finish button when the Windows Components
Wizard successfully completed the installation process.

Completing the Windows
Components Wizard

You have successfully completed the Windows
Components Wizard

To close this wizard, chck Finish

Firish

Configure the SMTP Server name

1.

348

To configure the SMTP Server name start up the DVS
Advantage Control software and select the
File=>Preferences>Email Settings... menu item.

The dialog below will then appear:



DVS Advantage Operation Manual

T Email Settings Editor

Email Settings

Subject :

Email Notifications

Experiments | Emors

™ Send an email natification when experiments complete. Jiii

Email Body:

[ s [ o ]

SMTP Server: This needs to be set to the name of the e-mail
relay server to be used. If the SMTP Server field is left blank,
the name of the local SMTP server is used.

3. Atest email can be sent by clicking on the Test button.

4. If the SMTP Server is not detected the warning
message below will appear when a Test email is sent:
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Errer Deta: Srstom, Web HIpErompen: Coukd ot acorss TO0, Message’ dbfedt, <« Srtem Reflocton. | Evmption b target of an iwisiaen, =
¢ i The tearmigse e

— Endl ok inner esception stack trace —

, Ot barget, Cbject]] arge, Boolean| , 132 ouure,
. B £ 3

o rat Ohiet e, bl

».
& Systam T \ g i, Beebes barclar, Clrieck gk, bect{] angs)

by pe, Chiject ok . Cectd] arge)
sk Syshem wieh Mal. % . Ciefect]] angs)

. Ctjece]] arge)

# Syutan web 3
o Fpeam taieh M. e o epes. Sk Ml agn reesage]

ot System, Web. M. St phlad SereMalessane message)

ok SME. LS. birTest_Chh{Clject sender, E exdee 476

atest wel

=

5. Upon correctly setting the SMTP Server name, click the
Save button to save this name for all users of the DVS-
Advantage instrument.

6. Shutdown the DVS Advantage software.

For information on the use of the Email function, please
refer to the related section in this manual.

Remarks

For information about configuring the local SMTP server, see
the articles "Manage Your Company's E-mail with the
Windows 2000 SMTP Service" and "Using SMTP for Outgoing
Messages" in the MSDN library at http://msdn.microsoft.com.
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17.2 Uninstalling the DVS
Advantage Software

When removing the DVS Advantage Control Software, please
follow the 2 procedures listed below:

17.2.1 Backup Important Files

1. Backup important DVS Advantage system files.

Before uninstalling the DVS-Advantage software, make
sure a backup copy of the following folders and all the
files they contain is made:

a. C:\DVS-Advantage\config

b. C:\DVS-Advantage\database
These folders contain both the system and calibration settings
for the DVS instrument.

If these files are lost then the DVS Advantage instrument will
need to be re-calibrated by a SMS service engineer!!

2. Backup existing Sequence, Method and Data files
stored in the following directories:

a. C:\DVS-Advantage\method
b. C:\DVS-Advantage\sequence
c. C:\DVS-Advantage\data
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Note: DVS-Advantage sequence, method (.sao & .pre) and
data files (.dat and .xls) are often reusable in new versions
of the DVS—Advantage software. This means that if a new
version of DVS—Advantage software is installed, these files
may later be copied to the sequence, method and data
folders of the new DVS Advantage software version.

17.2.2 Uninstall the DVS-Advantage

software

1. Make sure that the DVS Advantage system files listed
in the section above have been backed up.

2. Ensure that you are logged into the computer as an
Administrator.
Start the Windows Control Panel.
Double click the Add/Remove Programs icon.

5. Select the DVS Advantage Control Software
application.

6. Click the Remove button.

7. Click the YES button when prompted for Removal

confirmation.

Once the Removal is complete, using Windows Explorer,
browse to the installation folder and delete the folder if it still
exists.
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18 Appendix H — Customer Support

If you experience any problems with this product please
contact your local supplier.

Contact SMS at the following locations —

United Kingdom (Worldwide Office)
www.smsuk.co.uk

Surface Measurement Systems Ltd UK
5 Wharfside

Rosemont Road

Alperton HAO 4PE

Phone: +44 020 8 795 9400
Fax: +44 020 8 795 9401
E-mail support@smsuk.co.uk
North America

www.smsha.com
Surface Measurement Systems NA
2125 28th Street SW

Suite 1

Allentown PA 18103

Phone: (610) 798 8299
Fax: (610) 798 0334

E-mail support@smsna.com
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